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UNIT- 1
FUNDAMENTALS OF DIGITAL COMPUTER

1.1 INTRODUCTION

1.2 OBJECTIVES

1.3 REPRESENTATION OF DATA IN COMPUTERS

1.4 COMPONENTS OF COMPUTER

1.5 EVOLUTION OF COMPUTERS

1.6 GENERATION OF COMPUTER

1.7 CLASSIFICATION OF COMPUTERS

1.8 COMPUTER MEMORY

1.9 APPLICATION OF COMPUTERS

1.10 POINTS TO REMEMBER

1.11 GLOSSARY

1.12 CHECK YOUR PROGRESS

1.13 BIBLIOGRAPHY/ REFERENCES

1.14 SUGGESTED READINGS

1.1 INTRODUCTION

This unit presents a broad survey of concepts and terminology related to today’s digital

computers. Here, the idea of computer literacy is introduced. A computer is also a tool intended
to assist the user in accomplishing information-based tasks ranging from locating and acquiring
data/information to processing it and to presenting or transmitting it as output. Besides, it

allows the user to browse the web pages, read a book, play a video game, watch a movie, etc.

When you look at a desktop computer, it comprises a monitor, keyboard, mouse, and a vertical
or horizontal box called a system unit. It is acceptable to refer to all of these components as a
computer. Technically, the systems unit houses the actual ‘computer’ or programmable
machine (hardware, firmware and, software), which executes (carries out) or responds to a

sequence of program instructions. A computer system then is a collective term for a computer
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(housed within the system unit), as well as these other components that are attached to it to
allow the user to input data and view output using different devices. Some of these components
include a monitor, keyboard, mouse, printer, disk drives, scanners, microphones, and speakers,
which are also referred to as peripherals. The peripherals work together to help the user
accomplish a given task effectively. It is the system unit that accepts and processes the data,
and generates the results. Other peripheral devices such as the hard drive store the data and

results, which can be viewed on the monitor.

The major components of a computer system include Central Processing Unit (CPU), input and
output devices. The CPU comprises a set of electronic circuits kept within the system unit. The
CPU is the brain of a computer system and is responsible for processing the data i.e. input from
peripheral devices and output to another peripheral device. The Central Processing Unit (CPU),
also known as the processor or microprocessor has components that control the operating
system and other software installed on the computer. The CPU also sends commands and data

to the peripherals attached to the computer, such as the monitor or printer.

Therefore, the speed (how fast the electrons move around the chip) at which the CPU executes
its tasks (or commands) determines how quickly you can view or hear the output from the
command such as printing a page or allowing you to view a letter on the monitor. This speed
is called ‘clock speed’ and is measured in megahertz (MHz). A computer system that responds
to commands quicker means that it’s clock speed is working faster to execute these commands.
Different CPUs use different silicon chips to execute the commands and process data. Different

types of chips have different clock speeds based on the technology that was used to create them.

The peripheral devices mentioned above are collectively called hardware devices, since they
can be physically attached to the computer. However, computer systems also include software,
or programs that are integral in the functioning of some of these peripheral devices and are
necessary to make the computer operate. Every computer system requires an operating system.
An operating system is a program that establishes communications with the various peripherals
and acts as a bridge to other application-specific software programs. An operating system is
like the command centre of the ship. It makes all of the decisions about how the computer will

function and work with others.

1.2  OBJECTIVES

After the successful completion of this unit, you will be able to-

° Define the term and its components.

e  Understand the Input devices and output devices used.

° Define Computer Generations and key applications of computers.
e  Understand the concept of storing data into computers.

e  Know about computer memory e.g. primary memory and secondary memory.
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1.3 REPRESENTATION OF DATA IN COMPUTERS

A computer is an electronic processing device, which accepts inputs, processes the input data,

and generates the output. In other words, a computer is an electronic device, operating under
the control of instructions (software) stored in its own memory unit, that can accept data (input),
manipulate data (process), and produce information (output) from the processing.
COMPUTER stands for- Common Operating Machine Particularly Used for Training
Education and Research.

The minimum requirements for a functional computer system include; a keyboard, a CPU and
memory, and a monitor. The data is usually entered via the keyboard and the information is
usually presented through a screen. However, information can also be presented through

speakers or any other output devices e.g. screen projector, printer.

The way components inside a computer fit together helps describe how the computer works.
Data comes in through an Input Device, and is sent to the CPU by the memory. CPU processes
the data based on the input data and the program is installed in the computer memory. When
the CPU has finished processing the data, it is presented through the output device as
information. The information can be stored in the computer memory or presented through an
Output Device.

Data and instructions cannot be entered and processed directly into computers using human
language. Any type of data- numbers, letters, special symbols, sound or pictures must first be
converted into machine-readable form i.e. binary form. Due to this reason, it is important to
understand how a computer together with its peripheral devices handles data in its electronic
circuits, on magnetic media, and in optical devices. Electronic components, such as
microprocessor, are made up of millions of electronic circuits. The availability of high
voltage(on) in these circuits is interpreted as ‘1’ while a low voltage (off) is interpreted as
‘0’.This concept can be compared to switching on and off an electric circuit. When the switch
is closed the high voltage in the circuit causes the bulb to light (‘1’ state). On the other hand,
when the switch is open, the bulb goes off (‘0° state). This forms a basis for describing data

representation in digital computers using the binary number system.

It has proved difficult to develop devices that can understand natural language directly due to
the complexity of natural languages. However, it is easier to construct electric circuits based
on the binary or ON and OFF logic. All forms of data can be represented in a binary system
format. Other reasons for the use of binary are that digital devices are more reliable, small, and
use less energy as compared to analog devices.

Bits, bytes, nibble, and word
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The terms bits, bytes, nibble, and word are used widely in reference to computer memory and

data size.

Bits: is the basic unit of data or information in digital computers, expressed in binary forms 0

or 1.

Byte: a group of bits (8 bits) used to represent a character. A byte is considered as the basic

unit of measuring memory size in computer.
A nibble: is half a byte, which is usually a grouping of 4 bytes.

Word: two or more bits make a word. The term ‘word length’ is used as the measure of the
number of bits in each word. For example, a word can have a length of 16 bits, 32 bits, 64 bits,
etc.

Computers not only process numbers, letters and special symbols but also complex types of
data such as sound and pictures. However, these complex types of data take a lot of memory
and processor time when coded in a binary form. This limitation necessitates the need to
develop better ways of handling long streams of binary digits. Higher number systems are used
in computing to reduce these streams of binary digits into manageable form. This helps to

improve the processing speed and optimize memory usage.
Number systems and their representation-

A number system is a set of symbols used to represent values derived from a common base or
radix. As far as computers are concerned, number systems can be classified into two major

categories:

° decimal number system

e  binary number system

While the other number systems include: octal number system and hexadecimal number

system.

1.4 COMPONENTS OF COMPUTER

To perform computer functionalities, we need some hardware and software. In a general way

computer is an electronic device which perform particular tasks. It takes input and processes it

to produce an output. Primarily there are three main components of a digital computer-Input

PROCESS OUTPUT

\ 4

INPUT

Unit, Processing Unit and, Output Unit.

Input Unit-
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It takes different types of input data from various input devices like-keyboard, mouse, light
pen, scanner, MICR, Bar Code Reader, etc. Whenever you want to instruct anything to a
computer, input device (s) is (are) needed. If you want to write an application on a computer,
you need an input device called “KEYBOARD”.

List of input devices-

Keyboard

Mouse

Joystick

Light pen

Trackball K evhnard
Scanner

Graphic Tablet (touch screen)
Microphone

Magnetic Ink Character Reader
(MICR)

Optical Character Reader (OCR)
Bar Code Reader

Optical Mark Reader (OMR)

Mous

Tov Micranha

MICR Scanner OMR

Details about some frequently used input devices-

Keyboard-
Keyboa] Num Lock, Caps Lock, and Scoll Lock indicators _]LlSt hke a tradltlonal typewrlter,
althougl _ Function keys Control keys ning additional functions.

The abo
can be ¢

" e common. Generally, keyboards

Typing .
These ki

" /hich are the same as typewriters.

Numeri¢

Keyboard Wrist pad Arrow keys Keypad

ur

Some ke |,

Iy _ is placed into the right side of the
keyboard just shown in the above keypad.
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Function Keys-

At the top of the keyboard, 12 function keys are present where each key has a unique task. The
function of these keys varies application to application.

Control Keys-

It includes Home, End, Insert, Delete, Page Up, Page Down, Control(Ctrl), Alternate(Alt) and
Escape(Esc) key. Each key has some special function or worked into combination with some
other keys.

Special Purpose Keys-

Keyboard also contains some special purpose keys such as Enter, Shift, CapsLock, NumLock,
Spacebar, Tab, and Print Screen.

Arrow Keys-

It consists of four directional arrow keys named as-left arrow, right arrow, up arrow and
down arrow.

Mouse-

This is a commonly used pointing device. A mouse can be used to control the position of the
cursor on the screen, but it cannot be used to enter text or any data into the computer. Douglas
Engelbart called the father of mouse and invented it in 1963.There are basically three kinds of

mouse- Mechanical Mouse, Optical Mouse, and Cordless Mouse.

A mouse contains the following functional buttons-

° Click (Left Click)

e  Right Click

° Scrolling (Middle Button)
° Double Click

Scanner-

A scanner is an input device just like a photocopy machine. It is used when a paper has some
information and it is to be transferred to the computer for further manipulation. The scanner
captures images from the source, which are then converted into a digital form that can be stored
on the disk.

Processing Unit-

The Processing unit is also called a Central Processing Unit (CPU). CPU is the brain of your
computer. It performs all types of data processing operations and stores data & intermediate
results for a while (during processing). It also controls the operation of all parts of the computer
system. In general terms, CPU can be understood as the following-

Control Unit (CU) - It controls the various component of a computer.
Arithmetic and Logic Unit (ALU) - This subunit of the CPU performs all the arithmetic

and logical operations such as- addition, subtraction, multiplication, division, and

comparison.
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Note- Apart from the processing unit, memory unit is an indispensable part to the smooth
running of a program. Whenever you need to store information in a computer, you need

memory. Computer memory is basically sub divided into two broader categories as-

(1) Primary Memory (also known as Main Memory).
(i) Secondary Memory (also known as Storage / Permanent Memory).

Note-We will have a detail discussion about memory unit further in this book.
Output Unit-

The processed data is called output. After processing, either the results are stored in the memory
or sent to the output unit. Some examples of different output devices are- CRT (Cathode Ray
Tube) monitor, LCD (Liquid Crystal Display) monitor, LED (Light Emitting Diode) monitor,

printer, speaker, screen projector, plotter, etc.
Monitor-

A monitor is a commonly used output device which displays information in a similar way to
that of a television screen. Generally, the size of a monitor is 19-inch, 20 inch and 21 inches.

Broadly speaking, there are three different types of monitors-
Cathode Ray Tube (CRT)

Liquid Crystal Display (LCD)

Light Emitting Diode (LED)

Printer-

A printer is a hard copy output device i.e. it provides the output in a hard copy/printed form.

There are two types of computers- Impact Printer and Non- impact printers.

Impact Printers— refers to all those printers whose printing heads touches the paper, for e.g. dot

matrix printer.

Non- Impact Printer— refers to all those printers whose printing heads do not touch the paper,

for e.g. laser and inkjet printer.

1.5 EVOLUTION OF COMPUTER

Today most of the jobs mainly depend on either the creation or collection and distribution of

information. This topic addresses the different advancements in computer technology and the
various types of computers and their critical components. As each new computer generation
improves on its previous generation, there has been a corresponding reduction in size (or
miniaturization) of computer circuitry. In contrast to this miniaturization, the speed, power,
and memory of computers have proportionally increased. Although this topic will describe the

major developments of each computer generation, it is more important to consider how
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technology has influenced the development of current computer systems. The detailed

description of computer evolution is discussed in the next title.

1.6 GENERATION OF COMPUTER
° First Generation (Year 1946 - 1959)

° Second Generation (Year 1959 - 1965)
) Third Generation (Year 1965 - 1971)

° Fourth Generation (Year 1971 - 1980)
° Fifth Generation (Year 1980- Onwards)

First Generation (1946 - 1959)-

First-generation computers were vacuum tube-based computers popular in the period 1946-
1959. These vacuum-based computers were expensive, extremely large, and less cost-effective
as they consumed a lot of electricity. The language used for storing and processing data was

machine language. Some of the first-generation computers are:

Electronic Numerical Integrator and Calculator (ENIAC) built at the University of
Pennsylvania in the year 1946 by John Eckert and John Mauchly. Electronic Discrete Variable
Automatic Computer (EDVAC) developed in 1950 at Cambridge University. UNIVAC-1
developed in 1951. The following drawbacks were there in first-generation computers as-

° They were extremely large.

° Operational speed was very slow.

° Electric consumption was very large.

° They have no operating system.

) The programming capability was very low.

Second Generation (1959 - 1965)-

The computers from 1959- 1965 were transistor-based second generation computers. In this
generation, vacuum tubes were replaced by more durable transistors. Transistors are more
compact than vacuum tubes as they are made up of semiconductors. Some of the computers of
the second generations are:

IBM 1620- Its size was smaller as compared to the first-generation computers, used mostly for
scientific purposes.

IBM1401- used for business applications.
CDC3600- used for scientific purposes.
The salient features of this generation are-

° They were smaller in size than the first generation computers.
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° Operational speed relatively faster and more reliable than first-generation computers.
° Electricity consumption was relatively lesser than first-generation computers.

° They had higher capacity internal storage.

Third Generation (Year 1965 - 1971)-
The third-generation computers from 1965 to 1971 were Integrated Circuit (IC) based. These

ICs are more compact than a transistor and were called chips. Single ICs has many transistors,
resistors and capacitors, placed on a single thin of silicon. So, the computer built of such

components became smaller. Some of the computers developed during this period were-

IBM360- developed by IBM in the year 1964.
PDP8- developed by DEC in the year 1965.
The salient features of this generation are-

e  Relatively small in size.

° Relatively low cost.

° Operating system is used.

° More reliable and high operational speed.

e  Large memory capacity.

Fourth Generation (1971 - 1980)-
The computers from the period 1971-1980 were Very Large Scale Integrated (VLSI)

microprocessor-based fourth generation computers. VLSI circuits were used in these
computers. VLSI circuits having about 5000 transistors and other circuit elements and their
associated circuits on a single chip made it possible to have microcomputers of the fourth
generation. As a result, fourth-generation computers became more powerful, compact, reliable,
and affordable giving rise to personal computer (PC) revolution. In this generation time
sharing, real-time networks, and distributed operating systems were used. All the high-level

programming languages like C, C++, DBASE etc., were developed during this generation.

The salient features of this generation are-

° They have a very high speed.

° Low costs in comparison to the preceding generations.
° Smaller in size.

e  Reliability is very high.

° Hardware failure is very low.

e  Very low heat generation.

Fifth Generation (1980- Onwards)-

The fifth generation of computers developed 1980 onwards were Ultra Large Scale Integrated
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(ULSI) microprocessor-based. In this generation, the VLSI technology was replaced by more
advanced ULSI technology. ULSI is a set of ten million electronic components into a single
chip. This technology is based on parallel processing with hardware and software support. A
key advancement of this generation is machine learning/artificial learning.

The salient features of this generation are-

° Working based on artificial intelligence or machine learning.

° Working based on image and graphics recognition.

° Highly efficient in solving highly complex problems including decision making, logical

reasoning, and many more.

1.7 CLASSIFICATION OF COMPUTER

Computers of this age can be broadly categorized in the following two ways-

e  Based on the size of memory

e  Based on speed.

Based on the size of the memory, computers can be further classified into-
° Micro Computer

° Mini Computer

) Mainframe Computer

° Super Computer

Micro Computer-

The speed of a micro computer is very low with similar low capacity of storage. Its CPU is a
microprocessor. The first microcomputers were built of 8-bit microprocessor chips. The most
common microcomputer is a personal computer (PC). The PC supports many input and output
devices. An improvement of the 8-bit chip is 16-bit and 32- bit chips. Examples of
microcomputers are- IBM PC, PC-AT, etc.

Mini Computer-

This is designed to support more than one user at a time. It possesses a large storage capacity
and operates at a high speed than a microcomputer. The mini computer is used in a multi-users
system in which various users can work at the same time. This type of computer is generally
used for processing large volumes of data in an organization. They are also used as servers in
Local Area Networks (LAN).

Mainframe Computer-

32-bit computers are generally called mainframe computers. They operate at a very high speed,
have very large storage capacity, and can handle the workload of many users simultaneously.

They are generally used in centralized databases. The mainframe computers are also used as
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controlling nodes in Wide Area Network (WAN). Examples of mainframe computers are-
DEC, ICL and IBM 3000 series.

Super Computer-

A supercomputer is the fastest and most expensive. The processing speed of this type of
computer is very high, so they are relatively costly. They also have multiprocessing techniques.
One of the ways in which supercomputers are built is by interconnecting hundreds of
microprocessors. Supercomputers are mainly used for weather forecasting, biomedical
research, remote sensing, aircraft design, and other advanced areas of science and technology.
Some examples of supercomputers are- CRAY YMP, CRAY2, NEC SX3, CRAY XMP, and
PARAM from India.

1.8 COMPUTER MEMORY
[A] Primary Memory

Computer memory is used to store information (data and instructions) in a digital computer. A
memory is divided into several small parts called memory cells. Each memory cell or location
has a unique address in the form of machine language (0/1). It is useful to know how to store
information on a computer because this will allow us to ascertain about the amount of space
that will be required to store a data set which in turn will allow us to determine what software
or hardware we will need to be able to work with a data set and to decide upon an appropriate
storage format. The computer memory is divided into main and auxiliary memory. Main
memory also called primary memory and secondary memory also called storage memory. Main
memory holds instructions and data when a program is in execution, while auxiliary or
secondary memory holds data and programs not currently in execution and acts as a storage

medium.

Primary memory holds instructions and data currently being processed by the CPU- the
intermediate results produced during the execution of the process. The instructions and data

remain in primary memory which can be accessed by the CPU directly and quickly.
Functions of Primary Memory

° Holding data and instructions for the task assigned by the input device before processing.
° Holding intermediate results while processing.

° Holding data and information after processing unless they are transferred to the output

unit.
° Holding programs and instructions from the secondary storage device.

° Holding system programs like an operating system.

Types of Primary Memory-
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° Random Access Memory (RAM)
e  Read-Only Memory (ROM)
Random Access Memory (RAM)-

It is a volatile or temporary memory. Its contents get lost once the power supply is switched
off. It is also called read/write (R/W) memory. It allows CPU to read as well as write data and
instructions over it. It temporarily holds software, programs /instructions before and after
processing of the data. RAM is used during the execution of instructions. RAM is considered
‘random access’ because you can access any memory cell directly. RAM is made up of
semiconductor material; therefore it is also called semiconductor memory, just like processors
and ROM types of chips. In comparison to other memory devices (storage memory), RAM is
much faster to read and write instructions, and data. RAM is also named direct access memory
because the operating system, application programs, and data currently in use are stored in
RAM directly accessed by the CPU/processor.

The Random Access Memory is further divided into- (i) Dynamic Random Access Memory
(DRAM) (ii) Static Random Access Memory (SRAM).

Dynamic Random Access Memory (DRAM)-

It makes use of a transistor and a capacitor to form a memory cell standing for a single bit of
data. DRAM is not able to retain information for a longer time even if the power supply is on

because it needs refreshing frequently. It is slower and less expensive than SRAM.
Static Random Access Memory (SRAM)-

In SRAM flip flops are used for retaining memory. Typically, it uses four to six transistors for
each memory cell. It does not have a capacitor and hence does not require refreshing. It can
store information until the power supply is “on”. It is faster and expensive in comparison to

DRAM and primarily used in the processor’s cache memory.

Note- Apart from SRAM and DRAM, some other types of RAM are also available. Few

are as follows:

a)  Fast Page Mode Dynamic Random Access Memory (FPM DRAM) — This memory is a
bit faster in comparison to the conventional DRAM. The access time is improved for this
memory as it sends row address only once for accessing the neighbouring locations in
memory. Despite its name, it is still one of the slowest RAMs used today. This memory
is not considered good for high-speed memory buses over 66 MHz.

b)  Extended Data Output Dynamic Random Access Memory (EDO DRAM) — It can be
seen as an improved version of “FPM DRAM?”, as it can retain data valid for a longer
period than FPM. Due to this feature, it is known as the extended data output. It stores
265 bytes of data information into latches and these latches hold the next same amount

Unit 1: Fundamentals of Digital Computer-1 Page 15 of 249



CVDMM- 302: ICT Resources and Applications uou

d)

g)

of information. This arrangement makes it possible for programs to be executed

sequentially without any delay.

Synchronous Dynamic Random Access Memory (SDRAM) — SDRAM is a generic name
that refers to the many dynamic random access memories that are synchronized with the
system bus. It carries data between the CPU and the memory controller hub. It uses the
features called pipelining, which accepts new data before to finish previous processing
data.

Double Data Rate - Synchronous Dynamic Random Access Memory (DDR- SDRAM) -
Double data rate SDRAM was introduced later to give an alternative to single data rate
SDRAM. DDR SDRAM provides better speed than Synchronous Dynamic Random
Access Memory and also consumes a lesser amount of energy. The transfer rate of data
became just double as it is capable of sending data on both rising and falling edges of the

clock pulse.

Double Data Rate Type2 - Synchronous Dynamic Random Access Memory (DDR2-
SDRAM) — The speed of DDR2- SDRAM is just double in comparison to the DDR
SDRAM because its input/output buffer frequency is doubled.

Double Data Rate Type3 - Synchronous Dynamic Random Access Memory (DDR3
SDRAM)- DDR3- SDRAM is considered as an improved version of DDR2 SDRAM. It
also doubles the speed of DDR2 SDRAM. Its power consumption is lesser and the rates
of data transfer range from 800Mbps to 1600 Mbps.

Double Data Rate Type4 - Synchronous Dynamic Random Access Memory (DDR4
SDRAM) — This RAM is a higher-speed successor to the technology used by DDR3
SDRAM. This provides better system-level reliability, capacity, performance scalability,
and power efficiency in comparison to all of its previous memories. Such as- DDR3
SDRAMs.

Read-Only Memory (ROM)

It is a non-volatile memory whose contents are not lost even the electric power is off. It stores

instructions for computer start-up. During the computer start-up operation, the main memory

(RAM) of the computer is empty because of its volatile nature, so that the computer gets

instructions from the ROM to start-up (booting) operation. The contents of ROM cannot be

written or erased by the user only trained programmers and technicians can alter or write or

erase the contents of ROM. ROM chips are generally designed at the time of manufacturing.
ROM also performs the BIOS (Basic Input Output System) functions.

Types of Read-Only Memory

Programmable Read-Only Memory (PROM)
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b)

Erasable Programmable Read-Only Memory (EPROM)

Electronically Erasable Read-Only Memory (EEPROM)

Programmable Read-Only Memory (PROM) - The data stored in PROM cannot be
modified and therefore it is also known as a ‘one-time programmable device’. It is made
as a blank memory as a result when you want to write on a PROM chip, a ROM burner

is required to write data onto a PROM chip.

Erasable Programmable Read-Only Memory (EPROM)- Unlike programmable
ROM; erasable programmable ROM can write/modify data more than once. When
ultraviolet rays of some specific wavelength fall into EPROM’s chip glass panel, the bits

of memory come back to 1 and the chip enables them to write.

Electronically Erasable Read-Only Memory (EEPROM)- Electrically Erasable
Programmable ROM is as same as Erasable Programmable ROM, but the same work of
erasing the stored data is performed with an electric current. EEPROM is a type of non-
volatile memory and used in computers and other electronic devices. It used to store
relatively small amounts of data and also allows individual bytes to be erased and
reprogrammed. It stores a computer system’s BIOS (Basic Input Output System). Unlike
EPROM the entire chip does not have to be erased for changing some portion of it.

[B] Secondary Memory

Secondary memory is where programs and data are kept on a long-term basis. Common

secondary storage devices are the hard disk and optical disks. A hard disk might have a storage

capacity of one terabyte (TB). A hard disk is slow in accessing speed compared to the main

memory. Secondary memory has enormous storage capacity, especially hard disk. Some of the

secondary storage devices are explained below-

a)

b)

Hard Disk Drive (HDD)- Hard disks are stored permanently inside their drive, which is
normally installed into the computer box where you cannot see any part of it. Hard Disks
can store a lot of data and are used to store most of the information on computers. The
advantage of HDD is cost and capacity. The disadvantage of HDD is that they make a lot
of noise, are slow, and prone to failure. They are slowly being replaced by solid-state
drives (SSD).

Floppy Disk Drive (FDD)- Floppy disks are small disks that you can pop in and out of
their drive. All you can see of their drive is a slit in the computer box with a button and
a light. You can put in different disks and then take them out and give them to someone
so that you can transfer data between your computers. FDD's are now obsolete. They can
store only about 1.44 MB, which is way too little. They are prone to damage and are now
unsupported for many years.

Compact Disk (CD)- The most popular kind of optical disk is the Compact Disc (CD).

CDs can still be put into and taken out of their drive, making them good for buying
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d)

programs and for transferring data nowadays. The normal CDs that you buy with
programs on them are CD-ROMs. They are called so because like ROM, they are read-
only. You can also get CD-Rs and CD-RWs, which are not read-only and are not erasable
and erasable, respectively. However, CD-R cannot be deleted once it is written(a process
known as finalizing). CDs can store around 700MB. And, because CDs store their
information with variations in the shape of the disk that reflects a laser differently, they
cannot be damaged as easily. However, one should still never touch the shiny surface of
the CD. CDs are now being replaced by online media, and do not feature in many new
computers anymore.

Digital Versatile Discs (DVD)- DVDs are another kind of Optical disc that works
identically to CDs; however, they can store much more information than CDs. DVDs can
store usually about 4.3 GB, but dual-layered DVDs can store up to about 9 GB and DVD-
RAM can store about the same amount. They are sometimes called Digital Video Discs
because of their extensive use in video and films.

Flash memory- Nowadays, one can get memory cards that are called flash memory or,
more properly, EEPROMs. These are cards that operate just like ROM that isn’t read-
only, so they don’t lose their information when the power is cut.

Solid State Disks (SSD)- SSDs are based on flash memory. They are much quicker than
HDDs, do not make much noise and heat, but they are costlier than HDD's, but the cost
of SSDs are rapidly declining. Another concern with SSDs is that the cells on the SSD
can last only up to a specific number of write cycles. However, they are not of much
concern to home users, as SSDs utilize features such as TRIM to extend lifespan. The
lifespan of the SSD will usually be mentioned, which could be anywhere between 30 -

150 TB more than the average lifespan of a computer.

1.8

APPLICATION OF COMPUTERS

The range of computer applications has penetrated each possible field. Some of the key areas

are -

Business- A computer performs faster calculations and provides accurate and reliable
results which have made it possible to integrate with business organizations. Some of the
areas where computer performs different roles are- Payroll calculations, Budgeting, Sales
analysis, financial forecasting, and Managing employee database, Maintenance of stocks,
etc.

Education- Some of the key areas where computers are used are- student management
systems, teaching tools, learning management systems, etc.

Marketing/Advertising — Computers have revolutionized the advertisement industry
where you can create art and graphics, write, revise and copy, and print and disseminate

ads and sell more and more products.
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Banking- In this day and age, banking is mostly dependent on computers.
Some of the facilities provided using computers are — Online accounting
facility, checking current balance, making deposits and overdrafts online,

checking interest charges, ATM, shares, etc.

Insurance- Insurance companies keep all the records up-to-date with the help of
computers. Some of the other important functions are- amount calculation, customer
MIS, maturity, etc.

E-Learning- Computers have bought a boom in the popularisation of e-learning. One can
sit at home and enrich his/her learning with not just textual information but also pictorial
and animated information which are easier to learn.

Military- Computers are largely used in defence and military operations. Modern tanks,
missiles, weapons, etc are some devices that can be handled by a computer.

Desktop publishing- With desktop publishing, you can create page layouts for entire
books on your personal computer.

Medicine- Computers are a great help in the diagnosis of diseases. Various computer led
software are used in magnetic resonance imaging to examine the internal organs of the
human body. Computer software is also used in storing patient data and performing

surgeries.

The list of areas where computer application is endless in this day and age no place has been

left untouched. The above mentioned are some of them.

1.9

POINTS TO REMEMBER

Assembly Language- It is the first step to improve the programming structure. You
should know that a computer can handle numbers and letters. The symbolic programming
of assembly language is easier to understand and saves a lot of time and effort of the

programmer.

High-Level languages- Assembly language and machine level language require deep
knowledge of computer hardware whereas in a higher language you have to know only
the instructions (Language Grammar) in English words and logic of the problem
irrespective of the type of computer hardware you use.

Von Neumann Architecture also known as the Von Neumann model is a design model
for a stored-program concept wherein the computer consists of a CPU, memory and
Input/output devices. The program is stored in the memory and the CPU fetches an

instruction from the memory at a time and executes it.
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° Freeware- Freeware is software that is distributed without demanding any cost for its
usage. These programs are available either as fully functional software for an unlimited

period.

° Open Source- The term ‘Open Source’ is very close to ‘free software’ but not identical.
We say this because, the source code of open-source software is readily available to users
as well under a copyright, and one is freely allowed to redistribute the software. The
concept of an open-source program relies on the fact that a user can review a source-code

for eliminating possible bugs/error in it.

° Shareware- Shareware is demonstration software that is distributed for free but for a
specific evaluation period only, say, 15-30 days (Say trial version). After the evaluation
period, the program gets expired and a user can no longer access the program. Only if
you are interested in using the program further, the shareware provider may require you

to purchase a license for the software.

° Spyware- Spyware goes a few steps further and surreptitiously installs software on your
computer. The spyware may contain a code that sends information about the user’s
computer to the developer or some other location whenever the user is connected to the

Internet.

e  Malware- Typically referred as ‘Malicious Software’, Malware is any program with mala

fide intentions which exploits data of a computer without its user’s consent.

e  Data and instructions cannot be entered and processed directly into computers using
human language. Any type of data- numbers, letters, special symbols, sound or pictures
must first be converted into machine-readable form i.e. binary form.

e  The CPU is the brain of a computer system and is responsible for processing the data i.e.

input from peripheral devices and output to another peripheral device.

e  Byte: a group of bits (8 bits) used to represent a character. A byte is considered as the

basic unit of measuring memory size in computer.

e  Word: two or more bits make a word. The term ‘word length’ is used as the measure of
the number of bits in each word. For example, a word can have a length of 16 bits, 32
bits, 64 bits, etc.

e  Computer memory is used to store information (sometimes also called data and
instructions) in a digital computer. A memory is divided into several parts called memory

cells.

e  Main memory holds instructions and data when a program is in execution, while auxiliary
or secondary memory holds data and programs not currently in execution and acts as a

storage medium.
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1.10 GLOSSARY

Cache Memory- Cache is a type of memory and is similar to RAM. A cache is used by
the computer to move data between the RAM and CPU.

Bit- Represents a binary digit which is the amount of information obtained by asking a
‘yes’ or ‘no’ question. This is also the smallest unit of information stored on a computer

asaOorl.

Byte- Data is stored on a computer in the form of bytes. A byte is one character, which

may be a number or letter. A byte is composed of 8 consecutive bits.

Flash Drive- This is a small portable hard drive that plugs into a USB port and allows

you to transport files between different computers. Also called a thumb drive.

Graphical User Interface (GUI) - A program that helps you work easily with your
operating system. Also, application programs by providing pictures and visual clues

enhance your experience at work. Windows is the GUI on PCs.

Modem- This is a way to transfer data through a telephone or cable line generally by the
Internet. It may be internal or external. Some modems are used to fax or act as answering

machines.

Motherboard— The circuit board that functioning parts of the computer connect to be the
motherboard. The CPU, RAM, and cache all plug into the motherboard.

NIC (Network Interface Card) — A card is put in the computer allowing connection to a

network.

Sound Card— This device allows the computer to reproduce music, sounds, and voices.
The computer needs a sound card to hear the audio portion of web sites or often to play

multimedia games.

USB Port— The Universal Serial Bus is accessed through small rectangular port on the
front or back of computer that allows peripheral devices such as digital cameras and
external hard drives to connect to the computer. See Ports for other types of connections.

App- A type of application software designed to run on a mobile device, such as a

Smartphone or tablet computer (also known as a mobile application).

Bug- An error in a software program. It may cause a program to unexpectedly quit or
behave in an unintended manner. The process of removing errors (bugs) is called

debugging.
PROM- Programmable Read-Only Memory.
EPROM- Erasable Programmable Read-Only Memory.

EEPROM- Electronically Erasable Read-Only Memory.
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ROM- Read-Only Memory.

HDD- Hard Disk Drive.

FDD- Floppy Disk Drive.

CD- Compact Disk.

DVD- Digital Versatile Discs.

SSD- Solid State Disks.

SDRAM- Synchronous Dynamic Random-Access Memory.
DDR- Double Data Rate.

EDO DRAM- Extended Data Output Dynamic Random-Access Memory.
SRAM- Static Random-Access Memory.

DRAM- Dynamic Random-Access Memory.

Bit- Binary Digit.

1.11 CHECK YOUR PROGRESS

Descriptive type questions-

a)
b)
©)
d)
e)
f)

g)
h)

What do you understand by Computer Generation?

Draw a block diagram of a digital computer and explain it briefly.
Explain input and output devices used in the computer.

Write down some important applications of a computer.
Distinguish between RAM and ROM

Write short notes on: Primary memory and Secondary memory

‘Computers play an important role in our daily lives’. Discuss in your own words.

How data is stored in a computer? Define.

Objective type questions-

a)

b)

Which of the following are components of the Central Processing Unit (CPU)?

[A] Arithmetic logic unit, Mouse [B] Arithmetic logic unit, Control unit

[C] Arithmetic logic unit, Integrated Circuits [D] Control Unit, Monitor

If a computer has more than one processor then it is known as

[A] Uniprocessor [B] Multiprocessor [C] Multithreaded [D] Multiprogramming

In which of the following form, data is stored in the computer?
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[A] Decimal  [B] Binary [C] Hexadecimal [D] Octal
d)  GUI stands for.....
[A] Graphical user Instrument [B] Graphical unified Interface
[C] Graphical unified Instrument [D] Graphical user Interface
e) EEPROM stands for............
f) RAM is of two types........... & .
g)  Main memory is also known as...........
h)  Pen drive is an example of ......... storage device.
1)  ROM is volatile memory. (True/False)
j)  Analog computers use continuous physical quantities like voltage. (True/False)
Answer (Objective type questions)-

[a] Arithmetic logic unit, Control unit [b] Multiprocessor [c] Binary [d]Graphical user Interface
[e] Electronically Erasable Programmable Read Only Memory [f] DRAM & SRAM |[g]
Primary memory [h] Secondary[i] False [j] True.
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UNIT- 2
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2.1 INTRODUCTION

In the previous unit, you have learned about the representation of data in a computer, the

concepts of bits and bytes as well as the various memory-hierarchy levels. Till now, you know
well about the digital computer. The information present in a computer can be easily transferred
through the Internet to anyone across the globe.

In this unit, you would explore various hardware tools that can be used as Information and
Communication Technology (ICT) resources. ICTs are tools that support users to
communicate/transfer the information across the globe. The usage of ICT has been witnessed
in various domains like Education, Healthcare, Banking, Insurance, etc. To realize the

importance of ICT one must understand the peripheral devices and expertise various ICT Tools.

2.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

° Understand the overview of hardware resources used.

° Explore ICT hardware resources used for Technology Enabled Learning.
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° Explore the uses of different hardware resources.

2.3 MEANING OF ICT (HARDWARE) RESOURCES

Information and Communication Technology (ICT) includes the products which help the user

to store, access, disseminate, or receive information. These products comprise of all the
software applications, hardware resources like computer, CDs, videotapes, multimedia,
telephone, scanner, etc. The world of ICT exists due to the advent of the Internet. So, it becomes
highly important to understand the concept of Internet before moving further.

ICT is thus the integration of information, computation, and technological advancements. It
has made our life simple. It has changed the dimensions of our work, learning, and dealings in

business. In fact, it has changed the whole ecosystem of society and its people.

Just look around your surroundings, you would find your siblings getting study material from
their school through mobile phones, your parents chatting with your relatives, sharing their
experiences through smartphones, your neighbours paying their bills online, your cousin
purchasing goods online, your friend studying through online courses, your doctor using
medical instruments with the support of ICT. There are so many devices that are linked together
to do daily business viz. CD, USB, smart phones, digital camera, remote controls, printers,

scanners, etc.

Hardware is the most visible part of any information system: the equipment such as computers,
scanners, and printers are used to capture data, transform it, and present it to the user as an
output. In this unit, we will focus mainly on the personal computer (PC) and the commonly

used peripheral devices.
Some commonly known range of computer systems are-

° Supercomputers- The term Supercomputer is used to denote the fastest computing
engines available at any given time that are used for running exceptionally demanding

scientific applications.

° Mainframe computers- It provides high-capacity processing and data storage facilities
to hundreds or even thousands of users operating from dumb terminals. A dumb terminal
is a display monitor that has no processing capabilities, because all it’s processing it

depends on the server.

° Servers- Servers have large data storage capacities enabling users to share files and

application software though processing typically occurs on the user’s own machine.

o Workstations- Workstations provide high-level performance for individual users in

computationally intensive fields such as engineering.
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Personal computers (e.g. laptop/notebook computers) - They have a connected monitor,
keyboard, and CPU that are developed into a convenient and flexible business tool,

capable of operating independently or as part of an organizational network.

Mobile devices- such as personal digital assistants or the latest generation of cellular
telephones offer maximum portability plus wireless connection to the internet, although
they do not offer the full functionality of a PC. Also, we are already moving into the age
of wearable computers for medical or security applications, embedded computers in
appliances ranging from motor cars to washing machines, and the smart card which

provide identification, banking facilities, medical records, and many more.

2.4

POPULAR ICT (HARDWARE) RESOURCES

Input Devices-

Data may enter an information system in a variety of different ways and the most appropriate

input device usually depends on the type of data being entered into the system. Following are

the frequently used input peripherals-

Keyboard- A lot of input still happens with the help of a keyboard. Usually, the
information that is entered by means of a keyboard is displayed on the monitor. The
layout of most keyboards is similar to that of the original typewriter on which it was
modelled.

Pointing Devices [Mouse]- The now ubiquitous electronic mouse is an essential input
device for use with any graphical user interface. It consists of a plastic moulded housing
designed to fit snugly in the palm of the hand with a small ball at its bottom. Moving the
mouse across a flat surface will translate the movements into a rolling action of the ball.
This is translated into electronic signals that direct the corresponding movement of a
cursor on the computer monitor. Buttons on the mouse can then be used to select icons
or menu items, or the cursor can be used to trace drawings on the screen.

Pointing devices [Trackball]- The less popular trackball operates exactly like an
‘upside-down’ mouse except that the ball is much larger and instead of the mouse being
moved over a surface the user manipulates the ball directly. Originally popular in
educational laboratory settings and for laptop computers, trackballs are now mainly
confined to exhibition displays and other public terminals.

Touch Screens- Touch-screens are computer monitors that incorporate sensors on the
screen panel itself or its sides. The user can indicate or select an area or location on the
screen by pressing a finger onto the monitor. Light and touch pens work on a similar
principle, except that a stylus is used, allowing much finer control. Touch pens are more
commonly used with handheld computers such as personal organizers or digital
assistants. They have a pen-based interface whereby a stylus (a pen without ink) is used

on the small touch-sensitive screen of the handheld computer, mainly by means of ticking
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off pre-defined options. Although, the fancier models support data entry either by means
of a stylized alphabet, which resembles a type of shorthand, or some other more
sophisticated handwriting recognition interface.

° Digitizer- Digitizer tablets also use a pressure-sensitive area with a stylus. This can be

used to trace drawings. A similar conceptual approach is used for the touchpad that can
be found on the majority of new notebook computers, replacing the more awkward
joystick or trackball. The user controls the cursor by moving a finger across a fairly small
rectangular touch-sensitive area below the keyboard, usually about 5 cm by 7 cm.
A large number of game interfaces have been developed to provide a more realistic and
natural interface in various gaming situations and simulations: the joystick, steering
wheel, foot pedal, and other gaming devices. They all perform functions similar to the
mouse in that they allow the user to control a cursor or simulate generally real-time
motion control. You can contact your nearest game arcade for further details.

e  Optical scanners and readers [Optical Scanner]- Optical Scanners use light-emitting
devices to illuminate the printing on paper. On the basis of the amount of light emitted,
a light sensor determines the position and darkness (or colour) of the markings on the
paper. Special-purpose optical scanners are in use by postal services to read and /
interpret hand-written postal codes. General-purpose scanners are used with personal
computers to scan in images or text. These vary from handheld devices (see picture) to
flatbed scanners which feed input documents one sheet at a time. A common use of
optical scanners is the scanning of black-and-white or colour images and pictures. When
scanning text, it is necessary to load additional optical character recognition (OCR)
software that converts the scanned raster-image of the text into the equivalent character
symbols, so that they can be edited using word processing software.

° Optical scanners and readers [Barcode Scanner]|- Barcode scanners detect sequences
of vertical lines of different widths, the ubiquitous barcode as found also on the back of
this book. These scanners have become very popular with retailers due to the fact that all
pre-packaged products are now required to have a product bar code on their packaging,
following the standard laid down by the South African Article Numbering Association
(SAANA). Libraries and video shops now also commonly use bar code scanners. They
are more generally used for tracking and routing large numbers of physical items such as
for asset inventory purposes in many larger organizations, postal items by the postal
services and courier services, or for luggage handling by airlines.

° Optical scanners and readers [Optical mark readers]- Optical mark readers are
capable of reading dark marks on specially designed forms. The red multiple-choice
answer sheets in use at many educational and testing institutions are a good example.

° Magnetic Card Reader- A magnetic card reader reads the magnetized stripe on the back
of plastic credit-card size cards. These cards need to be pre-recorded following certain

standards. Although the cards can hold only a tiny amount of information, they are very
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popular for access (door) control and financial transactions (ATMs and point-of-sale
terminals).

Magnetic ink character recognition (MICR)- MICR uses a special ink (containing
magnetisable elements) and a distinct font type. It is used mainly in the banking sector
for the processing of cheques.

Touch-tone devices- Touch-tone devices can use a voice telephone to contact computer-
based switchboards or enter information directly into remote computers. Many corporate
telephone help-lines rely on the customer pressing the touch-tone telephone buttons to
route his/her call to the correct operator by selecting through a menu of possible options.
Indian banks also enable their clients to perform a number of banking transactions via
telephone.

Biometric devices- Biometric devices are used to verify personal identity based on
fingerprints, iris or retinal scanning, hand geometry, facial characteristics, etc. A
scanning device is used to capture key measurements and compare them against a
database of previously stored information. This type of authentication is becoming
increasingly important in the control of physical access.

Voice-recognition devices- Voice-recognition devices has recently made a strong entry
into the market with the availability of low-cost systems that work surprisingly well with
today’s personal computers. These systems allow for voice control of most standard
applications (including the operating system). With voice control, the computer
recognizes a very limited number (50 or less) of frequently used, programmable system
commands (“‘save”, “exit”, “print”) from a variety of users. In fact, these systems are not
only used for the interface of computer programs, they are also slowly making an

appearance in consumer appliances, novelty items, and even motor cars too.

Output Devices-

Output devices are used to transform computer-readable data back into an information format

that can be understood by humans. Input devices collect data from users and process it at the

CPU finally sending it to us an output. Following are the output devices used in computers-

Display screens [Cathode Ray Tube|- The desk-based computer screen is the most
popular output device. The standard monitor works on the same principle as the normal
TV tube: a ray gun fires electrically charged particles onto a specially coated tube (hence
the name Cathode-Ray Tube or CRT). When the particles hit the coating, the coating is
being excited and emits light. A strong magnetic field guides the particle stream to form
the text or graphics on your familiar monitor. CRTs vary substantially in size and
resolution. Screen size is usually measured in inches diagonally across from corner to

corner.
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° Display screens [Liquid Crystal Display] - A technology that has received much
impetus from the fast-growing laptop and notebook market is the liquid crystal display
(LCD). LCDs have matured quickly, increasing in resolution, contrast, and colour
quality. Their main advantages are lower energy requirements and their thin flat size.
Although alternative technologies are already being explored in research laboratories,
they currently dominate the “flat display” market.

° Display screens [Light Emitting Diodes]- Organic light-emitting diodes (OLED) can
generate brighter and faster images than LED technology and require thinner screens, but
they have less stable colour characteristics, making them more suitable for cellular
telephone displays than for computers.

° Screen Projectors- Originally developed for the projection of video films, the current
trend towards more portable LCD-based lightweight projectors is fuelled by the needs of
computer-driven public presentations. They are rapidly replacing the flat transparent
LCD panels that needed to be placed on top of an overhead projection unit. Though the
LCD panels are more compact, weightless, and are much cheaper.

° Printers- Printers are the most popular output device for producing permanent, paper-
based computer output. Although they are all hardcopy devices, a distinction can be made
between impact and non-impact printers. With impact printers, a hammer or needle
physically hits an inked ribbon to leave an ink impression of the desired shape on the
paper. The advantage of the impact printer is that it can produce more than one
simultaneous copy by using carbon or chemically-coated paper. Non-impact printers, on
the other hand, have far fewer mechanically moving parts and are therefore much quieter
and tend to be more reliable.

° Plotters- Plotters are mainly used for engineering and architectural drawings. A plotter
consists of one (or several, in the case of colour plotters) pen(s) affixed to an arm. As the
arm moves across the sheet of paper, the pen draws lines onto the paper. It is ideal for
line drawings such as plans, especially in cases where the paper size exceeds that which
can be accommodated by the other types of printers.

° Sound output- It is required by most multimedia applications and sophisticated games.
The sound card in many of today’s personal computers synthesizes sound by drawing
from a library of stored sounds, essentially using the same process as found in music
keyboards.

° Musical Instrument Digital Interface (MIDI) - Modern day music production would
be impossible without a vast array of electronic instruments and keyboards. These are
typically controlled by a personal computer by means of Musical Instrument Digital
Interface, a common standard for linking, controlling and processing electronic music.

° Speech synthesis- Speech synthesis is the production of speech-like output using an
artificial voice. Although the lack of intonation still makes the voice sound artificial, the
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technology is reasonably mature and can be found anywhere from talking clocks and

luxury cars to automated responses for telephonic directory enquiries.

ICT Resources, helpful for technology-enhanced learning-

Tablet- A tablet computer (or sometimes called a tablet) is a type of computer that can
be carried easily. Users control a tablet mostly by using its touch screen with multi-touch
technology similar to a smartphone. The screen can be anywhere from 7 inches (18 cm)
(sometimes called a phablet) to 12 inches (30 cm) in size, but many have a screen size of
about 10 inches (25 cm) diagonal. Almost all tablet computers can access the Internet
using Wi-Fi, and many can use mobile phone networks like 2G, 3G, and 4G. Tablets are
lighter, more portable, have longer battery life, make less heat, and do not need a mouse
or keyboard to be connected. Typing is usually done on the touch screen with a “virtual

keyboard’ that appears on the screen.

Interactive Whiteboard- An interactive whiteboard is a large interactive screen that
connects a computer and a projector. The projector projects the computer's desktop onto
the screen of the interactive whiteboard. The user can control the computer by using a
special pen, finger, or another tool to touch the screen of the interactive whiteboard.
Normally, interactive whiteboards are fixed on walls. However, there are some mobile
interactive whiteboards. Interactive whiteboards are used in many different places such
as in classrooms, in workgroups, and in training rooms for professional coaching.
Interactive whiteboards are the modern version of the traditional whiteboards used in

schools.

Graphic Card- It is a circuit board that is placed inside the computer system to display

images through the monitor. It ensures high-quality video at a high speed.

Sound Card- It helps the computer to convert digital signals into sound waves so that
one can hear it. The sound card audio ports are placed at the back of the computer system
and marked with different colours. For example white/yellow colour is used to mark

digital out whereas the blue colour is used for sound in.

Network Card- Network Interface Card (NIC) helps the computer system to
interconnect with local networks or the Internet. It contains the circuitry which is required
to communicate and interact using wired or wireless connections. Wired connections are
referred as Ethernet Connection (used in LAN) and wireless as in Wi-Fi. It would not be
possible to even send an email without NIC.

Modem- Modem Stands for Modulator Demodulator. In order to share the data, we
require two modems, sending modem and receiving modem. The sending modem
converts the data into signals which can be transmitted through a phone line. The

receiving modem demodulates the signals back to digital data. It converts the data in a
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suitable form so that it can be transferred from one device to another by changing analog
signals into digital signals and vice versa. It is an interface between the user and the
internet. There are two types of modem- (i) Ethernet - It is a wired modem which can be

plugged into any network card, (ii) Wireless - It connects to a computer using wireless
LAN(WLAN)

e  Router- It is the device that ensures the transfer of data from one network to the other.
The information is sent from the source in small packets. It is the responsibility of the
router to forward these data packets to the marked destination (receiver) by following

appropriate routing protocol for find the optimum route.

2.5 ICT (HARDWARE) RESOURCES AND APPLICATIONS

Information and communication technology (ICT) can complement, enrich, and transform

education for the better. UNESCO shares knowledge about the many ways technology can
facilitate universal access to education, bridge learning divides, support the development of
teachers, enhance the quality and relevance of learning, strengthen inclusion, and improve
education administration and governance. We need to continue making new efforts to further
develop the capacities of teachers and learners to make effective use of appropriate
technologies for learning. Technology-enabled learning aims to focus on increasing access to
quality teaching and learning by supporting policy formulation and innovation in the
application of ICT in education, and the development of ICT skills. In order to understand the
role and applications of ICT (hardware) in technology-enabled education one must be aware

of hardware resources used in accessing ICT in everyday life.

2.6 POINTS TO REMEMBER

° To share data (send or receive) in networks we require two modems- sending modem and

receiving modem.

° There are two types of modem- (i) Ethernet- It is a wired modem that can be plugged into
any network card (ii) Wireless- It connects to a computer using wireless LAN (WLAN).

° The Network Interface Card (NIC) helps the computer system to interconnect with local
networks or the Internet.

e  An interactive whiteboard is a large interactive screen that connects a computer and a
projector.

° Plotters are mainly used for engineering and architectural drawings.

° Biometric devices are used to verify personal identity based on fingerprints, iris or retinal
scanning, hand geometry, facial characteristics, etc.

° Digitizer tablets also use a pressure-sensitive area with a stylus. This can be used to trace

drawings.

2.7 GLOSSARY
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Router- A device that ensures the transfer of data from one network to the other network.

Modem- Stands for Modulator Demodulator. It converts the data in a suitable form so
that it can be transferred from one device to another by changing analog signals into

digital signals and vice versa.

Sound Card- It helps the computer to convert digital signals into sound waves so that one

can hear it.

Screen Projectors- Originally developed for the projection of video films, the current
trend towards more portable LCD-based lightweight projectors are in demand.

MICR- Uses a special ink (containing magnetisable elements) and a distinct font type. It
is used mainly in the banking sector for the processing of cheques.

Supercomputers- The term Supercomputer is used to denote the fastest computing
engines available at any given time that is used for running exceptionally demanding

scientific applications.

2.8

CHECK YOUR PROGRESS

Descriptive type questions-

a)
b)
©)
d)

Define the role of hardware resources to the functioning of a computer system.
List the input devices with their right uses.
Explain the uses of different types of computer systems available.

What do you understand by output devices? List the popular output devices.

Objective type questions-

a)

b)
©)

d)

e)

A sound card helps the computer to convert digital signals into sound waves so that one
can hear it.(True/False)

MIDI stands for Musical Instrument Digital Interface.(True/False)

Organic Light-Emitting Diodes (OLED) can generate brighter and faster images than
Light Emitting Diodes (LED). (True/False)

A magnetic card reader reads the magnetized stripe on the back of plastic credit-card size
cards. (True/False)

Servers have large data storage capacities where users unable to share files and
application software. (True/False)

Answers (objective type question)-

[a] True [b] True [c] True [d] True [e] False
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3.1 INTRODUCTION

There is an urgent need for quality software and digital materials for use in schools. Teachers

and students must become discerning and knowledgeable ICT users. The school environment
has to be fully supportive of ICT, making available expert assistance and advice to the teacher
in this rapidly-changing field. New forms of curriculum and assessment are called for new
ways of organising schools if the dramatic educational potential of ICT is to be delivered and
realised. A report made by the National Institute of Multimedia Education in Japan proved that
an increase in the use of ICT in education with integrating technology to the curriculum has a
significant and positive impact on student achievements. The results specifically showed that
the students who are continuously exposed to technology through education has better
‘knowledge’, presentation skills, innovative capabilities, and are ready to take more efforts into
learning as compared to their counterparts. In this unit, we will discuss ICT resources from the

viewpoint of software resources used for technology-enhanced education.
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3.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

e  Understand the overview of the software and its role.
e  Explore the types of software.

° Define Operating system, its functions, and types.

° Define programming languages.

) Explore the free and Open Source Software (FOSS).

3.3 SOFTWARE OVERVIEW

Software is a way to communicate with the blind hardware of the computer system. It consists

of all the instructions that tell the hardware how to perform a task. Software is developed
through a programming language. Software, commonly known as programs or apps can be

broadly divided into two categories- (i) System Software and (ii) Application software.

System software helps to run the computer hardware and computer system itself. System
software includes operating systems, device drivers, diagnostic tools, and more. An operating
system is a type of system software that manages the hardware and creates the interface

between the hardware and the user.

Application software allows users to accomplish one or more tasks. It is meant to perform
several tasks for the user including word processing, web browsing, and other task which
require installation of the software. Applications software are designed and developed as per

the users/customers requirements.

3.4 TYPES OF SOFTWARE
[1] System Software-

System software comprises device drivers, operating systems, servers, software components,
and programming software (for writing programs through tools such as editors, linkers,
debuggers, compilers/interpreters, and others). The most important is the operating system,

here we will discuss the operating system.
Operating System-

An operating system handles signals or instructions received from input and output devices,
manages memory usage, and control peripherals. Therefore, the operating system is the most
important program a computer must run on. DOS (Disk Operating System), Microsoft
Windows XP, and Mac OS are some examples of personal computer operating systems. Server-

level computers use operating systems such as UNIX and Microsoft Windows Server.
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Portable devices, such as cellular phones, smartphones, and personal data assistants use
specialized, ‘embedded’ operating systems that enable them to do many tasks. Some of the
functions operating system include- starting the computer (also called ‘booting’), managing
and monitoring other programs, memory management, communications management,
management of peripheral devices, enabling interaction between the user and the computer
system through the use of external input devices, monitoring and security of access to data and

applications.

Today’s personal computers use a Windows-based operating system that incorporates many of
the original concepts in DOS. Operating systems differ in functionality, flexibility, and ease of
use. Today there are a number of different operating systems in use. They can be as either
classified as personal operating systems, network (client/servers) operating systems, and

handheld operating systems.

To interact with the computers a user uses a part of the operating system called a user interface.
The functions of the user interface are to start application programs, manage secondary storage,
such as hard disks, as well as manipulate files and folders, and finally shut down the computer

safely. The three principal types of interfaces are-

° Graphical User Interface (GUI)
e  Command-line interface/Character User Interface (CUI)

A graphical user interface is a form of user interface that allows users to interact with
electronic devices through graphical icons, menu and an audio indicator such as primary
notation. A GUI is a user-friendly interface that eliminates the need to remember complex
computer commands. CUI is a way for users to interact using commands with computer
programs. In CUI based computers user interacts using text-based commands. Examples
CUTIs are MS-DOS and the Windows Command Prompt.

Functions of an Operating System-

° Managing computer resources- The operating system allows application software
programmes such as word processing, spreadsheet, and database packages to
communicate with the computer’s hardware. For example, if you work on a document in
Excel and you want to print the document, you just press the print button on the toolbar.
Excel will direct the operating system to select a printer to print the document. The
operating system then notifies the computer to begin sending data and instructions to the
appropriate program to get the document printed. The operating system, therefore, acts

as an interface between the application programmes and the hardware.

° Managing files and memory- The operating system manages all files on a computer. It
keeps tracks of the locations where programmes and data are stored within the

computer’s memory. For example, when you open a file that has been saved to the hard
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drive you are first instructing the computer to find the file and then to open it. The
operating system also allows you to easily find files stored in secondary storage devices.
Other file management functions include copying, erasing, renaming, and backing-up
files.

° Maintaining security- In networks and larger computers, each user is given a user name
or ID and password to gain access to the computer system. The operating system keeps
a register of all these names so that only persons with valid usernames and passwords
can access the system. This prevents access by hackers and unauthorised persons. The
operating system also keeps a log to records users logged in, the length of time each user
stayed on the system, and the tasks they performed. Administrators can check the log to

look for security breaches and the abuse of resources.

° Managing tasks- A computer can perform many tasks simultaneously. One way of doing
this is multi-tasking — the ability of the computer to run more than one programme at the
same time. For example, a user can listen to music on his/her computer while typing a
document or typing an e-mail while another e-mail is being sent. In the case of networks,
the multiuser operating system allows more than one user to access the same data at the

same time.

° Providing a user interface- Many operating systems functions are never apparent on the
computer’s display screen. What you see on the screen is called the user interface. The

interface helps the user to interact with the computer.
Types of operating systems-
[a] Batch operating system-

It is a type of operating system where users directly do not interact with the computer system.
The user prepares his/her job in the form of batch (a group of tasks) and submits it to the
computer for processing. To speed up processing, jobs with similar needs are batched together
and run as a group. The batch operating system have some difficulties- lack of interaction
between the user and the job, slower speed of the mechanical I/O devices than the CPU,
difficulty in providing the desired priority, etc. However, some advantages involved with the
batch operating system are- It is very difficult to guess time required for any job to complete,
processors of the batch systems know how long the job would be when it is in a queue, the idle

time for the batch system is very less, etc.
[b] Time-sharing operating systems-

Time-sharing is a technique that enables many people located at various terminals to use a
particular computer system at the same time. Time-sharing or multitasking is a logical
extension of multiprogramming. The processor's time which is shared among multiple users

simultaneously is termed as time-sharing. The main difference between Multiprogrammed
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Batch Systems and Time-Sharing Systems is that in the case of Multi programmed batch
systems, the objective is to maximize processor use, whereas, in Time-Sharing Systems, the

objective is to minimize response time.
[c] Distributed Operating System—

The distributed operating systems are referred to as loosely coupled systems or distributed
systems. These system’s processors differ in size and function. The major benefit of working
with these types of operating system is that it is always possible that one user can access the
files or software which are not present on his system but some other system connected within

this network i.e., remote access is enabled within the devices connected in that network.
[d] Network operating System-

A Network Operating System runs on a server and provides the server the capability to manage
data, users, groups, security, applications, and other networking functions. The primary
purpose of the network operating system is to allow shared file and printer access among
multiple computers in a network, typically a local area network (LAN), a private network, or
to other networks. Examples of network operating systems include Microsoft Windows Server
2003, Microsoft Windows Server 2008, UNIX, Linux, Mac OS X, Novell NetWare, and BSD.
The network operating systems are having the following features- centralized servers, high
security at the server level, upgrades to new technologies and hardware that can be easily

integrated into the system, etc.
[e] Real-time operating System-

A real-time system is defined as a data processing system in which the time interval required
to process and respond to inputs is so small that it controls the environment. The time taken by
the system to respond to an input and display of required updated information is termed as the
response time. A real-time operating system must have well-defined, fixed time constraints,
otherwise, the system will fail. For example, scientific experiments, medical imaging systems,

industrial control systems, weapon systems, robots, air traffic control systems, etc.
[2] Application Software-

Computer software is basically programs and procedures intended to perform specific tasks on
a computer system. The user directly deals with the application software for a specific purpose.
The application software (program) also called end-user programs or apps can be a single
program or a group of small programs often referred as an application suite. Some examples

of application software are-
° Word processing software (example- MS Word, WordPad, and Notepad).
° Database software (example- Oracle, MS Access, MY SQL, etc).

° Spreadsheet software (example- Apple Numbers, Microsoft Excel, Open Office).
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° Multimedia software (example- Real Player, Media Player, VLC player, etc).
° Presentation Software (example- Microsoft PowerPoint, Keynotes, open office, etc).

° Enterprise Software (example- Customer relationship management system, Hospital

Management Software, etc).

° Information Worker Software (example- Documentation tools, resource management

tools, etc).

° Educational Software (example- dictionaries like Encarta and Britannica, mathematical
software like MATLAB and others like Google Earth, NASA World Wind).

° Simulation Software (example- Flight and scientific simulators).
e  Application Suites (example- OpenOffice, Microsoft Office).

° Software for Engineering and Product Development (example- IDE or Integrated

Development Environments).
Utility programs-

Utility programs, as the name suggests not only help in executing various crucial tasks for the
operating system but also help in the overall maintenance of the computer system. Operating
systems such as Windows, macOS, and Linux come with their own set of utility programs to
maintain and execute different utility functions such as formatting, compressing, scanning,
exploring, and much more. Utility programs also assist with the management of computer
functions, resources, and files. Some common tasks performed by utility programs are- Disk
Defragmentation, Disk Clean-up, File Management, Compression, Disk Management,

Antivirus, Firewall, etc.

3.5 PROGRAMMING LANGUAGES

Do you use various applications (apps) in your smart phone? Do you ever think about how to

develop these apps? Answer is simple, all the applications are developed using programming
languages. There are a bunch of programming languages available. A computer is a device that
can accept human instruction, processes it, and responds to it. In other words, a computer is a
computational device which is used to process the data under the control of a computer

program.

Computer programming languages allow us to give instructions to a computer in a language
the computer understands. Just as many human-based languages exist, there is a list of
computer programming languages that programmers can use to communicate with a computer.
The portion of the language that a computer can understand is called a binary. Translating
programming language into computer understandable language (or in binary) is known as

‘compiling.” Each programming language has it’s own translator (except machine language).
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Some popular languages of computer are- C, Python, C++, C#, R, Ruby, ADA, Java, Visual
BASIC, Perl (Practical Extraction and Report Language), PHP, JavaScript, PROLOG
(Programming in Logic), Document formatting languages (e.g. TeX, PostScript, SGML), etc.

A computer program is a sequence of instructions along with data to process needful action. In
other words, a computer is a computational device that is used to process the data under the
control of a computer program.
So, these computer programs are written using a programming language which is called high-
level programming languages. High-level programming languages are nearly human languages
which are more complex than the computer understandable (computer only understands binary
language) language which is called machine language, or low-level language. Basically,
computer programming languages are divided into two categories, as- low-level language and

high-level language.
Example of a low-level programming language is machine language.

Examples of some high-level programming languages are- FORTRAN (Formula Translation),
ALGOL (Algorithmic Language), LISP (List Processing), COBOL (Common Business-
Oriented Language), BASIC (Beginner’s All-purpose Symbolic Instruction Code), SQL
(Structured Query Language), Pascal, Logo, Ada, etc.

Note- The advantages of both the low- and high-level programming language are merged

within the middle-level languages. Examples of such languages are- C, C++, JAVA, CH#, etc.
Characteristics of a programming Language—

° A programming language must be simple, easy to learn and use, have good readability,

and 1s human recognizable.
° A portable programming language is always preferred.

° Programming language’s efficiency must be high so that it can be easily converted into

machine code and executed consumes little space in memory.

° A programming language should be well structured and documented as it is suitable for

application development.

e  Necessary tools for development, debugging, testing, and maintenance of a program must

be provided by a programming language.

° A programming language should provide a single environment known as the Integrated

Development Environment (IDE).

e A programming language must be consistent in terms of syntax and semantics.

3.6 INTRODUCTION TO OPEN SOURCE SOFTWARE
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Open-source software is released through a specific kind of license that makes its source code
legally available to end-users. There are many such licenses, but typically software is

considered open source if-

It is available in source code form without additional cost i.e. users can view the code that

comprises the software and make any kind of changes to it they want.

The source code can be repurposed into other new software, meaning anyone can take the

source code and distribute their program from it.
Is open-source software always free?

Open-source software does not necessarily mean that executable software is given always free
because converting that source code into an enforceable code requires expertise, time, and

SCrvers.

Open-source software is also sometimes conflated with the free software movement, which can
add to the confusion around whether open source means ‘free.” The free software movement
grew out of the ‘hacker culture’ of the 1970s and was formally founded by Richard Stallman
as part of the GNU Project and the non-profit Free Software Foundation. Usually, ‘free
software’ is meant to emphasize freedom in the rights of end-users, but can sometimes be

confused as meaning ‘free of cost.’

One thing is interesting, neither free software nor open-source software denotes anything about
cost both the kinds of software can be legally sold or given free. The primary difference
between them has to do with the sharing. For free software, if you make changes to source code
and want to share them, you also have to share those changes back with the original project.
For open-source software, there is typically no such restriction. Despite their practical
differences, free software and open-source software do share common values. Both the terms
'free' and 'Open Source' are combined in a common phrase, as “Free and Open Source
Software” (FOSS).

FOSS vs. Proprietary Software-

The key difference between proprietary software and FOSS is the availability of the source
code. Proprietary or commercial software like Microsoft Windows and Adobe Photoshop are
not available to end-users as source code where free software like the Linux kernel and open-
source software such as Google Chromium (the basis of the Chrome web browser) are available

as source code through their respective licenses.

The Open source license allows software to be freely used, modified, and shared. It should also
be approved by the Open Source Initiative (OSI), a license must go through the Open Source
Initiative's license review process. Some popular open-source licenses are- Apache License
2.0, BSD 3-Clause ‘New’ or ‘Revised’ license, BSD 2-Clause ‘Simplified’ or ‘FreeBSD’
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license, GNU General Public License (GPL), GNU Library or Lesser General Public License
(LGPL), MIT license, Mozilla Public License 2.0, Common Development and Distribution

License and Eclipse Public License version 2.0.
Why does Open-source software matter?

Open-source software matters to everyone, not just programmers because it unlocks the
potential of many more people to become innovators than a closed-source (proprietary
Software) model. Open source communities, for instance, are organized around open source
projects where anyone with skills can join and contribute code. These groups still maintain
standards around contributing to open source projects just like proprietary software teams do

but they open up this process to anyone in the world who wants to contribute.

This open-source development model has resulted in some of the most important applications
and cloud platforms in use today. The most popular of which comprise LAMP (Linux, Apache,
MySQL, PHP), a model of service stacks that undergird much of the web.

Brief about LAMP-

Linux- is an open-source Operating System (OS) and the largest open source project in the

world.
Apache- is an open-source cross-platform web server that played a key role in the early web.

MySQL- is an open-source Relational Database Management System (RDBMS) used by many

database-driven web applications.

PHP- a general purpose scripting language used in software development (Perl or Python

languages are sometimes substituted).

Other examples of popular open source technologies include the Android mobile OS, the
Mozilla Firefox web browser, the widely-used version control system Git, and the two related
office suites OpenOffice and LibreOffice. On a broader scale, most innovation in the areas of
cloud computing, big data, and artificial intelligence have been derived from open-source

software projects.

Open-source software has other advantages for businesses and individual programmers. When
source code is open, it makes it easier for anyone to study it to develop new programming
skills. Open-source licensing also allows students to get practice by editing the code and
sharing it with friends and the broader open-source community, or even contributing fixes to
existing open source projects. The open-source software also offers businesses the ability to
customize it to meet their specific needs. Some also prefer open-source software because there
are many more developers looking for security vulnerabilities when the source code is openly
available and has an active community supporting it. The open-source way is so effective
because it can attract tremendous technical talent much of the innovation in technology is
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taking place in the open source community, and people all over the world end up using open-

source software.
SourceForge (https://sourceforge.net)-

SourceForge is an Open-Source software community resource dedicated to helping open-
source projects as successful as possible. It helps to create a premiere resource for open-source

software development and distribution.

With the tools it provides, developers on SourceForge create powerful software in over 502,000
projects and host millions of registered users. It also connects more than 32 million monthly
users with all of these open source projects and serves more than 2.6 million downloads a day.
The SourceForge business software directory lists over 50,000 software titles. IT professionals
come to SourceForge to develop, download, review and publish open source, and business
software. SourceForge is the largest, most trusted destination for Open Source Software

discovery, software reviews, and software development on the web.

3.7 POINTS TO REMEMBER

° Software is a way to communicate with the blind hardware of the computer system. It

consists of all the instructions that tell the hardware how to perform a task.

° System software helps to run the computer hardware and computer system itself. System
software includes operating systems, language translators, device drivers, diagnostic

tools, and more.

° Application software is the category of programs which include word processing, web
browsing, and almost any other task for which you might install the software.
Applications software are designed and developed as per the users/customers

requirements.

° An operating system handles signals or instructions received from input and output

devices, manages memory usage, and control peripherals.

° Some of the functions operating system include- starting the computer (also called
‘booting’), managing and monitoring other programs, memory management,
communications management, management of peripheral devices, enabling interaction
between the user and the computer system through the use of external input devices,

monitoring and security of access to data, and applications.

° To interact with the computers, a user uses a part of the operating system called a user
interface, which is basically of two types e.g. Graphical User Interface (GUI), Character
User Interface (CUI).

° The operating system manages all files on a computer. It keeps tracks of the locations

where programmes and data are stored within a computer’s memory.
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° A Network Operating System runs on a server and provides the server the capability to
manage data, users, groups, security, applications, and other networking functions.

° Time-sharing is a technique that enables many people located at various terminals to use
a particular computer system at the same time.

° Utility programs not only help in executing various crucial tasks for the operating system
but also help in the overall maintenance of the computer system.

° Computer programming languages allow us to give instructions to a computer in a
language the computer understands. Just as many human-based languages exist, there is
a list of computer programming languages that programmers can use to communicate
with a computer.

° Open-source software is released through a specific kind of license that makes its source
code legally available to end-users.

3.8 GLOSSARY

° GUI- Graphical User Interface.

° CUI- Character User Interface.

° LAMP- Linux, Apache, MySQL, and PHP.

° FOSS- Free and Open Source Software.

) IDE- Integrated Development Environment.

) DOS- Disk Operating System.

3.9 CHECK YOUR PROGRESS

Descriptive type questions-

a)  Why does open source software matter?

b)  Define FOSS and Proprietary Software.

c) Is open-source software always free?

d)  What do you understand by programming languages?

e) Define the role of Application software.

f)  Briefly define the types of operating system.

g)  Why Operating system is important for the execution of a computer system?

Objective type questions-

a)

System software includes operating systems, language translator, device drivers, etc.
(True/False)
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b)

c)
d)

g)

Operating systems differ in functionality, flexibility, and ease of use. (True/False)
The operating system manages only folders on a computer. (True/False)

A Network Operating System runs on a server and provides the server the capability to
manage data, users, groups, security, applications, and other networking functions.
(True/False)

The operating system keeps tracks of the locations where programmes and data are stored

within the computer’s memory. (True/False)

A computer program is a sequence of instructions along with a memory to process

needful action. (True/False)

The Open source license allows software to be freely used, modified, and shared.
(True/False)

Answers (objective type question)-

[a] True [b] True [c] False [d] True

[e] True [f] False [g] True

3.10 BIBLIOGRAPHY/REFERENCES
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UNIT- 4
ICT RESOURCES AND APPLICATIONS- III
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4.2 OBJECTIVES
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4.4 OPEN EDUCATION AND OPEN LEARNING INITIATIVES
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4.10 BIBLIOGRAPHY/REFERENCES

4.11 SUGGESTED READINGS

4.1 INTRODUCTION

The applications of ICT in our daily life have changed the ways individuals access and

elaborate knowledge. In the 21st century, digital skills are essential for learning and even living
a successful life (accessing resources at anytime and anywhere). In order to grab the new
opportunities, digital technologies are opening possibilities in many areas. Individuals have to
develop the right set of skills to make meaningful use of these technologies in their life.
Increasing use of digital technologies at work (especially in teaching & learning) is raising the
demand for new skills along with the following directions-

o ICT specialist skills to programme, develop applications, and manage networks.
° ICT generic skills to use such technologies for professional purposes.

° ICT complementary skills to perform new tasks associated to the use of ICTs at work,

e.g. information-processing, self-direction, problem-solving, and communication.
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Raising the demands of new-age skills, digital technologies are also creating new opportunities
for skills development. Massive Online Open Courses (MOOCs) and Open Educational
Resources (OER) modify learning methods and give access to quality resources to a larger
population. The use of digital technologies in formal education and vocational training has the
potential to improve learning, although the outcomes depend on the capacity to link these tools
to effective pedagogy. Here we are going to elaborate on some useful ICT resources and
repositories for future use and access as well as we will briefly describe the overview of the
Learning Management System (LMS).

4.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

° Define new age learning skills.
e  Explore open education and learning initiatives.
° Explore digital repositories for e-learning.

° Define Learning Management System.

4.3 ICT RESOURCES AND NEW AGE LEARNING SKILLS-

Knowledge involves two components, e.g. inter-linked content and skills. Content includes

facts, ideas, principles, evidence, and descriptions of processes or procedures. Generally,
subject instructors are well trained in content and have a deep understanding of the subject
areas in which they are teaching. Skill development is the process of lifelong learning. The

new-age learning skills include-

° Communications Skills- With the traditional communication skills of reading, speaking,
and writing coherently and clearly we need to add social media communication skills.
These might include the ability to create a short YouTube video to capture the
demonstration of a process or to pitch sales, the ability to reach out through the Internet
to a wide community of people with one’s ideas, to receive and incorporate feedback, to

share information appropriately, and to identify trends and ideas.

° The ability to learn independently- To take responsibility for working out what you need
to know and where to find that knowledge. This is an ongoing process in knowledge-
based work because the knowledge base is constantly changing. It could be learning
about new equipment, new ways of doing things or learning from whom do you need to

get the job done.

° Ethics and responsibility- Are the essential values required to build trust in both the real
and the business world where there are many different players and a greater degree of

reliance on others to accomplish one’s own goals.
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° Teamwork and flexibility- Although many workers work independently or in very small
companies they depend heavily on collaboration and the sharing of knowledge with

others in related but independent organizations.

° Thinking Skills- e.g. critical thinking, problem-solving, creativity, originality, and
strategizing are one of the most important skills needed in a knowledge-based society.
The teaching community should have always pride in themselves on teaching such
intellectual skills.

° Digital Skills- Most knowledge-based activities depend heavily on the use of information
technology. However, the key issue is that these skills need to be embedded within the
knowledge domain in which the activity takes place. The use of digital technology needs
to be integrated and evaluated through the knowledge-base of the subject area.

° Knowledge Management- Is perhaps the most over-arching of all the skills. Knowledge
is not only rapidly changing with new research, new developments, and rapid
dissemination of ideas and practices over the Internet. But the sources of information are

increasing with a great deal of variability in the reliability or validity of the information.

OPEN  EDUCATION  AND OPEN  LEARNING
INITIATIVES

Open education is education without academic admission requirements and is typically offered

4.4

online. Open education broadens access to the learning and training traditionally offered
through formal education systems. The qualifier ‘open’ refers to the elimination of barriers that
can preclude both opportunities and recognition for participation in institution-based learning.
One aspect of openness or ‘opening up’ education is the development and adoption of open

educational resources. (Source: https://en.wikipedia.org/wiki/Open_education).

Programs are commonly offered by the educational institutions in online mode or using open
and distance learning mode like e-learning, MOOC, and Open Course Ware to eliminate the
entry barriers e.g. with no academic admission requirements. Where many e-learning programs
are free to follow the costs of acquiring a certification may be a barrier. Thus, many open
education institutes offer free certification schemes accredited by organizations.

In other words, open education is a collection of practices that utilize online technology to
freely share knowledge. The open education movement not only includes the sharing of
knowledge but also follows the following features-

° Publishing research in open journals (open access publishing)
° Releasing data to be reused by others (open data)

° Using, sharing and collaboratively creating software and computer code (open-source
software)
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° Flexible admission policies to institutions or courses (open admissions or open

registration)

o Student assignments that promote student publishing or participating on the open web

(open teaching or open pedagogy)
° Sharing of teaching and research practices (open scholarship)

° Sharing and reuse of teaching and learning materials (open educational resources)

including courses (open courseware) and textbooks (open textbooks)

The above literature is a thematic idea to briefly understand the open education and the types
of activities that the 'open education' encompasses. The 'open education' develops the learning
opportunity for the deprived section of the society with quality learning material globally. To
grab the advantages of open education movement someone needs to have basic IT literate and

Internet savvy.
List of useful resources to access quality learning material-

[a] Open Learning initiatives at Carnegie Mellon University (https://oli.cmu.edu/learn-

more-about-oli)-

You may visit the above link, to freely access the bunch of courses offered under Open

Learning initiatives (OLI).
[b] Open Learning Initiative at Stanford University (http://oli.stanford.edu)-

Open Learning initiative courses are openly and freely available to anyone in the world at
Stanford University who wants to learn- whether you are a student at a college or university or
learning on your own; you can avail the OLI courses using the following link-
http://oli.stanford.edu.

[c] Open Learning at Harvard (https://www.extension.harvard.edu/open-learning-
initiative)-

One can visit the Harvard Open learning initiatives and explore the open courseware (free
courses).

[d] Open Learning at lumen learning (https://lumenlearning.com/courses)-

One can visit the lumen learning (https://lumenlearning.com/courses) initiatives of open

learning and explore the open courseware (free courses).

LIST OF POPULAR DIGITAL REPOSITORIES FOR
TECHNOLOGY ENABLED EDUCATION

Online Learning Resources (under the NMEICT, MHRD, Govt. of India)-

4.5
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° E-PG Pathshala (epgp.inflibnet.ac.in) - e-PG Pathshala is an initiative of the MHRD
under its National Mission on Education through ICT (NME-ICT) being executed by the
UGC. e-Adhyayan, e-Pathya, and UGC-MOOCs are more initiatives of NMEICT where
under e-Adhyayan 700+ e-Books and video contents for the Post-Graduate Courses are

provided.
e  NCERT e-books (www.ncert.nic.in/textbook/textbook.htm)-

° Spoken Tutorial (www.spoken-tutorial.org)- It is an educational content portal where one
can learn various Free and Open Source Software by oneself. The courses offered are of
self-paced, multi-lingual that anybody with a computer and a desire for learning, anyone

can learn from any place, at any time and in a language of their choice.

e  Digital Library Inflibnet (www.inflibnet.ac.in)- The Ministry of Human Resource
Development (MHRD) has formed e-ShodhSindhu merging three consortia initiatives,
namely UGC-INFONET Digital Library Consortium, National Library, and Information
Services Infrastructure for Scholarly Content (NLIST) and Indian National Digital
Library in Engineering Sciences and Technology (INDEST)-AIll India Council for
Technical Education (AICTE) Consortium. The e-ShodhSindhu provides current as well
as archival access to more than 15,000 core and peer-reviewed journals and many

bibliographic, citation, and factual databases in different disciplines.
) SWAYAM PRABHA (TV Channel)-
° E-pathshala (www.epathshala.nic.in)-
° Tamanna (www.ncert.nic.in/tamanna/tamanna.html)-
° NISHTHA (www.itpd.ncert.gov.in)-

° Talk to Teacher (aview.in)- A-VIEW is an indigenously built multi-modal, multimedia
e-learning platform that provides an immersive e-learning experience that is almost as
good as a real classroom experience. A-VIEW is part of the talk to a teacher program
coordinated by IIT Bombay and funded by the Ministry of Human Resource
Development (MHRD).

° Consortium for Educational Communication (www.cec.nic.in)- It is an Inter-University
Centers set up by the University Grants Commission (UGC) of India. It has been
established to address the needs of higher education through the use of a powerful
medium of television along with the appropriate use of emerging Information

Communication Technology (ICT).

° FOSSEE (www.Fossee.in)- Free Open Source Software for Education (FOSSEE) project
promotes the use of FOSS tools to improve the quality of education in our country. This

project aims to reduce dependency on proprietary software in educational institutions.
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E-Kalpa (www.dsource.in)- This project presents three initiatives — providing digital
online content for the design, a social networking environment for design & higher
learning, and creating a digital resource database on design. The project would focus on
knowledge accumulation, storing and dissemination, and education in four sectors -

University, Industry, Government, and the Informal sector.

Virtual Labs (www.vlab.co.in)- This initiative has been taken by the Ministry of Human
Resource Development (MHRD). Virtual Labs project is a consortium activity of 12
participating institutes among them, the IIT Delhi is coordinating institute. Virtual Labs
do not require any additional infrastructural setup for conducting experiments at user
premises. The intended beneficiaries of this project are- all students and faculty members
of science and engineering, high-school students whose inquisitiveness will be triggered,

researchers, and engineering colleges who can share the given resources.
Open Source Courseware Animations Repository (http://oscar.iitb.ac.in/oscarHome.do)-

E-Yantra (www.e-yantra.org)- The e-Yantra is an initiative to spread education in
embedded systems and robotics by IIT Bombay, sponsored by the Ministry of Human
Resource & Development (MHRD). The objective of this project is to provide hands-on
learning to engineering students who have limited access to labs and mentors. The goal
is to create the next generation of (Embedded Systems) engineers in India with a practical

outlook to take on challenging problems and provide solutions.

Quantum & Nano Computing (www.dei.ac.in/dei/quantumNano)- The Quantum-Nano
Centre is a multidisciplinary centre at Dayalbagh Educational Institute, Agra. The
mission of this project is to aggressively explore and advance the application of quantum-

nano systems to a vast array of relevant information processing techniques.
Expert Database & National Researcher Network (vidwan.inflibnet.ac.in)-

Indian Research Information Network System (irins.org/irins)-

Open Educational Resources-

NPTEL (www.nptel.ac.in)-

SWAYAM (www.swayam.gov.in)-
NROER (www.nroer.gov.in)-

Saylor Academy (www.saylor.org)-

OER Commons (Www.oercommons.org)-
Khan Academy (www.khanacademy.org)-

MIT BLOSSOMS (www.blossoms.mit.edu)-
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COL Virtual Learning (www.colvee.org)-

Directory of OER (www.doer.col.org)-

COL’s Institutional Repository (www.oasis.col.org)-
Virtual University of Pakistan (www.ocw.vu.edu.pk)-
LabXchange (www.labxchange.org)-

MIT Open CourseWare (www.ocw.mit.edu)-

Lumen Courses (www.lumenlearning.com)-

MERLOT- Online Learning Resources (www.merlot.org)-
eCampus- Learning Resources (www.ecampusontario.ca)-

Skills Commons (www.skillscommons.org)-

Quizzes/ Testing / Games-

Book Widgets (www.bookwidgets)- Worksheets, simulations, games & more for use in

classrooms and multi-touch books.

Class kick (www.classkick.com)- Easy real-time feedback & formative assessment.
Class marker (www.classmaker.com)- Easy online testing.

Class tools (www.classtools.net) - Several class tools of any kind.

DeckToys (https://deck.toys) - Drag-and-drop lesson creation, differentiate the right
way, full control over your lesson delivery and tracking your progress in real-time.

Educaplay (educaplay.com) - Create numerous interactive games with instant feedback.

Flipgrid (https://info.flipgrid.com) - Create a Grid - that’s your classroom or community.
Add a Topic or two to spark the discussion. Your students share short video responses to

ignite a dialogue. Super simple. Super powerful..

Google Forms (http://forms.google.com)- Easy for quizzes, evaluations or

questionnaires.

Goosechase - Scavenger hunts for the masses. Bold, crazy, and highly addictive.

Incredibly easy to use with all the power you could ever want.

Gynzy - Gynzy is an online whiteboard helping teachers create engaging lessons plans

to engage students in the classroom.

HS5P (www.h5p.org) - Create, share, and reuse interactive HTMLS5 content in your

browser.
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° Learnclick (www.learnclick.com) - Create online cloze quizzes. Simply mark words to

turn them into gaps, dropdown or drag & drop quizzes.

. Poll Everywhere (www.polleveryone.com)- Live interactive audience participation.

Engage your audience or class in real-time.

) Quizizz (www.quizizz.com) - Quizizz is a fun review tool that allows the entire class to

practice together. It’s completely free.

. SurveyMonkey (www.surveymonkey.com)- Create Surveys, Get Answers.

BRIEF OVERVIEW OF LEARNING MANAGEMENT
SYSTEM

The Learning Management System (LMS) may be defined in the user perspective as a virtual

4.6

environment that aims to simulate face-to-face learning environments with the use of
Information Technology. In LMS, the interaction happens through devices that enable
communication either synchronously or asynchronously allowing the creation of different
strategies to encourage dialogue and active participation of students. Learning Management
Systems are web-based systems that enable teachers and students to share materials, submit &
return assignments, and to communicate online. The LMS, mediation involves both the
acquisition of competences and communication skills for all the teachers and students as well
as creation of interactive moments and practical application possibilities for collaborations. To

establish such communication we used chat rooms, forums, blogs, video blogs, etc.

The LMS is enabled to integrate multiple media, different languages & resources while
enabling alternative technologies and presenting information in an organized manner to fulfil
its main purpose which is the construction of learning through interaction. The well-planned
and designed courses perform the key role in teaching-learning using LMS, which is necessary
for e-learning quality. There are several LMS (software) options available in the market
including commercial or proprietary and free and open-source software. Some top rated LMS
options are- BlackBoard (proprietary), Breeze, Moodle (Free and Open Source), plus dotLRN
and the Sakai Project, etc.

In relation to quality standards in LMS, considering the development of information technology
and the growing use of these LMS environments, the importance of identifying those that
comply with minimum requirements arises. These requirements can be expressed in terms of
reliability, scalability, security, sustainability, and adoption of international standards of
quality. Reliability can be obtained through the experience of large universities in using virtual
fields for face-to-face or distance education. Scalability is needed to attend to the large numbers
of students, a fundamental characteristic of e-learning. The adoption of international quality
standards largely depend on the developer team and the options for meeting the needs and goals

of users which can differentiate virtual environment.
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4.7

POINTS TO REMEMBER

The applications of ICT in our daily life have changed the ways individuals access and
elaborate knowledge.

e  Individuals have to develop the right set of skills to make meaningful use of ICT in their
life. Increasing use of digital technologies at work (especially in teaching learning) is
raising the demand for new skill sets.

° Knowledge involves two components e.g. content and skills

° Most knowledge-based activities depend heavily on the use of information technology.

° Open education is education without academic admission requirements and is typically
offered online. Open education broadens access to the learning and training traditionally
offered through formal education systems.

° The open education is a collection of practices that utilize online technology to freely
share knowledge.

° The Learning Management System (LMS) may be defined in the user perspective as a
virtual environment that aims to simulate face-to-face learning environments with the use
of Information Technology.

4.8 GLOSSARY

° LMS- Learning Management System.

) OLI- Open Learning initiatives.

° Knowledge Management- Knowledge is not only rapidly changing with new research,
new developments and rapid dissemination of ideas and practices over the Internet but
the sources of information are also increasing with a great deal of variability in the
reliability or validity of the information.

° Communications Skills- With the traditional communication skills of reading, speaking
and writing coherently and clearly we need to add social media communication skills.

4.9 CHECK YOUR PROGRESS

Descriptive type questions-

a)
b)
c)
d)

What do you understand by new-age learning skills? Explain.
Explain Open Education.
List five digital repositories for e-learning.

Briefly explain the learning management system.

Objective type questions-
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f)
g)

LMS may be defined as a virtual environment that aims to simulate face-to-face learning

environments with the use of Information Technology. (True/False)

In LMS, the interaction happens through either synchronous communication or

asynchronous communication. (True/False)

The objective of the E-Yantra project is to provide hands-on learning to engineering
students who have limited access to labs and mentors. (True/False)

Virtual Labs project is a consortium activity of JNU and Delhi University to provide

virtual practical experience. (True/False)

Open education is a collection of practices that utilize online technology to freely share

knowledge. (True/False)
FOSSEE stands for Free Open Source Software for Enterprise. (True/False)

A-VIEW is an indigenously built multi-modal, multimedia e-learning platform that

provides an immersive e-learning experience. (True/False)

Answer (objective type questions)-

[a] True [b] True [c] True [d] False

[e] True [f] False [g] True

4.10 BIBLIOGRAPHY/REFERENCES
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° nroer.gov.in/welcome (National Repository of Open Educational Resources).

4.11 SUGGESTED READINGS
e  http://oasis.col.org/handle/11599/2447

° Education for the 21st Century- Impact of ICT and Digital Resources, IFIP 19th World
Computer Congress, TC-3 Education, August 21-24, 2006, Santiago, Chile, Editors:
Kumar, Deepak, Turner, Joe (Eds.)

) https://docs.moodle.org/39/en/Main_page

e  https://opentextbe.ca/teachinginadigitalage/chapter/section-1-3-the-skills-needed-in-a-
digital-age/
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INTRODUCTION TO TEXT EDITOR (MS WORD) - 1
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5.11 SUGGESTED READINGS

5.1 INTRODUCTION

MS-Word is a powerful word processor that allows you to create memos, fax coversheet, web
pages, reports, mailing labels, brochures, tables, and many other professional and business
applications. MS Word provides easy graphics handling, calculation of the data tables, ability

to create a mailing list, list sorting, and efficient file management.

5.2 OBJECTIVES

After the successful completion of this unit, you will be able to-
° Describe how to create, open and save a word document

) Discuss MS-Word working tools.

5.3 STARTING MS WORD
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A text editor is any word processing program that you can use to type and edit text. Word Pad
and Notepad for Windows and SimpleText and Text Edit for the Mac are common text editors.

Large programs such as Microsoft Word and Word Perfect are also text editors.

Microsoft Word allows you to create professional-quality documents, reports, letters, and
résumés. Unlike a plain text editor Microsoft Word has features including spell check, grammar
check, text and font formatting, HTML support, image support, advanced page layout, and

more.

Step 1 Click Start Button

Step 2 Click on the ‘sub-menu’ icon.

Step 3 Click on ‘Microsoft Office 2007’ from the sub-menu.

Step 4 Click on the ‘Microsoft office word 2007°.
Basics of MS-Word

° Tabs: - Tabs are the predefined functions and features in the word processor which can

be applied for developing certain characteristics on the entered text.

° Active tab: - Active tab comprises of seven tabs- home, insert, page layout, references,

mailing, review, and view.

° Ribbon: - Each tab of the active tab menu has its specific groups of related commands

termed as the ribbon.

° Rulers: - Rulers help us to control the margins of the page and indentation of the

paragraphs. They are also used for aligning the images and the text.
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° Document header/footers: - Headers and footers are being used to display descriptive

information such as page number, document name, date/or time, etc.
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e  Document area: -Document area is a huge blank section of the word processor window
which allows the user to enter the contents. This area contains infinite number of pages

which is being incremented automatically when the previous page is filled.

e  View buttons: - View button is a feature that allows us to see how the document appears

or presented.
° Zoom slider: - Zoom slider is used to zoom in or zoom out the document pages.

There are many basic operations and functions that we should know before start working in the

MS-word, which are listed below:

[1] To move the insertion point to the beginning or end of the document
Press H+> or H+B.

[2] To convert a document created in an earlier version of Word
Click the Microsoft Office Button, and then click Convert.

[3] To view multiple pages
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° On the View toolbar, click the Zoom button.

° In the Zoom dialog box, click the many pages arrow, select the number of pages, and
then click OK.

[4] To adjust the magnification of a document
° On the View toolbar, click the Zoom button.

° In the Zoom dialog box, enter the percentage or type an amount in the Percent box and
then click OK.

[5] To display the Document Map
On the View tab in the Show/Hide group, select the Document Map check box.
[6] To display thumbnails of pages

° On the View tab, in the Show/Hide group, select the Thumbnails check box to display or

hide non-printing characters.
° On the Home tab, in the Paragraph group, click the Show/Hide 9 button.
[7] To display a document in a different view
° On the View tab, in the Document Views group, click the button for the desired view, or
° Click a view button on the View toolbar at the right end of the status bar.
[8] To switch among open documents

On the View tab in the Window group click the Switch Windows button and then click

the name of the document you want to switch to.
[9] To view multiple open documents

On the View tab in the Window group, click the Arrange All button.
[10] To open a new document

Click the Microsoft Office Button, click New and then in the New Document window

double-click Blank document.
[11] To save a document for the first time

° On the Quick Access Toolbar, click the Save button or click the Microsoft Office Button
and then click Save As.

° If Browse Folders is shown in the lower-left corner of the Save As dialog box, click it

and then navigate to the location where you want to save the file.

e In the File name box, type a name for the document, and then click Save.
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[12] To create a new folder while saving a document

Click the Microsoft Office Button, and then click Save As.
° In the Save As dialog box, navigate to the folder where you want to create the new folder.
° On the dialog box’s toolbar, click the New Folder button
e  Type the name of the new folder, press F, and then click Open.
° In the File name box, type a name for the document, and then click Save.
[13] To preview how a document will look when printed
Click the Microsoft Office Button, point to print, and then click Print Preview.
[14] To print a document with the default settings
Click the Microsoft Office Button, point to print, and then click Quick Print.
[15] To print a document with custom settings
° Click the Microsoft Office Button, and then click Print.
° In the Print dialog box, modify the settings as needed, and then click OK
[16] To select text
° Word: Double-click the word.
° Sentence: Click in the sentence while holding down the H key.

° Paragraph: Triple-click in the paragraph, or double-click in the selection area to the left

of the paragraph.

° Block: Click to the left of the first word, hold down the G key, and then click immediately

to the right of the last word or punctuation mark.
° Line: Click in the selection area to the left of the line.
° Document: To delete the text Triple-click in the selection area.
° Select the text and then press A or Z.
[17] To undo an action
On the Quick Access Toolbar click the Undo button.
[18] To move the text by dragging
o Select the text and then point to the selection.

° Hold down the mouse button, drag the text to its new location and then release the mouse

button.
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[19] To save the text as a building block

° Select the text. Then on the Insert tab, in the Text group, click the Quick Parts button,
and then click Save Selection to Quick Part Gallery.

° In the Create New Building Block dialog box, type a name for the building block, make

necessary changes to the settings, and then click OK.
[20] To insert a building block in a document

Click where you want to insert the building block. Then either type the name of the
building block, and press #; or click the Quick Parts button on the Insert tab in the Text
group and select the building block from the Quick Part gallery.

[21] To insert the date and time

° Click where you want the date or time to appear. Then, click the Date & Time button

on the Insert tab in the Text group.

° In the Date and Time dialog box under Available formats click the format you want,
and then click OK.

[22] To use the Thesaurus

e  Double-click the word you want to replace. Then, click the Thesaurus button on the

Review tab in the Proofing group.

° In the Research task pane, point to the word you want to insert in place of the selected

word, click the arrow that appears, and then click Insert.
[23] To research information
° Click Research on the Review tab present in the Proofing group,
° Type the research topic in the search for box present in the Research task pane.

° Click the arrow of the box below the Search for box, click the resource you want to use,

and then in the results list, click a source to view its information.
[24] To translate a word or phrase into another language

° Select the word or phrase, and then on the Review tab, in the Proofing group, click the

Translate button.

° In the Translation area of the Research task pane, select the desired languages in the form

and to boxes to display the translation.
[25] To display a document in Outline view

On the View toolbar, click the Outline button.
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[26] To display specific heading levels in Outline view

On the Outlining tab, in the Outline Tools group, click the Show Level arrow, and in the

list, click a heading level.
[27] To collapse or expand heading levels in Outline view

Click anywhere in the heading to be collapsed or expanded. Then on the Outlining tab,
in the Outline Tools group, click the Collapse or Expand button.

[28] To demote or promote headings in Outline view

Click the heading to be demoted or promoted. Then on the Outlining tab, in the Outline

Tools group, click the Demote or Promote button.
[29] To move content in Qutline view

Collapse the heading whose text you want to move. Then on the Outlining tab, in the

Outline Tools group, click the Move Up or Move Down button.
[30] To find text
° On the Home tab, in the Editing group, click the Find button.

° On the Find tab of the Find and Replace dialog box, specify the text you want to find,
and then click Find Next.

[31] To replace text
° On the Home tab, in the Editing group, click the Replace button.

° On the Replace tab of the Find and Replace dialog box, specify the text you want to find

and the text you want to replace it with, and then click Find Next.

° Click Replace to replace the first instance of the text, Replace All to replace all instances,

or Find Next to leave that instance unchanged and move to the next one.
[32] To check spelling and grammar
° On the Review tab, in the Proofing group, click the Spelling & Grammar button.

° In the Spelling and Grammar dialog box, click the appropriate buttons to correct the

errors Word finds or to add words to the custom dictionary or AutoCorrect list.

o Click OK when Word reaches the end of the Spelling and Grammar check, and then click

Close.
[33] To remove personal information from a document

° Click the Microsoft Office Button, point to Prepare, and then click Inspect Document.
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° In the Document Inspector dialog box, select the items you want to check and then click

Inspect.

° In the Document Inspector summary, click the Remove All button to the right of any

items you want to remove, and then close the Document Inspector dialog box.
[34] To mark a document as final
° Click the Microsoft Office Button, point to Prepare, and then click Mark as Final.
° Click OK in the message box, click Save, and then click OK in the finalization message.
[35] Changing the Look of

Click the paragraph or select the text to which you want to apply a style. Then on the
Home tab, in the Styles group, click the thumbnail of the style you want to apply in the
Quick Styles gallery.

5.4 WORKING WITH DOCUMENT

Entering and saving text in a document-

Entering and saving of the data in MS-word is very easy. A blinking cursor appears in the text
area which decides the position of the text which is to be entered. We can enter the contents
in the text area with not only various formats of writing but also different sizes, shapes, and
colours. We can also apply certain features like bold, italic, and underline and can arrange the
position of the contents through various aligning icons. We can save the entered content by

shortcut key (CTRL+S) OR can go through various steps given below:

Step 1: Click on the ‘office button’ present at the top left corner of the screen.
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Step2: Now, click on the ‘save’ option from the menu. Or Click on the ‘Save As’ option to

provide a custom name to your document.
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Closing the MS Word-

If you want to close the MS-Word window you just have to click on the ‘X’ icon present on
the right top corner of the window. As you click on the ‘X’ icon, a small dialog box appears
which asks you for saving the document. If you want to save the document just click on the
“Yes’ option that will close the window after saving your document or else click on the ‘No’

option that will close the window without saving your document.
Opening an existing document-

We can open our previously saved documents by just clicking on the office button present at

the top left part of the MS-Word window. As we click on that ‘open’ option from the menu a
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document window appears which contains all the previously saved documents. All we have to

do is select the desired document from the list and click on the ‘Open’.

Copy and Cut (Move)-
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Copy and the cut commands are
used for transferring data from one place to another within the page or between the different
pages of multiple documents. The copy command transfers the replica of the original data while
the cut command transfers the original data to another place. We can perform both the
operations by selecting the ‘Copy’ or ‘Cut’ options from the dialog box appears on right

clicking the mouse after selecting the desired data.

After clicking on any one of the two options, just position the mouse on the area where you

want the data and select the ‘paste’ command by right clicking on the mouse.

WORKING WITH SYMBOLS, GRAPHICS, AND
EQUATIONS

We have several disciplines, areas, and fields where documentation work is highly preferred.
They require number of equations, pie-charts, graphs, and other quantitative properties for their
documents. As a result in order to create quality documents formatting of documents is highly

preferable. The common features used in MS-Word are as follows-
[1] To insert a picture

° Click where you want to insert the picture. Then click the Picture button on the Insert tab

in the Illustrations group,.
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° Navigate to the folder where the picture is stored, and then double-click the picture to

insert it.
[2] To adjust the size of an object

Click the object. Then point to one of the handles surrounding the object and when the

pointer becomes a two-headed arrow drag until the picture is the size you want.
[3] To insert clip art

° Click where you want to insert the clip art. Then on the Insert tab, in the Illustrations
group, click the Clip Art button

° In the Clip Art task pane, in the Search for box, type a word describing what you are
looking for, and then click Go.

° In the task pane, click a clip art image to insert it in the document, and then close the task

pane.
[4] To move an object

Click the object to select it. Then point to the object, and when the pointer changes to a

four-headed arrow. Finally, drag the object to the new position.
[5] To quickly copy an object

Click the object, hold down the H key, and then drag a copy of the object to its new

location, releasing first the mouse button and then the F key.
[6] To insert a WordArt object

° Click where you want to insert the WordArt. Then on the Insert tab, in the Text group,
click the WordArt button.

° In the WordArt gallery, click the style you want.

° In the Edit WordArt Text dialog box, type your text

° Set the size and other attributes of the text, and then click OK.
[7] To apply a drop cap

Click in the paragraph. Then on the Insert tab, in the Text group, click the Drop Cap

button, and click the style you want.
[8] To draw a shape

° On the Insert tab, in the Illustrations group, click the Shapes button, and then click the

shape you want.

° Point where you want the shape to appear, and then drag to draw the shape.
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[9] To group drawing objects
° Hold down the H key, and click each object you want to group.

° On the Format contextual tab, in the Arrange group, click the Group button, and then

click Group.
[10] To change the text wrapping of a picture

Select the picture. Then click the Test Wrapping button on the Format contextual tab in
the Arrange group. Select the wrapping style and attributes as desired.

[11] To change the position of a picture

Select the picture. Then point to the picture, and when the pointer changes to a four-

headed arrow. Finally, drag the picture to its new location. Or

Select the picture. Then on the Format contextual tab click the Picture button present in

the Arrange group, and click More Layout Options

In the Advanced Layout dialog box, on the Picture Position tab, set the position options

you want, and then click OK.
[12] To insert a symbol

° Click where you want to insert the symbol. Then on the Insert tab, in the Symbols group,

click the Symbol button, and click More Symbols.
° In the Symbols dialog box on the Symbols tab select the font you want.

° Scroll through the list of symbols until you find the symbol you want, double-click it,
and then click Close.

[13] To insert an equation

° Click where you want to insert the equation. Then on the Insert tab, in the Symbols group,

click the Equation button.

° Type your equation in the equation box that appears in the document.

5.6 WORKING WITH DIAGRAMS AND CHARTS

[1] To insert a diagram

° Click where you want to insert the diagram. Then on the Insert tab, in the Illustrations
group, click the SmartArt button.

° In the Choose a SmartArt Graphic dialog box, click the diagram layout you want and
then click OK.

[2] To add text to a diagram
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Click the placeholder text in the Type your text here pane or in the diagram shape, and
then type your text.

[3] To resize a diagram

Drag the sizings handle around the diagram frame, and then drag the handle to increase

or decrease the size of the diagram.
[4] To add a shape to a diagram

Click the diagram shape above or below where you want the new shape to appear. Then
on the Design contextual tab, in the Create Graphic group, click the Add Shape arrow,
and in the list, click Add Shape After, Add Shape Before, Add Shape Above, or Add
Shape Below.

[5] To change the diagram layout

Click a blank area in the diagram’s frame. Then click the ‘More’ button on the Design

contextual tab in the Layouts group. In the gallery, click the layout you want.
[6] To move a diagram

Point to the diagram’s frame (not one of the handles), and when the pointer changes to a

four-headed arrow, drag the diagram to its new location.
[7] To change the style of a diagram

Click a blank area inside the diagram’s frame. Then on the Design tab, in the SmartArt
Styles group, click the ‘More’ button. In the gallery, click the style you want.

[8] To insert a chart
®  On the Insert tab, in the Illustrations group, click Chart.

® In the Insert Chart dialog box, click the category of chart you want. Click the style you
want and then click OK.

[9] To enter data in a new chart

In the Excel worksheet, replace the sample data by clicking a cell, and then type your
data.

[10] To fit a column to its longest entry

Point the border between two column headings. Double click when the pointer changes

to a double-headed arrow.
[11] To edit the data in a selected chart

° Click the Edit Data button on the Design tab in the Data group,.
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° In the Excel worksheet, click the cell you want to edit, type the new data, and then press
F.

[12] To change the type of a selected chart

e  On the Design tab, in the Type group, click the Change Chart Type button.

e In the Change Chart Type dialog box, click the chart type you want, and then click OK.
[13] To change the style of a selected chart

On the Design tab, in the Chart Styles group click the more button. In the Chart Styles
gallery, click the style you want.

[14] To turn a chart’s gridlines on and off

On the Layout contextual tab in the Axes group click the Gridlines button. Point to
Primary Horizontal Gridlines or Primary Vertical Gridlines and click the option you

want.
Working with professional documents
E.g. reports, thesis, proposals, etc.
[1] To delete a building block
° In the Text group, click Quick Parts, and then click the Building Blocks Organizer.

° In the Building blocks list, select the building block you want to delete. Then, click
Delete.

[2] To create a table of contents based on headings

° Position the insertion point where you want to insert the table of contents. Then on the

References tab, in the Table of Contents group, click the Table of Contents button.
° In the Table of Contents gallery, click the table of contents style you want.
[3] To update a table of contents

° Click in the table of contents. Then on the References tab, in the Table of Contents group,
click the Update Table button.

° In the Update Table of Contents dialog box, click Update page numbers only or Update
entire table, and then click OK.

[4] To insert an index entry

° Select the word you want to mark. Then, click the Mark Entry button on the References

tab in the Index group.

° Click Mark in the Mark Index Entry dialog box.
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[5] To create an index

Click where you want to insert the index. Then, click the Show/Hide button on the Home

tab in the Paragraph group to turn off the display of non-printing characters.

Click Insert Index on the References tab in the Index group. In the Index dialog box, click
the Formats arrow, click an index format, select any other options you want, and then
click OK.

[6] To insert a bookmark

Select the text or item that you want to bookmark. Then on the Insert tab, in the Links

group, click Bookmark.

Type the bookmark name (with no spaces) or select one from the list of bookmarks on
the Bookmark dialog box in the Bookmark name box and then click Add.

[7] To insert a cross-reference

Click where you want to insert the cross-reference. Then type the introductory text for

the cross-reference. For example, for more information, see.
On the Insert tab, in the Links group, click the Cross-reference button.

In the Cross-reference dialog box, click the Reference type arrow and then click the type

of reference you want.

Click the Insert reference to the arrow and then click the type of item you are referencing,

if necessary.

In the Reference type drop-down list, click the item you are referencing to. Finally, click

Insert, and then click Close.

Finding a Particular Pattern-

A pattern is a simple, repeating overlay of a one-color design over a background of another

color. We can apply the pattern on different objects and various sections and part of the

documents with the help of given steps:

Step 1. Right-click the shape and choose Format Shape. The Format Shape dialog box opens.

Step 2. Click the Fill tab.

Step 3. Click the Pattern Fill option button. The controls change to show pattern options.

Step 4. Click the desired pattern.

Step 5. Open the Foreground Color menu and select the foreground color. As with other color

selectors, you can select a theme color, a tint or shade, or a standard color.
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Step 6. Open the Background Color menu and select the background color.

Step 7. Click Close to close the dialog box.
Inserting objects into a document-

Depending on the version of Word or Outlook you're using you can insert a variety of objects
(such as PDF files, Excel charts or worksheets, or PowerPoint presentations) into a Word

document or an email message by linking or embedding them.

[1] To insert an object

e  Click Object on the Insert tab.

° Insert a new object

[2] To create a new file that is inserted into your Word document or email message

In the Object dialog box, click the Create New tab, and then select an option from the Object
type list.

Object ?

Create from File

Object type:

Adobe Acrobat Document ~

Adobe Acrobat PDFXML Document

Adabe Acrabat Security Settings Document

EBitmap Image

Microsoft Equation 3.0

Microsoft Excel §7-2003 Worksheet

Microsoft Excel Binary Worksheet

Microsoft Excel Chart hd I:| Display as icon

Result

Inserts a new Adobe Acrobat Document

s
Em object into your document,

The default program for that file type opens, where you can enter any text or data you want.

When you close the program, any added content or changes appear in your Word document or

email message.

Select Display icon if you want the new file to appear as a clickable icon rather than the first

page of your new file. If this check box is selected, you can choose a different icon by clicking
Change Icon.

Tips:

° The information in the Result section changes based on the selected object type and
whether the Display icon is selected. Use this information to help you determine what

you want to insert and how you want it to appear.

° To edit the information in your inserted object, double-click the object.
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[3] Link or embed an existing file
To link or embed an object that's already been created:

° In the Object dialog box, select the Create from File tab, and then click Browse to find

the file you want to insert.

Object ?

Create Mew |
File name:
= Browse...
[ Link to file
|:| Display as icon
Result

Inserts the contents of the file into your

L=,
Em document so that you can edit it later using
the application which created the source
file.

° To link to the source file, rather than embedding it into your Word document or email

message, select Link to file.

° Select Display as icon if you want the inserted file to appear as a clickable icon, rather
than the first page of the file. If this check box is selected, you can choose a different

icon by clicking Change Icon.

Tip: The information in the Result section changes based on whether link to the file and
Display as icon are selected. Use this information to help you determine what you want to insert

and how you want it to appear.
Embedded objects vs. linked objects

Embedded objects become part of the Word file or email message and after they are inserted.

However, they are no longer connected to any source file.

Linked objects can be updated if the source file is modified. Linked data is stored in the source
file. The Word files or email message (the destination file) stores only the location of the source
file and it displays a representation of the linked data. Use linked objects if the file size is a

consideration.

5.7 POINTS TO REMEMBER

° Microsoft Word is a word processing program, designed to help you create professional-
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quality documents.

° With the finest document formatting tools Word helps you organize and write your
documents more efficiently.

° Word also includes powerful editing and revising tools so that you can collaborate with
others easily.

° We have learned how to create our own documents, open existing documents, and finally
save them before closing.

5.8 GLOSSARY

° Title Bar: It displays the document name followed by a program name.

° Menu Bar: It contains a list of options to manage and customize documents.

° Standard Toolbar: It contains shortcut buttons for the most popular commands.

e  Formatting Toolbar: It contains buttons used for formatting.

° Ruler: Ruler is used to set margins, indents, and tabs.

° Status Bar: It displays the position of the insertion point and working mode buttons.

° Scroll Bars: These are used to view parts of the document.

5.9 CHECK YOUR PROGRESS

Objective type questions-

a)
b)

©)
d)

g)

h)

..... 1s the file extension for the MS-Word document.

The active tab consists of ..... sub-tabs which opens the ribbon for performing various

operations on the content.
..... shortcut key is used for UNDO and ..... for REDO the operations.

We can save the document by one of the two ways i.e. by clicking on the SAVE AS

option from the ..... button or by using ..... shortcut key for the same.

We can group many objects by clicking them all while pressing holding the ..... key on
the keyboard.

MS-Word didn’t allow us to use various patters in the objects and in the document. (True
/ False)

A text editor is any word processing program that you can use to type and edit text. (True
/ False)

We can change the style of the text by selecting designs from the FONT option of the
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i)
)

HOME tab. (True / False)
B option in the HOME tab is used for applying bold effect in the text. (True / False)

MS-Word does not have an option for serial numbers on the pages. (True / False)

Descriptive type questions

a)
b)
©)
d)
e)
f)

g)
h)

What is a word processor?

How the text is made bold, italic, and underlined?

How can you insert a table in your document?

How can you change the case of the text?

Describe various types of apply text formatting in a word document.
Discuss the steps of applying paragraph formatting.

Learn how to create and edit hyperlinks in word 2007.

How will you insert special characters and equations in word 2007? Explain using an

example.

Answer (Objective type questions)

[a] .docx [b] 7 [c] CTRL+Z, CTRL+Y [d] OFFICE, CTRL+S [e] H [f] False [g] True [h] True
[1] True [j] False
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https://guides.co/g/microsoft-word-how-to-start-a-document/11891
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° Gookin Dan “Word 2019 For Dummies”
° Lambert Joan, “Microsoft Word 2019 Step by Step”
° Holloway Kari, “Writer’s Guide to Microsoft Word”

e  [llustrated Computer Concepts and Microsoft office 365 & office 2016
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UNIT- 6
INTRODUCTION TO TEXT EDITOR (MS WORD)- II

6.1 INTRODUCTION

6.2 OBJECTIVES

6.3 INTRODUCTION TO MICROSOFT WORD 2010

6.4 BULLET AND NUMBERING

6.5 UNDO AND REDO

6.6 WORKING WITH FONTS

6.7 PAGE BREAK

6.8 HEADER AND FOOTER

6.9 PAGE SETUP

6.10  HANDLING TABLES IN MS WORD

6.11 POINTS TO REMEMBER

6.12 GLOSSARY

6.13 CHECK YOUR PROGRESS

6.14 BIBLIOGRAPHY/REFERENCES

6.15 SUGGESTED READINGS

6.1 INTRODUCTION

Word processing means creating or manipulating text documents using some word processing

computer applications in presentable and effective manner. Manual documentation has so
many constraints like once a document is created it cannot be modified. We cannot apply
different text formats to make an attractive document. Such documents cannot be saved for
later use and multiple original copies cannot be created. But all these problems and lot more
can be easily handled in computer using a word processor. Using these, we not just only create
the attractive and presentable documents, but also modify them with the required change and

can print the hardcopy when needed. They provide various other tools like spell checker, mail

Unit 6: Introduction to Text Editor (MS Word)- lIPage 77 of 249



CVDMM- 302: ICT Resources and Applications uou

merge, tables, etc., to handle many other typical documentation problems. Commonly used

word processors are Microsoft Word, Google Docs, WordPad, Apache OpenOffice writer, etc.

6.2 OBJECTIVES
After going through this unit, you will be able to:

° Explore the new features of Word 2010

° Use Bullet and Numbering in MS Word 2010

) Describe how to create Table

° Describe ways of adding and editing text in MS Word 2010

6.3 INTRODUCTION TO MICROSOFT WORD 2010
Microsoft Word 2010 is one of the word processing components of Microsoft Office 2010

Suite used for creating, editing, formatting or printing the text document. Using this you can
create high quality text documents like letters, reports, books, etc. The powerful features of

Microsoft Word 2010 make it one of the most widely used word processing software.
Starting Microsoft Word 2010
To start Microsoft Word 2010

Step 1: Click on Start button

Step 2: Choose All Programs

Step 3: Click on Microsoft Office option

Step 4: Click Microsoft Word 2010 option in the expanded list.

6.4 BULLET AND NUMBERING

Information in a Word document is stored in the form of pages. So before you start typing

anything in your document, it is necessary to set the page format like its size, margins,
orientation, etc. so that we can get the document output in the desired manner. Although these
settings can be modified anytime even after typing your document, but that will lead to the

change in adjustment of document contents.
Creating Lists-

Bullets on numbers make a list look attractive and legible. A Bulleted list has a dot, circle or
any other symbol to identify the items in the list. A numbered list has a number or a letter to
identify the items in the list. Word 2010 offers another powerful feature which is used to
automatically create the ordered or unordered list of items in the document. An ordered or
number list is the one in which the items get automatically numbered when they are entered
and in unordered list, items get marked with a specific symbol every time when a new item is
added.

Creating A Bulleted List
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Step 1: Type the items of the list and select them.

Step 2: On the Home tab, click on the drop-down arrow of bullets option in the paragraph
group.

Step 3: Click a bullet style from the list that appears.

Creating A Numbered List

Step 1: Type the items of the list and select them.

Step 2: On the Home tab, click on the drop-down arrow of numbering option in the paragraph
group.

Step 3: Click a number style from the list that appears.

6.5 UNDO AND REDO

Correcting a typo in Microsoft Word is one of the easiest and most useful functions to access.

data - Word
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India is famous for its beautiful mountains, statues and temples. There are many
famous landmarks in our country.
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There are two ways to do so- Via Keyboard shortcut, and Via menu control
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Via Keyboard shortcut

Undo Keyboard Shortcut- The Undo command undoes anything you do in Word, which
includes formatting text, moving blocks, typing and deleting text. Undo a mistake you have
made, simply press Ctrl + Z on your keyboard. The last thing you edited will be undone.

Unit 6: Introduction to Text Editor (MS Word)- lIPage 79 of 249



CVDMM- 302: ICT Resources and Applications uou

Redo Keyboard Shortcut- Use the Redo command to set things back to the way they were. If
you have undone three edits and you press Ctrl +Y, word will redo the earliest undone action.

Via Menu Control

The other option to use the undo and redo functions in word is via the top menu bar. You will

see two arrows- a back one and a forward one.

6.6 WORKING WITH FONTS

Formatting means making the document attractive and presentable. It helps to enhance the
appearance of your document to make it more effective and easily readable. The tools available

in Font group are:

° Font is used to change the style and shape of the characters.
° Font Size is used to change the size of the characters.

° Font Color is used to change the text color.

° Bold is used make text darker.

° Italic is used to make text slanted towards right.

e  Underline is used to put a line under text.

° Text Highlight Color is used to highlight text in our document.
° Change Case is used to change the case of the selected text without typing again.

° Various text properties that can be set using Font group.

Changing Font- Font is the style and shape of the letters of the text. Some of the fonts in Word
2010 are: Calibri, Arial, Times New Roman, Comic Sans MS, Monotype Corsiva, Bradley
Hand ITC, etc.

To change font-

Step 1: Select the text to change the font.
Step 2: On the Home tab, click on the drop-down arrow of the Font option in the Font group.
Step 3: Click a font style from the list to apply it.

Changing Font Size- Font size is the size of the characters of text.

Step 1: Select the text to change the font size.

Step 2: On the Home tab, click on the drop-down arrow of the Font Size option in the Font
group.

Step 3: Click a font size from the list to apply it.

Changing Font Color-

Step 1: Select the text to change the color.
Step 2: On the Home tab, click on the drop-down arrow of the Font Color option in the Font

group.
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Step 3: Click a color from the list to apply it.
Typing Superscript and Subscript-

The text that appears above the normal text level is called superscript text. The text that appears

below the normal text level is called subscript text.

For example, in O? and O», 2 is the superscript and subscript, respectively.

Step 1: Select the text to change it to superscript or subscript.

Step 2: From the Home tab, click on superscript or subscript in the Clipboard group.
Making text Bold, Italic, Underline-

Bold means darker text. Italic means text slanted towards the right. Underline means a line
under the text.

Making text Bold

Step 1: Select the text you want to make bold.

Step 2: On the Home tab, click on Bold option in the Font group.

Making text Italic

Step 1: Select the text you want to make italic.

Step 2: On the Home tab, click on Italic option in the Font group.

Underlining text

Step 1: Select the text you want to make underline.

Step 2: On the Home tab, click on Underline option in the Font group.

Highlighting Text: We can highlight the text in our document just like we highlight with a
marker pen.

Step 1: Select the text to highlight.

Step 2: On the Home tab, click on the drop-down arrow of the Text Highlight Color option in
the Font group. A color palette appears.

Step 3: Click the color you want to apply.

Changing Case-

The Change Case command is used to change the case of the selected text without typing again.

There are five change case options in Word.

v Sentence Case: This changes all the selected letters of the sentence to lowercase except

the first letter. The first letter remains capital.
Lowercase: This changes all the selected letters to small case.
Capitalize Each Word: This changes the first letter of each word to capital.

Uppercase: This changes all the selected letters to capital.

NN

tOGGLE cASE: This reverse the case of every letter. The letters in small are converted
to capital and the letters in capital are converted to small.
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To change the case of text:

Step 1: Select the text.
Step 2: On the Home tab, click on the Change Case option in the Font group.
Step 3: Click an option from the list of options.

6.7 PAGE BREAK

Word automatically inserts a page break when you reach the end of a page. If you want the

page to break in a different place, you can insert a manual page break. Or you can setup rules
for Word to follow so that the automatic page breaks are placed where you want them. This is
especially helpful if you are working in a long document. As adding breaks to your document

can make it appear more organized and can improve the flow of text.

Breaks in Word

To insert a blank line between two existing lines, we place the cursor at the end of the line after
which we want to insert a blank line and press the Enter key.

Page Break

Page break allows us to move text to the next page before reaching the end of a page. Word
2010 automatically inserts a page break when you reach the end of the document. However,
we can choose to add manual page break as per our requirements. Words offers three page

break options- Page Break, Text Wrapping and Column Break.

Page

To insert a page break:

Step 1: Click where you want to start a new page.

Step 2: Click on Breaks and choose Page Option in the Page setup group in Page Layout tab.
The page break will be applied to the document, and the text will move to the next page.

Column

Column break is used when you wish to divide your document into multiple columns. It splits
the text into columns. By using column breaks, you can move to the next column. This
command works only when we have formatted the text in columns using the Column option in

the Page Layout tab. A column break can be applied to balance the appearance of the columns.

Step 1: Click the location where you want to start a column break.

Step 2: Click on Page layout tab.

Step 3: Click on Breaks and choose Column option. The content gets shifted to the next
column.

Text Wrapping

When text has been wrapped around an image or object, you can use a text wrapping break to
end the wrapping and begin typing on the line below the image.

Step 1: Click the location where you want to start a column break.
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Step 2: Click on Page layout tab.
Step 3: Click on Breaks and choose Text wrapping option. The content gets shifted to the

next column.

6.8 HEADER AND FOOTER

A Header or footer is text or graphics that is usually printed at the top or bottom of every page

in a document. A header is printed in the top margin and footer is printed in the bottom margin.
The area where the header and footer content are placed is called the Header and Footer

workspace.

The workspace uses a layer of the document that is separate from the main body and behaves
differently than the documents main content. After the header or footer is inserted the areas
become active and can be edited. They are tagged with Header or Footer and are marked with

a dashed line. Any content in the header or footer area will appear and print on every page.
Inserting Header or Footer

Header and footer display information, such as page number, author’s names and date.
To insert header/footer:
Step 1: Click on Insert tab
Step 2: From the header and footer group, click on header or footer. A Gallery appears.
Step 3: Choose a header style or footer style. Now, type the text you want at the top or bottom
of each page respectively
Step 4: Click on the close header and footer from the closed group in the design tab
Or
Double click in the document area
Editing Header or Footer
To edit header/ footer
Step 1: Click on insert tab
Step 2: Click header from the header and footer group. A Drop menu appears.
Step 3: Select edit header option. The header area will get activated.
Step 4: Now, modify and edit the header using the design tab. Following are some useful
special items you can insert into a header.
v Page Number: Click page number from the header and footer group and select the
location for the page number.
v Date & Time: Click date and time from the Insert group. The date and time dialogue
box appears. Select date format of your choice and click ok button.
v Graphic: Click Picture /Clip Art from the insert group to insert graphics in the
header.

6.9 PAGE SETUP
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The page setup is the parameters defined by the user that help determine how a printed page
appears. Those parameters can include everything from the size, margins, page orientation, and

quality of print. More plainly, it's a menu that allows users to customize the size and layout of
a page.
Click the Page Layout tab.

2. Click the small arrow in the bottom-right corner of the Page Setup group.
The Page Setup dialog box will appear.

Insert FPage Layout References Mailings Review View
Pu Ij %= Breaks ~ j &j IJj Indent Sy
= ¥3 Line Numbers - . £5 Left 07 il |
Orientation  Size Columns ) Watermark Page Page . ra ™
- - - bec Hyphenation - - Color - Borders | =% Right: |07 L+
Page Setup fa Page Background Paragrap
o oo pJooc ﬁ ' I L 'i\gge Setup ::

Show the Page Setup dialog box,

6.10 HANDLING TABLES IN MS WORD

Creating Table-

Tables are used to organise the information in the form of rows and columns. Rows and
columns intersect each other to form rectangular blocks called cells.

Creating Tables

Word 2010 offers different methods to create tables in your document. Let us learn three of
them.

Method 1

Step 1: Click on Insert tab

Step 2: Click on table from the tables group. A grid of cells will appear.

Step 3: Move the pointer across the grid to select rows and columns. Click in the last cell of
the selected grid of cells to get the table.

Method 2

Step 1: Click on insert tab

Step 2: Click on table from the tables group

Step 3: Select insert table option. The Insert table dialogue box will appear on the screen.

Step 4: Enter the number of rows and columns required in the table.

Step 5: Click on Ok button to get your table at the insertion point.

Method 3
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Another way to create table is by drawing it manually as need it used in draw table tool:

Step 1: Use Draw Table option in the Table expanded list as the mouse pointer will turn to a
pen shape.

Step 2: Drag the pointer diagonally on the document to draw the outer border of the table.
Step3: Now using the same tool draw horizontal and vertical lines in the box to divide it in the

required number of rows and columns.

Deleting Table-

There is a very quick way to delete a table in Word 2010, that doesn’t even involve selecting
the table first. Place the cursor in a cell in the table and notice that the Table Tools contextual
tab appears in ribbon.

Click Layout > Rows & Columns > Delete > Delete Table.

Doing this removes the table from your document.

Moving Across The Table Cells-

You can use Mouse or keyboard keys to move across the table cells for data entry.

v Press Tab key or use Right Arrow key to move forward in the next cell.

v To move in the backward direction along the row press Shift + Tab or Left Arrow key.
v Use Up or Down arrow key to move upward or downward in a Column.

v You can also click directly in a cell to enter or edit cell value

Selecting Table Cell, Row and Column-

Selecting cells

You can select multiple cells, rows and columns in a table to edit or format them together.
Selecting a single cell

Triple click inside the cell to select the cell.

Selecting all the cells in a row

Keep the mouse pointer in front of the row towards the left edge and click the left mouse button.
The entire row will be selected.

Selecting all the cells in a column

Keep the mouse pointer at the top of the column. The pointer turns to a downward arrow. Click

the left mouse button to select the entire column.

Entering And Deleting Data-

Entering data:
After creating your table, to enter data values in the table cells:
° Click in the cell where you want to enter the data. A blinking cursor will appear in it.
) Type the cell information.
° Use arrow keys to move into the next cell.
Or
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° Click in the cell where information is to be inserted.
° Continue like this till all the data values are entered in the table.
Deleting Data:
° Select the data you want to delete
° Press the delete key from the keyboard.
° Cell data will be removed from the table.
Or
° Move the cursor at end of data that you want to delete the data

° Press the Backspace key from the keyboard.
®  (Cell data will be removed from the table.

Inserting And Deleting Columns and Rows-

Inserting Rows or Columns

Sometimes, you need to add more columns and rows in a table.

Inserting a new column

Step 1: Select cell where you want to insert a new column and click on Layout tab.
Step 2: Click on Insert Left or Insert Right in the Rows and Column group.
Inserting a new Row

Step 1: Select cell where you want to insert a new row and click on Layout Tab.
Step 2: Click on insert above or insert below as needed in the rows and columns group to get a
new blank row in the table.

Deleting Rows or Columns

You can also remove the rows or columns that are no more needed in a table.

Step 1: Select the cell whose row or column is to be deleted.

Step 2: Click on the Layout Tab.

Step 3: Click on delete option in the rows and columns group.

Step 4: Select an option- Delete Rows or Delete columns. The entire row or column get deleted.
Merging And Splitting Cells-

Merging table cells

If you want to show some data value in a table which is spread across two or more cells, you
can merge them to form a single cell. The cells can be merged horizontally across the row or
vertical across the column.

Step 1: Select the adjacent cells which are to be merged.

Step 2: Choose the Layout Tab and click on Merge Cells option on the Merge group.

The selected cells will merge to form a single large cell

Splitting table cells

Just as you can merge two or more cells to form a single large cell, you can also split a cell into

two or more cells to store multiple values in them.
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Step 1: Select the cell that has to be split
Step 2: Choose the Layout Tab and click on Split Cells option in it. The Split cells dialog box

will appear

Step 3: Enter the number of rows and columns in which the cells is to be splitted.
Step 4: Click on Ok button

6.11 POINTS TO REMEMBER

° Microsoft Word 2010 is a word processing program, designed to help you create
professional quality documents.

° With the finest document formatting tools, word helps you organise and write your
document more efficiently. Word also includes powerful editing and revising tools so
that you can collaborate with others easily.

e  We have learnt how to create our own documents, open existing documents and finally
save them before closing. The standard toolbar and the formatting toolbar offer a variety
of buttons which offer a quick service to the user.

e  Text can also be justified between the margins. Proper line spacing can be given in
between the printed lines. Text entries separated by commas can be put in the bulleted or
numbered form. This makes the major heads clearly readable and long remembered.

° Word document generally contain paragraphs with different formatting. Even a very
simple document with a centered heading and a justified body contains paragraph with
two different types of formatting.

6.12 GLOSSARY

° Word processing means creating or manipulating text documents using some word
processing computer applications in presentable and effective manner.

° A Bulleted list has a dot, circle or any other symbol to identify the items in the list.

° A numbered list has a number or a letter to identify the items in the list.

° The Undo command undoes anything you do in Word, which includes formatting text,
moving blocks, typing and deleting text.

e  Use the Redo command to set things back to the way they were.

° Formatting means making the document attractive and presentable. It helps to enhance
the appearance of your document to make it more effective and easily readable.

° Page break allows us to move text to the next page before reaching the end of a page.

e A Header or footer is text or graphics that is usually printed at the top or bottom of every

page in a document.
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° The page setup are the parameters defined by the user that help determine how a printed

page appears.

° Tables are used to organise the information in the form of rows and columns. Rows and

columns intersect each other to form rectangular blocks called cells.

6.13 CHECK YOUR PROGRESS

Descriptive type questions-

a)  What is Word Processor?

b)  Write a short note on Header and Footer in Word.

¢)  Write a short note on Page Break?

d) What is font? How can you change the font size?

e)  Write the steps involved in creating a Bulleted list.

f)  How will you create a Numbered List?

g) Define a Table? What are the steps to create and delete a table?
h)  Write to steps to insert a table in MS Word.

i)  Write to steps to merging and splitting cells.

j)  Difference between superscript and subscript.
Objective type questions-

a)  Font is used to change the style and shape of the characters. (True/False)
b) [Italic is used to make text slanted towards right. (True/False)
¢) Change Case is used to change the case of the selected text typing again and again.

(True/False)

d) Rows and columns intersect each other to form rectangular blocks called table.
(True/False)

e) A header is printed in the top margin and footer is printed in the bottom margin.
(True/False)

f)  Column break is used when you wish to divide your document into single columns.
(True/False)

g) . on numbers make a list look attractive and legible.

h) ... display information, such as page number, author’s names and date.

i)  Youcanusea................. break to end the wrapping and begin typing on the line below
the image.

) TP allows us to move text to the next page before reaching the end of a page.

Answer (Objective Type Question)-
[a] True [b] True [c] False [d] False

[e] True [f] False [g] Bullets [h] Header and footer
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[1] text wrapping [j] Page break

6.14 BIBLIOGRAPHY/ REFERENCES
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6.15 SUGGESTED READINGS
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7.3  STARTING MS EXCEL
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7.1  INTRODUCTION
MS-EXCEL 1is a very powerful and easy-to-use spreadsheet package. It is a member-

application of the MS Office suite. It works very well with numbers and their complex
calculations. There are numbers of spreadsheet programs but from all of them Excel is most
widely used application. The best part about Excel is it can apply to many business tasks,
including finance, data management, forecasting statistics, analysis, inventory, billing, and

business intelligence.

7.2  OBJECTIVES

After the successful completion of this unit, you will be able to-

° Understand MS Excel interface.
e  Working with MS- Excel.

7.3  STARTING MS EXCEL

Microsoft Excel is a spreadsheet program that is used to record and analyse numerical data.

Spreadsheets were originally developed for bookkeeping. However, they are also useful for

Unit 7: Introduction to Spreadsheet (MS Excel)- IPage 90 of 249



CVDMM- 302: ICT Resources and Applications uou

data manipulation and producing for graphs. Spreadsheet as a collection of columns and rows
form a table. Alphabetical letters are usually assigned to columns and numbers are usually
assigned to rows. The point where a column and a row meet is called a cell. The address of a

cell is given by the letter representing the column and the number representing a row.

The MS Excel interface-

8. File Menu 9. Quick Access Toolbar 7. Title Bar
0. Ribbon Tab
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Starting MS Excel- To start the MS Excel, follow the steps-
Step 1- Open the Windows Start menu
Step 2- Choose All Programs then Microsoft Office followed by Microsoft Office Excel 2013

Step 3-You can create a shortcut to this software by dragging Microsoft Excel from this menu
onto the Desktop using the right mouse button — select Create shortcut here, from the popup

menu.
The MS Excel interface basic tools and commands-
[1] Active Cell-

A cell in the Excel spreadsheet that is currently selected by clicking on it, and highlighted by

a rectangular box.
[2] Column-

A column is a vertical set of cells in a spreadsheet. Every column has its own alphabet for

identity. You can select a column clicking on its header.

[3] Row-
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A row is a horizontal set of cells. Every row has its own number for identity. You can select a

row clicking on the row number marked on the left side of the window.
[4] Fill Handle-

It is a small dot present on the lower right corner of the active cell. It is used to fill numeric

values, text series, insert ranges, insert serial numbers, etc.
[5] Address Bar-

The address bar is the small input bar at the left side of the window. It shows the address of the
active cell. We can select more than one cell and then it will show the address of the first cell

in the range.

[6] Formula Bar-

The Formula bar is an input bar, below the ribbon. It is used to enter a formula in a cell.
[7] Title Bar-

It lies in the middle and at the top or the window. The title bar shows the program and sheet
titles.

[8] File Menu-

The file menu is a simple menu just like other applications. It contains options like (Save, Save
As, Open, New, Print, Excel Options, Share, etc).
[9] Quick Access Toolbar-

You will find it just above the file menu and its purpose is to provide a convenient resting
place for the Excel’s most frequently used commands. You can customize this toolbar based

on your comfort.
[10] Ribbon Tab-

Starting from the Microsoft Excel 2007 all the options menus are replaced with the ribbons.
The ribbon contains commands organized into three components: Tabs, Groups, and

Commands.
[11] Worksheet Tab-

This tab shows all the worksheets present in the workbook. By default you will see three

worksheets in your new workbook with the name of Sheetl, Sheet2, and Sheet3 respectively.
[12] Status Bar-

This displays sheet information as well as the insertion point location from left to right this bar

can contain the total number of pages and words in the document, language, etc.

7.4 MS EXCEL BASIC FUNCTIONALITIES
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Exiting MS EXCEL-

uou

When you are ready to quit Excel, you have different choices for exit the program:

° Select File -> Exit.
o Aa .
E e
[ | HOME INSERT PAGE LAYOUT FORMULA!
-9
v O ggC“t Calibri MLV
=g Copy ~
Paste B - -
- ~ Farmat Painter B I U - O 'a
E Clipboard P Font P
il
New
Vi
tl
S A B C
i ]
2
S 3
4
5
S &
7
Blank workbook
‘ Account

rner of the Excel 2013 Program window.

cel, a workbook is a collection of one or more
e. A workbook is another word for Excel file.
he blank workbook while starting the Excel.

eed to create a new workbook, by following

TIIC TIITTTACTIOIT O TOWS dIIU COIUIIIIIS IS TU4dIITUO T

the column header and row number.

11. A cell is identified with a combination of

Setting Font-
You can assign any of the fonts already installed for your printer to cells in a worksheet. You
HOME IMNSERT PAGE LAYOUT FORMULS
E”t Calibri Iy
opy T
Format Painter I U~ k- O - '& -
pboard I Font IF}

can set the font of the selected text from Home>>Font group>> select the font.

Setting font from format cell dialogue-

Step 1 Right click on cell >> Format cells >> Font Tab

Step 2 Press Ctrl + 1 or Shift + Ctrl + F
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Text Formatting-

wlls

Paste

-

HOME IMSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW LOAD TE

b d R
db Cut Calibri |11 A A T == - %‘Wrap Text
F Copy -
. . . B A EE=E &= v
¥ Format Painter ru = O - A === & 3= [ Merge & Center
Clipboard P Font P Alignment P

Various options available in “Home Tab” are as follows:

o Bold: It makes text highlighted by choosing Home>> Font Group>> Click B or Press
Ctrl +B

° Italic: It makes text italic by choosing Home>> Font group>> Click I or Press Ctrl + I

e  Underline: It makes text underlined by choosing Home>> Font group>> Click U or
Press Ctrl + U

° Double Underline: It makes text double underlined by choosing Home>> Font group>>
Click the arrow near U >> Select double underline

° Strike-through: It strikes the text in the centre vertically.

° Super Script: It makes content appear above the type line.

° Sub Script: It makes content appear below the type line.

Change Alignment-

You can change the horizontal and vertical alignment of the cell. By default, Excel aligns

numbers to the right and text to the left. Click on the available option in the Alignment group

in Home Tab to change alignment. Right click on the cell and select the format cell. In format

cells dialogue select Alignment Tab. Select the available options from the vertical alignment

and horizontal alignment options.

Horizontal Alignment: You can set horizontal alignment to Left, Center, Right, etc.

Left: Aligns the cell contents to the left side of the cell.

Center: Centers the cell contents in the cell.

Right

: Aligns the cell contents to the right side of the cell.

Justify: Justify the text to the left and right of the cell.

Vertical Alignment: You can set vertical alignment to Top, Middle, Bottom, etc.

Top: Aligns the cell contents to the top of the cell.

Center: Centers the cell contents vertically in the cell.

Bottom: Aligns the cell contents to the bottom of the cell.
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Merging of Cells-

MS Excel enables you to merge two or more cells. When you merge cells you don’t combine
the contents of cells. You combine a group of cells into a single cell that occupies the same
space. Select Merge and Center control on the Ribbon is simpler. To merge cells, select the
cells that you want to merge and then click the Merge and Center button. Select the alignment
tab of the format cells dialogue box to merge cells. The Home>> Alignment Group>> Merge

and Center control contains a drop-down list with these additional options:

Merge Across: When a multi-row range is selected this command creates multiple merged
cells- one for each row.

Merge Cells: Merges the selected cells without applying the center attribute
Unmerge Cells: Unmerges the selected cells.

Wrap Text and Shrink to Fit-

If you have text too wide to fit the column width but don’t want that text to spill over into
adjacent cells you can use either the wrap Text option or the Shrink to fit the option to
accommodate that text.

7.5 INSERTING, DELETING ROWS, AND COLUMNS

Inserting Rows and Columns

To insert a row or column into a Microsoft Excel worksheet:

Step 1 Select a cell in your worksheet where you would like the new row or column to be

inserted. To select multiple | 7. Ty [ 2 AutoSum - T Ty 2
H H

B FH = &) Fill - g

. Insert  Delete Format
multiple cells. [1] New rows are - - - & Clear~

rows or columns simply select
Insert Delete Format

- - -

inserted above the selected cell. | &= Insert Cells... Edif Cells

[2] New columns are inserted | &= Insert Sheet Rows

above the selected cell. U |nsert Sheet Columns

Step 2 On the Home tab in the | S Insert Sheet Cells group, click the

Insert command.

Step 3 Select Insert Sheet Rows or Insert Sheet Columns:
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Deleting Rows and Columns

To delete a row or column into a Microsoft Excel

worksheet:

Step 1 Select a cell in your worksheet in the new row or
column you wish to delete. To delete multiple rows or

columns, simply select multiple cells.

Step 2 On the Home tab in the Cells group click the
Delete command.

Step 3 Select Delete Sheet Rows or Delete Sheet Columns.

Insert

ng = 2 AutoSum -
==

[ |
&) Fill -
Delete Format
= - ¢ Clear~

A

~

p

Delete Cells...
Delete Sheet Rows
Delete Sheet Columns

Delete Sheet

e———

1it

7.6  SAVING AND CLOSING WORKBOOK

Saving a Workbook-

It’s important to save your workbook whenever you start a new project or make changes to an

existing one. Execute the following steps:

Step 1 Locate and select the save command on the Quick Access toolbar.

BEd S

-

Step 2 If you are saving a file for the first time, the Save As pane will appear in the backstage

view.

Step 3 You then need to select where to save the file and give it a file name. To save the

workbook to your computer, select the computer, then click OneDrive to save the file to your

OneDrive.
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Step 4 The Save As dialog box will appear. Select the location where you want to save the

Save As >
— « “ Bl » ThisPC » Desktop » N J) Search Desktop y=]
Organize « Mew folder SEEE 0
8 This PC (o) Marne Date modified Type
[ Desktop Exam Hold 8/23/2019 12:58 PM  File folder
Iifl Documents HRPD 1171172019 8:05 AM  File folder
Mew folder 12/31/2019 219 PM  File folder
* Downloads
. uou 10/8/2019 12:44 PM  File folder
J) Music
&= Pictures
B videos
i Local Disk (C2)
= Study Data (B} , o »
File name: | u0u| -
Save as type: | Excel Workbook ~
Authors:  JyotiRitesh Tags: Add atag
[ save Thumbnail
| Hide Folders Tools = Cancel

workbook.

Step 5 Enter a file name for the workbook, then click Save.

Step 6 The workbook will be saved. You can click save command again to save your changes

as you modify the workbook.

You can also access the save command by pressing Ctrl + S on your keyboard.

Closing a Workbook-

To close a workbook, follow the steps

given below-

Step 1 Click on the File tab in the main

menu.

Step 2 Click on close.

If the file gets saved then, it will get closed.

Otherwise you will get a message “want to

save changes in xxxx.xls”.

Account

Options

If you want to save changes just click on save.

Protect Workbook
» Control what types of changes people can make to this workbook,
Protect
Workbook +

Book1 - Excel (Pro

Check for
Issues ~

j Inspect Workbook

—‘j Versions
Q 7] There are no previous versions of this file.
Manage
Versions ~
Browser View Options
L Diclecack. T L L

Before publishing this file, be aware that it contains:
Printer path, author's name and absolute path
Content that people with disabilities find difficult to read

7.7

POINTS TO REMEMBER

° MS Excel is a very powerful and easy to use spreadsheet packages, perhaps the most

commonly used these days. It is a member application included in the MS Office suite.

It works very well with numbers and their complex calculations.

Unit 7: Introduction to Spreadsheet (MS Excel)- IPage 97 of 249



CVDMM- 302: ICT Resources and Applications uou

° Spreadsheets were originally developed for bookkeeping. However, they are also useful
for data manipulation and producing for graphs. Spreadsheet as a collection of columns
and rows form a table. Excel can sort and select data for a large amount of data or more
complex tasks.

7.8 GLOSSARY

° Cell: A cell is a box at the intersection of a row and column in a worksheet where data is
stored.

e  Column: Columns are a combination of all the vertical cells joined together in a single
vertical line.

° Row: Rows are a combination of all the horizontal cells joined together in a single
horizontal line.

° Workbook: It is a group of worksheets, which can be stored as a unit. A workbook is
stored on the disk in the form of a file with extension .xls.

° Worksheet: It is the working area of MS-EXCEL. Each worksheet of a single workbook
has its own identity and is separate from other worksheets.

° Workspace: It is the working area of MS-Excel where workbooks, worksheets, and other
related objects may be opened and manipulated.

7.9 CHECK YOUR PROGRESS

Objective type questions-

a) ... Includes some statistical functions, but for serious research work, a specialized
package should be used.

b) MS-EXCEL is a very powerful and easy-to-use..... package.

() IR are a combination of all vertical cells joined together in a single vertical line.

d) Rows are a combination of all the horizontal cells joined together in a single.....

e)  Each..... of a single workbook has its own identity and is separate from other worksheets.

f) A cell with a dark border around it is called.....

g) A calculation can be performed through.....

h)  A....isabox at the intersection of a row and a column in a worksheet where data is stored.

1)  The mail merge option is in..... menu.

7)) Inexcel replace option is in..... menu.

Descriptive type questions-
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h)

What do you mean by the range of cells?

What do you mean by cell referencing and what are different types of referencing?
Explain various types of charts available in MS Excel.

What is the difference between copying and moving a range?

What are the different components of the charts? Explain.

Explain the major functions used in MS Excel.

What do you use MS Excel for? Define.

Which types of files can be imported and exported from MS Excel?

Answers (Objective type questions)

[a] Microsoft Excel [b] Spreadsheet [c] Columns [d] Horizontal line [e] Worksheet [f] Active
[g] Excel [h] Cell [i] Tools [j] Edit
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UNIT- 8

INTRODUCTION TO SPREADSHEET (MS EXCEL)- I

8.1 INTRODUCTION

8.2 OBJECTIVES

8.3 INTRODUCTION TO MICROSOFT EXCEL 2010
8.4 COMPONENTS OF SPREADSHEET PROGRAM
8.5 WORKING WITH FUNCTIONS AND FORMULAS
8.6 MODIFYING WORKSHEETS WITH COLOR

8.7 ANALYZING DATA

8.8 SORTING AND FILTERING DATA

8.9 POINTS TO REMEMBER

8.10 GLOSSARY

8.11 CHECK YOUR PROGRESS

8.12 BIBLIOGRAPHY/ REFERENCES

8.13 SUGGESTED READINGS

8.1 INTRODUCTION

Data analysis, calculations, decision making are some of the important jobs in today's
competitive world of business. Organised representations of data, Complex calculations,
statistical analysis, comparisons, graphical representation of data are the jobs which are
frequently performed in the large organisations and Institutions to manage their operations. But
carrying out all such jobs manually is not only tedious and time consuming but also error-

prone.

Electronics spreadsheet are the computerized solutions of all such problems. In these
spreadsheets, data can be stored easily in the tabular form and all type of calculations, analysis,
etc. can easily be performed very quickly and accurately. Various electronic spreadsheet
programs are available to choose from like Apache Google Sheets, OpenOffice calc, Quattro

Pro, Lotus 123, Microsoft Excel, etc.
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8.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

e  Define the importance of spreadsheet
e  Explore Formula and functions

° Explore the Analysing data
8.3 INTRODUCTION TO MICROSOFT EXCEL 2010

Excel 2010 is an electronic spreadsheet program. It is the spreadsheet component of Microsoft

Office 2010 suite, which is one of the most widely used application software for data analysis.
Microsoft Excel allows to store data in the form of rows and columns. Both number or text
type of data values can be used in the worksheet on which you can perform different type of

operations using built in functions or with the help of user defined formulas.

Starting Excel 2010
To start Excel 2010, follow the steps given below

Step 1: Click on the Start button.

Step 2: Click on All Programs.

Step 3: Click on Microsoft Office
Step 4: Click on Microsoft Excel 2010

8.4 COMPONENTS OF SPREADSHEET PROGRAM

Workbook: An Excel document is known as workbook which is basic excel file saved with

xlsx extension. It is a collection of multiple worksheets. There are 3 worksheets by default in
a workbook, but you can always add or Delete worksheets as per your need.

Worksheet: Worksheet is like an individual page of the workbook having grid of cells formed
by the intersection of rows and columns. The 3 worksheets are named as sheet 1, sheet 2, sheet
3 by default which can be changed if needed.

Rows: Rows forms the horizontal sections of the worksheet which are arranged vertically from
top to bottom. There are 1,048,576 rows in a single excel worksheet. Excel worksheet and are
identified by the numbers 1 to 1,048,576.

Columns: Columns forms the vertical section of the worksheet which runs horizontally from
left to right. There are 16,384 columns in a worksheet represented with the labels A, B, C.........
upto XFD.

Cell: A small rectangular box formed by the intersection of a row and a column is called cell.

Formula Bar: It displays the contents of the current cell. It also used to create and view
formulas.
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8.5 WORKING WITH FUNCTIONS AND FORMULAS

Basic Calculations in Excel

Excel has a powerful feature to perform calculations on the data. We can perform addition,
subtraction, multiplication and decision of numbers either using formulas or using functions.
Formulas

A formula in Excel is an expression made up of data value or the cell references of the cells
containing data values along with the mathematical operations. These operators are used along
with the operands that can be the constant or cell references of the values to be used for
calculations. Every formula in Excel begins with “=" sign. Various arithmetical operators that
are used in the formula are:

=Al+ Bl -Cl1

Where Al, B1, C1 are Operands (Cell Addresses)

Creating Formulas using Fixed Values

We can use the numbers directly in the formula as fixed values. For example, if you want to
add two numbers say 100 and 200.

Step 1: Select the cell where result is to be displayed and click in it.

Step 2: Enter the formula =100+200 and press enter key or click button on the Formula Bar.
The result 300 will appear in the selected cell.

Creating Formulas using Cell Address

Look at the cells.

A B C D E F G H
1 |Product Rate Qty Amount
2 TV 25000 2
3 |Toaster 8000 4
4 Mobile Phone 32000 7
5 |AC 18000 1
b

To find amount of a product:

Step 1: Click in the cell D5 and type = (equal to) sign

Step 2: Click in the cell B2.

Step 3: Now type and then click on the cell D2

Step 4: Click on Enter button on the formula bar. The result will appear in cell E2.

D2 = X v S| =B2*C2
A B C D E F G
17 |Product Rate Qty Amount
2 |Tv | 25000] 2|-2*c2 |
3 |Toaster 8000 4
4 'Mobile Phone 32000 7
5 |AC 18000 1
6
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D3 - Jx

A B C D E F G
1 |Product Rate Qty Amount
2 TV 25000 2 50000
3 |Toaster 8000 4| _l
4 |Mobile Phone 32000 7
5 |AC 18000 1
6

Types of Formulas

Let us learn some simple ways of using a formula.

In Excel each cell can contain a calculation. In Excel terminology, it is called formula. Each
cell can contain one formula. When you enter a formula in a cell, Excel calculates the result of
that formula and displays the result of that calculation to you. Excel uses standard operators of
formula, such as plus sign for addition (+), a minus sign for subtraction (-), an asterisk for
multiplication (*), forward slash for division (/) and a caret (") for exponents.

All formulas in Excel must begin with an equal sign (=). This is because the cell contains or is
equal to the formula and the value it calculates. There are two types of formulas- Simple and
Compound formulas.

Simple Formulas

Basic formulas involve only one operator in a formula. Here is an example to understand this
well. To calculate the sum of two numbers, follow these steps:

Suppose you want to calculate the total marks of student. To enter formula, use the given steps:
Step 1: Click in the cell where you want to display the total. For example, G2.

Step 2: Type the formula=B2 + C2 + D2 + E2 + F2

Step 3: Press Enter Key. The total gets displayed in the cell.

Formula

SUM - X S =B2+C2+D2+E2+F2

A B C D E F G H
1 |Name _English Maths Hindi Science S5.5t. Total
2 |Trilok | 68| og| 78| og| 89|=B2+C2+D2+E2+F2
3 |Nidhi 78 09 73 89 90
4 |Lalit 78 90 84 93 84
5
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Total Marks

G3 v fx

A B C D E F G H
T |Name English Maths Hindi Science 5.5t Total
2 |Trilok 68 98 78 98 89 431
3 |Nidhi 78 99 73 89 90| ]
4 | Lalit 78 90 84 a3 84
5

Compound Formulas

Compound formulas are used when you need more than one operator.

To calculate the Simple Interest (Principal x Rate x Time) / 100), follow these steps:
Step 1: Type the content in the worksheet.

Step 2: Click on C6 (Where the result of the formula is to be displayed)

Step 3: Here, type= (C3*C4*C5)/100

SUM - X v i =(lc3*c4*Cs5)/100
A B C D E F

1 |Interest

2

3 Principal 10000

4 Rate(%) 5

5 Time(year) 3

6

7 | Interest |={c3*c4*(55){100

8

Step 4: Press Enter Key and the result will be displayed.

C8 = Jx
A B C D E

1 |Interest

2

3 Principal 10000

4 Rate(%) 5

5 Time(year) 3

(&)

7 Interest 1500

8 | [ 1

9

Functions in Excel 2010

Functions are the predefined formulas used to perform complex calculations and analysis.
These functions can be used in excel worksheet with the help of their name along with the
arguments in the form of cell references, ranges or values, which appear between parenthesis
next to the function name. for example, a simple mathematical function to calculate the sum of

multiple cell values can be used as:
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The above function will show the sum of values stored in cell range A1 to al0.

Some of the commonly used function in Excel are:
1)SUM ()

SUM function is used for summing up the values in a given cell range. The syntax of using this

=SUM(A1:A10)

Function Name Arguments

function is:

=SUM (Argumentl, Argument2 .......... )

Where SUM is the name of function and arguments can be the cell reference, cell range or
fixed values. Multiple arguments can be used by separated by comma (,) operator.

For example, =SUM (A1, A2, A3) [use of multiple cell address]

Or =SUM (A1:A10, B1:B10) [use of cell range]

Or =SUM (10,5,4) [use of constant values]

2) AVERAGE ()

This function is used to calculate the average or mean of the series of numbers in a cell range.
The syntax of using this function is:

=AVERAGE (Argumentl, Argument2 .......... )

Where AVERAGE is the name of function and arguments can be the cell reference, cell range
or constants.

For example, =AVERAGE (A1l: A10)

Or = AVERAGE (Al, A5, A10)

Or = AVERAGE (10,15,60,80)

3) MAX ()

This function is used to find the largest values in a series of numbers. The syntax of using this
function is:

=MAX (Argumentl, Argument2 .......... )

Where MAX is the name of function and arguments can be the cell reference, cell range or
constants.

For example, = MAX (A1: A10) will return the largest number value among the number stored
in the range of A1l to A10.

=MAX (10,15,60,80) will return 80 being the largest among these four numbers.

4) MIN ()

This function is used to find the smallest values in a series of numbers. The syntax of using this

function is:

Unit 8: Introduction to Spreadsheet (MS Excel)- lIPage 105 of 249



CVDMM- 302: ICT Resources and Applications uou

=MIN (Argumentl, Argument?2 .......... )

Where MIN is the name of function and arguments can be the cell reference, cell range or
constants.

For example, = MIN (A1: A10) will return the smallest number value among the number stored
in the range of Al to A10.

= MIN (10,15,60,80) will return 10 being the smallest among these four numbers.

5) IF ()

This is a logical function which evaluates a logical expression for its truthness and returns a
value among the two options. The syntax of using this function is:

=IF (Condition test, True value, False value)

In this, IF is the name of function and conditional test is the logical expression to be tested for
its truthiness. True value is the value returned in case expression evaluates to TRUE and
False value is the value returned if the condition stands False in the expression.

For example, = IF (A10>10, 1, 2)

In this statement, if the value in cell A10 will be less than or equal to 10 it will return 2 as a

result where as if the value will be more than 10 the value returned will be 1.

8.6 MODIFYING WORKSHEETS WITH COLOR

Working with columns, rows, and cells

By default, every row and column of a new workbook is set to the same height and width.
Excel allows you to modify column width and row height in different ways.
To modify column width:

1. Position your mouse over the column line in the column heading so the white cross

becomes a double arrow. ¢h +
B1 - Width: 935:':91 pixels) rakhand Open University
A B C D E F G
1 | Uttarakl‘land Open I.._lniversity
2

Click and drag the column to the right to increase column width or to the left to decrease

column width.

51 ' J* [\Width: 25.78 (239 pixels) "VErsity
A B C D

1 U‘tarakhand Open Universitv

2

2. Release the mouse. The column width will be changed in your spreadsheet.
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Bl

]
2

N Jr

B
| Uttarakhand Open University |

C

Uttarakhand Open University

If you see pound signs (########) in a cell, it means the column is not wide enough to display

the cell content. Simply increase the column width to show the cell content.

To set column width with a specific measurement:

1. Select the columns you want to modify.
2. Click the Format command on the Home tab. The

format drop-down menu appears.
Select Column Width.

jm :'r\ 7:7| X AutoSum T }Zv \ﬁ

3| Fill ~

Insert Delete |Format Sort & Find &

4. The Column Width dialog box appears. Enter a el xC[;” Swj:m T
specific measurement. N C__ avtoritRowreignt R |
Click OK. The width of each selected column will be Ii;lr;;;u%ﬂrl
changed in your worksheet. oy
Select AutoFit Column Width from the format drop-down opmees
menu, and Excel will automatically adjust each selected e ot
column so all of the text will fit. S '
To modify row height: B e
Position your mouse over the row line so the white cross el
becomes a double arrow. ¢h + [ Cotumn Width B e
Click and drag the row downward to increase row height or || o ioe: 58T
upward to decrease height. ok ][ cond |
Al - I Uttarakhand Open University
A B C

2

1 | Uttarakhand Open University |

Release the mouse. The height of each selected row will be changed in your worksheet.

Al

N Jx
A

B

Uttarakhand Open University

1]

I—e'ght_:_42.60 (71 pixels)

. n University

To set row height with a specific measurement:

1. Select the rows you want to modify.
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2. Click the Format command on the Home tab. The format drop-down menu appears.

uou

Al 7

g

hkhand Open University

B C

Row Height
Row height: B |
Uttarakhand ¢ [ - ] [ Cancel ]
1 I
2

3. Select Row Height.

4. The Row Height dialog box appears. Enter a

specific measurement.

5. Click OK. The selected rows heights will be
changed in your spreadsheet.

Select AutoFit Row Height from the format drop-

down menu, and Excel will automatically adjust each

selected row so all of the text will fit.

MODIFYING WORKSHEETS WITH COLOR

P T ' X AutoSum - W
- 3] Fill -
Insert Delete Format Sort &
(2 Clear ~ Filter ~
Cells | cell Size

! LI Rowﬂeight...l/\\) i

N Auto

-

=

ow Heigl
Column Width..,
AutoFit Column Width
Default Width...
Visibility

Hide & Unhide 3
Organize Sheets

Eename Sheet

Maove or Copy Sheet...

Tab Color »
Protection
(Zy Protect Sheet...
5]

Lock Cell

Format Cells...

4

Find &
Select =

Step 1: Select the row or column you want to change the color.

Insert  Page Layout  Formulas  Data Review View Help
& Cut |catibri [ =5 %E -
B Copy -
[ . A - = = = | & 3=
~ Format Painter . z - — === £33 E
Clipboard = Font Theme Colors Alignment|
_ H EEEENEE
Ad = I Geeta
A B C
1 Name English Maths Hmdl
2_|Nidhi Z = 7% | Standard Colors
3 |Lalit 78 90 84 EE EEEEE
4 |Geeta 68 98 78 -
No F
; ]
6 %y More Colors...
i

Step 2: Click on the fill color option

Step 3: Select the Theme color, you want to fill in the row or column.
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8.7

ANALYZING DATA

This section illustrates the powerful features Excel has to offer to analyze data.

1)  Sort: You can sort your Excel data on one column or multiple columns. You can sort in
ascending or descending order.

2)  Filter: Filter your Excel data if you only want to display records that meet certain criteria.

3)  Conditional Formatting: Conditional formatting in Excel enables you to highlight cells
with a certain color, depending on the cell's value.

4)  Charts: A simple Excel chart can say more than a sheet full of numbers. As you'll see,
creating charts is very easy.

5)  Pivot Tables: Pivot tables are one of Excel's most powerful features. A pivot table allows
you to extract the significance from a large, detailed data set.

6)  Tables: Tables allow you to analyze your data in Excel quickly and easily.

7)  What-If Analysis: What-If Analysis in Excel allows you to try out different values
(scenarios) for formulas.

8)  Solver: Excel includes a tool called solver that uses techniques from the operations
research to find optimal solutions for all kind of decision problems.

9)  Analysis ToolPak: The Analysis ToolPak is an Excel add-in program that provides data
analysis tools for financial, statistical and engineering data analysis.

8.8 SORT AND FILTER DATA

Excel offers a variety of built-in tools for data management among which sorting and filtering

features are the best one. The filter tool allows you to filter a column of data within a table to

isolate the required key components. The sorting tools allow you to arrange data in ascending

or descending order.

Sorting Data

Sorting means to arrange data either in ascending or descending order.

To sort the data:

Step 1: Select the cells. For example, A2:F4

Step 2: Click on Data Tab on the ribbon

Step 3: From the Sort & Filter group, Click on Sort A to Z option to sort in ascending order or

N12 e )
A B C D E F G
1 Name English Maths Hindi Science 5.5t
2 |Geeta 68 98 78 98 89
3 | Nidhi 78 99 73 89 20
4 |Lalit 78 90 84 93 84
5

Sort Z to A option to sort in descending order.
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A2 - Jr Nidhi
A B C D E F G
1 Name English Maths Hindi Science 5.5t
2 |Nidhi 78 99 73 89 90
2 |Lalit 78 90 84 93 84
4 |Geeta 68 98 78 98 89
5

To sort data on basis of multiple columns:
Step 1: Select the range of cells that contains the data to be selected.

Step 2: On the Data Tab, in the Sort & Filter group, Click on Sort option. The sort dialog box
appears.

A2 - Jx Geeta
A B C D E F G
1 Name English Maths Hindi Science 5.5t
2 |Geeta 68 98 78 98 89
3 |Lalit 78 90 84 93 84
4 |Nidhi 78 99 73 89 90
5

Step 3: Under Column, Click the Sort by down arrow and select a column from the list on

which you want to sort the data.

Step 4: Under Order, Click the down arrow and select an option to specify the sort order-A to
Z or Z to A, Smallest to Largest or Largest to Smallest, from the list.

N12 = S
A B C D E F G
1 Name English Maths Hindi Science 5.5t
2 Geeta 68 98 78 98 89
3 | Nidhi 78 99 73 89 90
4 |Lalit 78 90 84 93 84
5
Sort 7 >=
2| Add Level >< Delete Level Efz copy Level - Options... My data has headers

Column Sort On Order
sart by English o cell values o Largest to Smallest o

Then by Science o 1~ Cell values ~ Smallest to Largest ~
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Step 5: Click on Add Level button and repeat step 3 and 4 to add another column to sort the
data on.

Step 6: Click on the OK button.

1 Name English Maths Hindi Science 5.5t

2 | Nidhi 78 99 73 29 90
3 Lalit 78 90 34 93 34
4 |Geeta 68 98 78 98 29
5

Excel sorts the data on the basis of the first column and where the data values in the first column

are same, on the basis of the second column.
Filtering Data

Filtering is a process to extract the records from the worksheet that fulfil certain conditions. It
temporarily hides the rows that you do want to see. Excel provides AutoFilter and Custom
Filter to filter the data in a worksheet.

AutoFilter

The AutoFilter is used to filter data on basis the specific values present in a column.
To filter the records:

Step 1: Select any cell in the range or select range of cells.

Step 2: Click Filter option in the Sort & Filter group on the Data tab

H - 5 Book1 - Excel
File Home Insert Page layout Formulas [EBEIE Review View Help Team Q Tell me what you want to do
*—] = Queries & Connections ~N = v
3 o 5 sl I L) B S
= LA L@ © e
Get From From From Table/ Recent Existing Refresh El Sort Filter Textto Flash Remove Data (
Data - Text/CSV Web Range Sources Connections All- ‘TP Advanced Columns  Fill Duplicates Validation ~
Get & Transform Data Queries & Connections Sort & Fitter Data To
G10 @ S
A B e D E F G H J K L M N O
1| Name English Maths Hindi Science 5.5t
2 |Geeta 68 98 78 98 89
3 |Nidhi 78 99 73 89 0
4 |Lalit 78 90 84 93 84
5

Filter drop button will appear to the right side of each field name in the column headers row.

Step 3: Now, to filter the records with same data values in a particular field, click on the Filter

drop button of that field name

Unit 8: Introduction to Spreadsheet (MS Excel)- lIPage 111 of 249



CVDMM- 302: ICT Resources and Applications uou

H ©-
File Home  Insert Page Layout Formulas Review  View Help  Team
r D D D D D ”ﬁ 3 Queries & Connections a| Y
B LE L& ©) < 2> Az
Get From From From Table/ Recent Existing Refresh %\ »L Sort Filter
Data - Text/CSV Web Range Sources Connections All -
Get & Transform Data Queries & Connections Sort & Filte
Al - Je Name
A B C D E F G | H | | J
1| Name~| EnglisH~| Math!~| Hindi~| Sciend -] 5.5t/
2 |Geeta 68 98 78 98 89
3 |Nidhi 78 99 73 89 90
4 |Lalit 78 90 84 93 84
5

A list appears showing the values of that column. The option Select All is checked by default.

Step 4: Uncheck the Select All option and check only those values whose related records you
want to see. For Example, choose value 89 in the science field to see the record of students

who scored 89 marks in science.

Step 5: Click on OK button to filter and see the selective records.

H - s Bo
File  Home Insert Pagelayout Formulas WBCEM Review View Help Team @ Tell me whatyouwant tc
F D D D D D ”= [ Queries & Connections 8] Y
B L L& ®© < “ lalz
Get  From From From Table/ Recent = Bxisting  Refresh 7| Sort | Filter
Data~ Text/CSV Web  Range Sources Connections | All~ T Advance:
Get & Transform Data Queries & Connections Sort & Filter
Al - Jo | Name
A B C D E F G H J K
1| Nam¢-| English~| Math[~| Hindi~| Scien s.st| -
2 |Geeta | 4| sortSmallest to Largest 89
3 INIdhL ] 2| ort Largest to Smallest .
4 |Lalit 84
¢ | sSortbyColor , -
6|
7,
8,
9 —
10 Number Eilters ,
1 Search 0
12
~ (Select All)
13 Vg9
4] [¥l93
15 ¥ og
16|
17|
18]
19|
20 |
21|

Insert Page Layout Formulas Review View Help Team Q Tell
? D D [‘i D rlrba ] Queries & Connections "
= 32 L& © < ez

Get From From From Table/ Recent Existing Refresh zl Sort

Data - Text/CSV Web Range Sources Connections All ~
Get & Transform Data Queries & Connections
Al - b3 Name
A B C D E F G H

1| Mame- EnglisH-| Math/~| Hindi~| Sciend¥| s.5t|- |
3 |Nidhi 78 99 73 89 920
5
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Custom Filter

You can also use Custom Filter to extract the records that meet a specific condition. For

example, to display the records where the marks in Maths are less than 91.
Step 1: Select the range of data.

Step 2: Click on Filter option in the Sort & Filter group on the Data tab

H - 5 Bookl - Excel
File Home Insert  Pagelayout Formulas Review View Help Team Q Tell me what you want to do
= [T Queries & Connections A H Y ~y = E 5 v
[ D'] Egh D [‘l’ E Fe &l = E B ®
Get From  From From Table/ Recent Existing Refresh El Sort Filter Textto Flash Remove Data d
Data - Text/CSV Web Range Sources Connections All~ ‘P Advanced Columns  Fill Duplicates Validation -
Get & Transform Data Queries & Connections Sort & Filter Data To|
G10 v Jx
A B C D E F G H J K L M N 0]
1 Name English Maths Hindi Science 5.5t
2 Geeta 68 98 78 98 89
3 Nidhi 78 99 73 89 80
4 |Lalit 78 20 84 93 84
5

Step 3: Click on Filter drop button next to the column on which you want to apply the condition.

Step 4: From the drop list, select Number/Text Filters and click Custom Filter option from the

submenu. The Custom AutoFilter dialog box will appear.

Step 5: Click on the condition drop button to choose required condition like equals, does not

equal, is greater than, is less than, etc.

Step 6: Enter the value with which the condition is to be tested in the box next to it. You can

H - =
File Home Insert Page Layout Formulas Review View Help Tear
F D E‘ﬁ E [‘5\ D ||= [F Queries & Connections
= P
EER B =2 O =
Get From From From Table/ Recent Existing Refresh
Data - Text/CSV Web Range Sources Connections All ~
Get & Transform Data Queries & Connections
Al = Jx Name
A B = D E F G H
1 | Namd-| EnglisH-] Math[-] Hindi-| Sciend -| s.St|- |
4] sort Smallest to Largest 78 a8 89
A.L Sort Largest to Smallest t 73 89 S0
84 a3 84
Sort by Color >
Number Filters > Equals...
Search p Does Mot Equal...
(Select Al Greater Than...

Greater Than Or Equal To...

Less Than...

Less Than Or Equal To..
Between...

Top 10...

Above Average

Below Average

oK Cancel
Custom FEilter...

24 |
add another condition, if needed, by joining it with And or Or option.

Step 7: Click on OK button to get the filtered records
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Custom AutoFilter ? X

Show rows where:
Maths

is less than ~ 91 x

@and Oor
Use 7 to represent any single character
Use * to represent any series of characters
Al - J Name
A B C D E F G H
1 Name - Englisl‘lZ‘ Math HindE ScienE S.StE
4 |Lalit 78 90 84 93 84
5

Removing Filter

You can remove the filter and see all the records again.

Step 1: Select any cell in the worksheet.

Step 2: Click on Filter option in the Sort & Filter group on the Data tab

The filter drop buttons will disappear from the worksheet and the hidden records will be

displayed again in the worksheet.

8.9

POINTS TO REMEMBER

Excel 2010 is an electronic spreadsheet program. It is the spreadsheet component of
Microsoft Office 2010 suite, which is one of the most widely used application software

for data analysis

Spreadsheet were originally developed for book keeping. They are also useful for

scientific calculations, data manipulation and for producing graphs.

Microsoft Excel include some statistical functions, but for serious research work a
specialized package should be used.

Excel can also sort and select data, however for large amounts of data or more complex
task, a database program should be used instead.

8.10 GLOSSARY

A cell is a box at the intersection of a row and column in a worksheet where data is stored.

Columns are combination of all the vertical cells joined together in a single vertical line.

Unit 8: Introduction to Spreadsheet (MS Excel)- lIPage 114 of 249



CVDMM- 302: ICT Resources and Applications uou

° Rows are combination of all the horizontal cells joined together in a single horizontal

line.

° Workbook is a group of worksheets, which can be stored as a unit. A workbook is stored

on the disk in the form of a file with extension .xIs.

° Worksheet is the working area of MS-Excel. Each worksheet of a single workbook has

its own identity and is separate from other worksheets.

° Workspace is the working area of MS-Excel where workbooks, worksheets and other

related objects may be opened and manipulated.

8.11 CHECK YOUR PROGRESS

Descriptive type questions-

a)  What are the components of Spreadsheet program?

b)  Define a Formula in Excel and also define types of formulas.

c¢)  Define all functions used in Excel?

d)  How can number be subtracted, multiplied, and divided in excel cells?
e) Explain the SUM () function.

f)  What is sorting? How will you apply sorting to a range of cells?

g)  What is filter?

h)  How can we enter numerical value or formula as a label?

1) What is the role of Auto filter option?

7)) Explain the use of IF () function with the help of an example.

k)  Differentiate between Formula and Function.
Objective type questions-

a)  Formula should always start with = sign. (True/False)

b)  Formula and Function give the same result. (True/False)

c) Ranges cannot be used in formulas. (True/False)

d) A function must be followed by opening and closing parenthesis. (True/False)

e) The AutoFilter is used to filter data on basis the specific values present in a row.

(True/False)
f)  Using sort function data can be stored eitherin ... ... ... and ... ....... order.
g)  Sort A to Z option is used to sort the datain ... ... ... order.
h) A formula always contains ... ... ... and ... ... ...

1)  The cell address in a formula is known as ... ... ...

D function is used to calculate the sum.
Answer (Objective Type Question)-

[a] True [b] True [c] False [d] True [e] False

Unit 8: Introduction to Spreadsheet (MS Excel)- lIPage 115 of 249



CVDMM- 302: ICT Resources and Applications uou

[f] Ascending, Descending [g] Ascending [h]create, edit [i] cell reference [j]sum

8.12 BIBLIOGRAPHY/ REFERENCES

° J.K. Shahjahan, MS Office2010, Excel Books
° Sanjeev Gupta and Shameena Gupta, Computer Aided Management (Using MS-Office
2010 Tools), Excel Books

° Information Technology Vocational, Educational Publishers

8.13 SUGGESTED READINGS

° Excel for Beginners by M.L. Humphrey
° The art of invisibility by Kevin Mitnick
° Microsoft Office 2016 Rapid Edition, Word, Excel, PowerPoint, Access Rapid Editors

Unit 8: Introduction to Spreadsheet (MS Excel)- lIPage 116 of 249



CVDMM- 302: ICT Resources and Applications uou

UNIT- 9
INTRODUCTION TO MS POWER POINT- I

9.1 INTRODUCTION

9.2 OBIJECTIVES

9.3 STARTING MS POWER POINT

9.4 DIFFERENT TYPES OF VIEWS

9.5 CREATING PRESENTATION

9.6 DESIGN TEMPLATES

9.7 APPLYING CUSTOM ANIMATION AND SLIDE TRANSITION

9.8 MISCELLANEOUS POINTS- PRESENTATION

9.9 POINTS TO REMEMBER

9.10 GLOSSARY

9.11 CHECK YOUR PROGRESS

9.12 BIBLIOGRAPHY/ REFERENCES

9.13 SUGGESTED READINGS

9.1 INTRODUCTION

PowerPoint is similar to a word processor such as Word except the fact that it’s geared toward

creating presentations rather than documents. A presentation is like those Kodak Carousel slide
trays that your grandpa filled up with 35mm slides of the time he took the family to the Grand
Canyon in 1965. The main difference is that with Microsoft PowerPoint 2019 you don’t have
to worry about dumping all the slides out of the tray and figuring out how to get them back into
the right order.

A word document consists of one or more pages likewise, PowerPoint presentations consist
one or more slides. Each slide contains text, graphics, animations, videos, and other
information. You can easily rearrange the slides in a presentation, delete slides that you don’t
need, add new slides, or modify the contents of existing slides.

9.2 OBJECTIVES
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After the successful completion of this unit, you will be able to-

° Work with MS PowerPoint e.g. design templates, insert charts, shapes, etc.

e  C(Create your presentation.

e  Apply custom animation and slide transition.

9.3 STARTING MS POWERPOINT

MS PowerPoint interface-

You can start Microsoft PowerPoint in just a few simple steps as follows:

Step 1 Click on the PowerPoint icon in the Taskbar. If you do not see the icon, go to the Start

button, right-click, and choose Search. Type "PowerPoint" in the search field, and when

PowerPoint appears, double-click it. (Windows 7: Go to the Start button, then All Programs

and choose PowerPoint.)

Step 2 PowerPoint will open, prompting you to select a theme. Click on the Blank Presentation.

The MS PowerPoint interface’s quick explanation-

®  Quick Access- This button is positioned on the top left portion. This toolbar is

customizable which can be moved into two possible locations. This toolbar consists of a

set of commands that it is independent on the tab of the ribbon currently displayed and

you can add commands in this button.

Control Tool

Animation

Quick Access ‘ ' Title Bar ( Em
. - —~ or Tab Menu
3 . P — —
| Ribbon ] P =
Menu ::i-'- R
Sorter o
Panel
" Slide
template -
Add Note |
Bar
Status Bar ‘ ~

" sliding |

Pane

Zoom
In/Out

° Title Bar- It is positioned at the top of the user interface where the file name is seen after

saving a file. As default, once you open your MS-Office 2010 you will see it as

Presentationl Microsoft PowerPoint.
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° Control Tool Box- Located right top of the user interface where you can close, restore

and maximize, and minimize the windows program.

° Tab Menu or a tab of the ribbon- Positioned below the title bar the Tab menu relates
to the type of activity such as to relate a ribbon menu name. For example once you click
the home it will open as home ribbon menu. The tab menus are FILE, HOME, INSERT,
DESIGN, TRANSITIONS, ANIMATIONS, SLIDE SHOW, REVIEW, and VIEW.

° Ribbon Menu- Located under of the tab menu if you need to see it or control it, hold
CTRL key and press F1. This menu contains all the commands and other menu items that

help you find the command easily to finish your work.

° Slide Sorter- Positioned to the left side of your user interface. All the slides will arrange
in vertical order from the top as first slides down to your last slides. You can drag to

rearrange the slides, delete, and use other tools once you right click your mouse.

° Slide Template- This part is located at the center of your user interface, this is where

you start and put your design in Presentation, animation, effects, and more.

° Animation Pane- It is a part and command of ANIMATION PANE. Once you click this
button it will open in the right-side portion of your user interface. This pane or panel will
display the animation functions you use in your slide template. Also, you can rearrange

the animation and effects as desired.

° Zoom In and Out Sliding Bar- This part is located on the right side down and above of
the taskbar. This is used to enlarge and decrease the view of your slide template at the

center.

° Add Note or Notes Pane- This pane or panel is positioned at the bottom of your user
interface. This is where you can type notes that accompany your slide. You can print

these notes as notes pages or display it when you save a presentation as a web page.

° Status Bar- This part is located below the user interface and left side of the zoom in/out
sliding bar and view buttons of the slide show. This is only to notify what slide number

you use in your application.
Exiting MS PowerPoint-

After you have created a new presentation file and spent some time working on it, you will
want to save it every so often so that when your system crashes, you can recover your work.
And if you are like most folks you'll also want to save and close your presentation each time

you wrap up a work session.

Saving and closing a PowerPoint presentation are both straightforward tasks. If you are familiar
with any other Windows programs, then you will recognize most of the steps. To save a newly

created presentation:
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Step 1 Select Office button> Save. The Save As dialog box appears.

Most of the time, when you're ready to save your presentation, you'll choose the .pptx file type
or .ppt (the old, pre-2007 PowerPoint format). But you have got about a dozen choices,
including the template (.potx) and show (.ppsx) formats.

You can press Ctrl+S or click the Save button (the little diskette icon) that appears in the Quick
Access toolbar.

Step 2 Click the Save in the drop-down box to choose a directory to store your file in. In the

File name field, type a new name for your file.

Step 3 Click the Save as Type drop-down box to select a file format. Most of the time, you
will choose the .pptx format and click Save. The Save As dialog box disappears and PowerPoint

saves the file in the format you specified.

Step 4 To close a presentation, simply select Office Close. When you do, PowerPoint closes
your presentation with no fanfare. If you have never saved this particular file, however, a dialog
box pops up asking you if you want to save the changes you made. Click ‘Yes’ to display the

Save As dialog box and proceed as described above.

9.4 DIFFERENT TYPES OF VIEWS

PowerPoint supports multiple views to allow users to gain the maximum from the features

available in the program. Each view supports a different set of functions and is designed

accordingly. PowerPoint views can be accessed from two locations.

[1] Views can be accessed quickly from the bottom bar just to the left of the zoom settings.

Presentation Views View Ribbon
) Presentation] - Mirosolt PowerPomt [ Ll ‘—";!r
m Hom nsent Design ranssons Animations Stde Show Reviev lew a @
3 i sude Sone thde Marte Ruler i L2 B covee - ) o 2
i y \ yudy -, )
‘J_j?.:!e'. Page __;":1dcx.‘.!’::!er Gnolines .= = . Crayicale > = = . ! 4.
ol Wi Reading View J Notes Master Suldes SOOW >,,,,, am Black and White .'-."‘;.’:: :1 "JT - A9
1

[2] Views can also be accessed from the Presentation Views section in the View ribbon
Here is a short description of the various views and their features.

a)  Normal View- This is the default view in PowerPoint and is primarily used to create and
edit slides. You can create/ delete/ edit/ rearrange slides, add/ remove/ modify content

and manipulate sections from this view.

b)  Slide Sorter View- This view is primarily used to sort slides and rearrange them. This

view is ideal to add or remove sections as it presents the slides in a more compact manner
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making it easier to rearrange them.

2] Presentationl - Microsoft PowerPoint E=nEoET < |
ﬁ Home Insert Design Transitions Animations Siide Show Rewview Views <= 9
& i < S} =i = la 3 4
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New SR S Drawing Editing
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Clipboard = | Slides =
oo =
-
Slide#2
* SamplaTex2
Title Slide * Only text boxcoment
Wnrdl Ase Sampie Tec
inashape
1 =5 2
Slide #1 Slide #3
|
* Ssmple Texx = Compsre Text L - Compars Yexx 2
!
: | ! -
Stide Sorter “Office Theme ™ 5 | | [(B!S8le8 =& 100% (— L] + B3

Slide Sorter View icon

c) Reading View- This view is new to PowerPoint 2010 and it was created mainly to review

the slideshow without losing access to the rest of the Windows applications. Typically,
when you run the slideshow, the presentation takes up the entire screen so other
applications cannot be accessed from the taskbar. In the reading view, the taskbar is still
available while viewing the slideshow which is convenient. You cannot make any

modifications on this view.

Slides Show- This is the traditional slideshow view available in all the earlier versions of

PowerPoint. This view is used to run the slideshow during the presentation.

9.5 CREATING PRESENTATION

In Microsoft PowerPoint, a presentation is made up of multiple slides. There are several ways

to create or add a slide in a PowerPoint presentation. After adding slides, you can move the

slides around and also delete slides.
[1] Working with Slides
Insert new slide-

To insert a new slide into a presentation, follow the steps below.

e In the slide preview pane on the left, left-click with your mouse in-between two slides

where you want to insert a slide.

° In the PowerPoint ribbon, on the Home or Insert tab, click the New Slide option.
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° In the drop-down menu that opens, select the type of slide to insert. The new slide will

be inserted into the presentation where you clicked in step 1 above.
Copy and paste an existing slide-
To add a copy of an existing slide to a presentation, follow the steps below.
° In the slide preview pane on the left, find the existing slide you want to copy.
° Using your mouse, right-click on that slide and select Copy in the pop-up menu.

° Determine where you want to add the copied slide. Right-click on the slide above where

you want to paste the copied slide.

° In the pop-up menu that appears in the Paste Options section, click the middle paste
option icon to paste the slide. The middle paste option will paste the slide using the same

formatting as the slide you copied.
Insert slide from another presentation-
To add a slide from another presentation, follow the steps below:

° In the slide preview pane on the left, left-click with your mouse in-between two slides

where you want to insert a slide.
° In the PowerPoint ribbon, on the Home or Insert tab, click the New Slide option.
) In the drop-down menu that opens, click the Reuse Slides option at the bottom.

° In the Reuse Slides pane that opens on the right, click the Browse button and select

Browse File.

° Find the PowerPoint presentation file that contains the slide you want to add to the

currently open presentation and click the Open button.

e A preview of the slides is displayed below the Browse option. Left-click on the slide you
want to insert into the currently open presentation. A new slide will be inserted with text
from the selected slide included in the new slide.

° To also apply the formatting of the selected slide to the newly inserted slide, right-click
on the selected slide and select Apply Theme to Selected Slides.

Move a slide-

To move a slide to another location in a PowerPoint presentation, follow the steps below:
° Open the PowerPoint presentation.

° In the left preview pane, find the slide you want to move.

° Press and hold the left mouse button on the slide, then drag the slide up or down to where

you want to move it.
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° Release the left mouse button when you have dragged the slide to its new location.
Delete a slide-

To delete a slide in a PowerPoint presentation, follow the steps below.

° Open the PowerPoint presentation.

° In the left preview pane, click on the slide you want to delete.

° Press the delete key to delete the slide.

[2] Working with new presentation-

° Create presentations from scratch or a template.

° Add text, images, art, and videos.

° Select a professional design with a PowerPoint Designer.

° Add transitions, animations, and motion.

° Save to OneDrive to get to your presentations from your computer, tablet, or phone.
° Share and work with others, wherever they are.

Create a Presentation-

° Select Blank Presentation to create a presentation from scratch.

° Select one of the templates.

° Select Take a Tour, and then select Create, to see tips for using PowerPoint.
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Adding slide-
o Select the slide you want your new slide to follow.
° Select Home > New Slide.

° Select Layout and then you type want from the drop-down.

Insert Design Transitions Animations Slide Show Review Vie

sa, ¥ Cut

E@® Copy
Paste N
™ Format Painter

Clipboard

il

INTRODUCTION

Two Content

Blank Content with Picture with
Caption Caption

Add text and format text-
° Place the cursor where you want, and type.

° Select the text, and then select an option on the Home tab: Font, Font size, Bold, Italic,

Underline, etc.

e  To create bulleted or numbered lists, select the text, and then select Bullets or Numbering.

g 0O E -

File Home Insert Design Transitions | Animations  Slide Show | |

ﬁj X —@ l@ B~ | |calibri ~le6 v

5 B I U S a AY~
Paste E‘@ Mew Reuse 5 - ‘"'A .
- ¥ Slidev Slides T~ | # ~ A~ pa~ A A B
Clipboard (5] Slides Font (5

itie p S— SR

Adding a picture, shape, or chart-
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° Select Insert tab, then to add a picture- Select Picture or Browse for the picture you want
and select Insert.

° To add a shape, art, or chart- Select Shapes, Icons, SmartArt, or Chart

9.6 DESIGN TEMPLATES

PowerPoint offers design templates to make it easy to create an attractive presentation. These

templates come in a variety of colors and styles. You can apply a design to existing slides or

begin a new presentation with a template. To begin a new presentation with a design template:
° In the task pane under New, click Design Template.

° A list of templates appears.

° Move your mouse pointer through the different designs or use the scroll bar.

° Click the down-pointing arrow in the gray box next to the template you like.

° Choose Apply to All Slides.
Adding a design to an existing presentation-

Do you have an existing presentation you want to add a design to? PowerPoint makes it easy

to enhance existing slides with a design template. To apply a design to an existing presentation:

) In the task pane, under Open a presentation, click the presentation you want.

° Click the down-pointing arrow in the New Presentation & # Slide Design v X
pane and choose Slide Design - Design Templates. Design Templates
[e=f Color Schemes
e A list of templates appears. (% Animation Schemes

e  Move your mouse pointer through the different designs ~ 2PPly a design template:

Used in This Presentation &
or use the scroll bar.

. . . Lorem Ipsum
° Click the down-pointing arrow in the gray box next to I
the template you like. -'":T‘;.."“:""'“"""" —

) Choose Apply to All Slides.

Applying a design template to selected slides-

Recently Used
As you are working on your presentation, you can choose to 1
apply a particular design template to selected Slides if you %fapsmeﬂ
want one or more slides to have a different look. - e

b
T
- Ve s
I T )
=T

APPLYING CUSTOM ANIMATION AND SLIDE
TRANSITION

9.7
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Custom Animation-
We can apply the custom animation with the certain steps given below:
° Select the text or object.

° Select the Animation tab.

ol =
Home Insert Dresign @ Slide Show Review View Format L7]

il [Mo Sound] - || Advance Slide

'A._E,i' 124 | Mo Animation - [

= — Ef—,FI_ Fast b On Mouse Click
Preview .- Transition =
2f Custom Animationd = o~ 130 Apply To All v Automatically After: 00:00  *
Preview Animations Transition to This Slide

— = Custom Animation X
) :
@ £ :
2 E ~ | _ Entrance b | 1. Blinds
- ig————-— — Ernphasi v s 2E
mphasis ]
| |:| Product Life Cycle l!' _.p «
O e & Exit * | 3y 3. Checkerboard
4 Stages Motion Paths » | 3 4. Diarmend
# 5Fyln
Select an elemer More Effects...
alick Add Effect -

° In the Animation group, click the Custom Animation.
° Custom Animation task pane appears on the right.

° Click the Add Effect. It will display four options that are further divided into different

options.
° Select the desired effect.
Slide Transition-
Transition effects appear, when one slide changes into the next slide in a slide show.
° Select the slide to which you want to apply the effect.
o Select the Animation tab.

° In Transition to This Slide group, you will see the transition effects.
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° Click the drop-down arrow to see the menu of transition effects.

y

n
‘,‘/
- Home Insert Design Slide Show Review View Format

#h [No Sound] ~ | Adva

742, 1.4 No Animation ~ = ;

1] S I "5 2y ]
o h .‘I "A“-" - T - v =_—J,_ Fast bt ¢
review "’;,1, Custom Animation — —— O 2 Apply To Alll v ¢

Preview Animations [Transition to This Slide]

. I

° Select the desired transition effect.

e  Click ‘Apply to All’ to apply the effect to all slides.

9.8 MISCELLANEOUS POINTS- PRESENTATION

Saving a presentation-

PowerPoint offers two ways to save a file: Save and Save As. These options work in similar

ways, with a few important differences.

° Save: When you create or edit a presentation, you'll use the Save command to save your
changes. You'll use this command most of the time. When you save a file, you'll only
need to choose a file name and location the first time. After that, you can just click the

Save command to save it with the same name and location.

° Save As: You'll use this command to create a copy of a presentation while keeping the
original. When you use Save As, you'll need to choose a different name and/or location

for the copied version.
Note- Using ""Save As" to make a copy-

If you want to save a different version of a presentation while keeping the original, you can
create a copy. For example, if you have a file named Client Presentation you could save it as
Client Presentation 2 so you'll be able to edit the new file and still refer back to the original
version. To do this, you'll click the Save As command in the backstage view. Just like when
saving a file for the first time, you'll need to choose where to save the file and give it a new file

name.
Running a Presentation

Most PowerPoint presentations are created to run as a slideshow. Given all the advanced feature
available in PowerPoint 2010 it is no surprise that there are many features related to running
the slideshow that has been included in this program too. Most of these features are really to

help you create a good slideshow without having to go through the entire presentation over and
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over again after every minor change. Features related to running the slideshow are grouped
under the Slideshow ribbon.

Closing a Presentation-

Slide Show Ribbon
(P] Title Slide2.pptx - Microsoft PowerPoint * = :
Iﬁ Home Insert Design Transitions Animations Stide Show Review View [~ @
-*—b‘ 8 From Current Stide eo=ms oMl Hide Slide V! Play Narrations -
- 4 2 e —
= @ Broadcast Slide Show —= S Rehearse Timings Z1 Use Timings
From Set Up 3 Monitors
Beginning .= Custom Slide Show = gjide Show ™ Record Slide Show ~ (VI Show Media Controls -
Stast Slide Show vet Up

Closing a presentation is certainly easier than opening one. To close a presentation, save your
file and use one of these techniques:

° Click the Office button and choose Close on the drop-down list. The PowerPoint program

remains open although the presentation is closed.

° Click the Close button, the X in the upper-right corner of the PowerPoint window (or

press Alt+F4). Clicking the Close button closes PowerPoint as well as your presentation.
Opening an Existing Presentation-

PowerPoint and Windows offer many shortcuts for opening an existing presentation. To open
a presentation, click the Office button and choose Open - or take advantage of the numerous
ways to open presentations quickly as followed-

° Click the Office button and choose Open on the drop-down list (or press Ctrl+ O). You
see the Open dialog box.

° Locate and select the presentation you want to open and then click the Open button. You

can also double-click a presentation name to open a presentation.

9.9 POINTS TO REMEMBER

° Microsoft PowerPoint is widely used for making professional quality presentations in a

variety of formats, including onscreen computer slide shows, black-and-white or colour
overheads, and 35 mm slides. You can also use it for notes and class presentations.
Besides, PowerPoint can be used as a drawing package for preparing pictures, forms,
posters, and leaflets.

° Presentation is a powerful managerial tool of communication through which you can
compile and deliver your ideas, concepts, plans, and products to the audience in a

structured, effective, and impressive manner.

° Slides and transparencies are used to projected in front of the audience using an overhead
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projector or otherwise. The operation of this equipment is mainly manual, semi-

automated at the best.

9.10 GLOSSARY

Title Bar: This is the top section of the window. It shows the name of the file followed

by the name of the program which in this case is Microsoft PowerPoint.

Slide Area: This is the area where the actual slide is created and edited. You can add,

edit, and delete text, images, shapes and multimedia in this section.

Normal Layout View: This displays page in normal view with the slide on the right and
a list of thumbnails to the left. This view allows you to edit individual slides and also

rearrange them.

Slide Tab: This section is available only in the normal view. It displays all the slides in

sequence. You can add, delete, and record slides from this section.

Quick Access Toolbar: The Quick Access Toolbar is located just under the ribbon. This
toolbar offers a convenient place to group the most commonly used commands in

PowerPoint.

9.11 CHECK YOUR PROGRESS

Objective type questions-

a)

b)

c)
d)
e)
f)
g

h)

)

Word documents consist of one or more pages, and PowerPoint presentations consist of

one or more.....

..... This part position right side down and above the task bar. This is use to enlarge and

decrease the view of your slide template at the center.

..... view is used to run the slideshow during a presentation.

PowerPoint offers two ways to save a file..... and.....

..... View presentations you recently worked on in the dialog box.

Each slide is consisting of text, graphics, animations, videos, and other information.

reading view is the default view in PowerPoint and this is primarily used to create and
edit slides

Click the Office button and choose Close on the drop-down list for closing the

presentation

Broadcast slideshow Allows users to broadcast the slideshows using Microsoft's
PowerPoint Broadcast Service

Presenter View is used to define the resolution in the slideshow view.
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Descriptive type questions-

a)
b)
c)
d)
e)

What do you use MS PowerPoint for? Elaborate.

What is MS PowerPoint?

Explain the major functions used in MS PowerPoint.
Create a MS PowerPoint Presentation with animated slides.

What are the major features of MS PowerPoint?

Answers (Objective type questions)

[a] Slides [b] zoom in and out sliding bar [c] slideshow view [d] save and save as [e] My Recent
Documents Button [f] True [g] False [h] True [i] True [j] False
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10.6 EDIT TEXT, FONT STYLE AND COLORS IN SLIDES

10.7 WORKING WITH TABLES IN A PRESENTATION
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10.14  SUGGESTED READINGS

10.1 INTRODUCTION

Presentation is a way of communication between the speaker and the audience. It helps to

communicate the ideas for information on any topic to the masses. An effective presentation
always leaves an everlasting effect in the minds of people, so it is very important to understand
before creating any presentations that who are the target audience of that presentation? What
should be the contents? How these are to be organised? And finally, what should be mode of
presentation? A presentation can be in a written, oral or visual form. But a successful
presentation is one which can bind the audience till the end by effectively communicating the
core idea behind the presentation. Graphical components in a presentation like pictures, charts,
motion clips, figures, diagram, etc, prove to be an excellent tool to convey the idea in an

effective and interesting manner.
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Earlier, there were limited tools available to deliver the presentation. The traditional tools like
notes, drawn figures, images, still slides, etc., were used for this purpose. But now with the
development of multimedia technology in the field of computers, the trends are totally changed.
Today’s presentations are supported by multiple modes of communication like text images,
graphics, videos, audios, etc. Animation and sound effects not only just make the presentation
effective and interesting, but also help the presenter to quickly design the presentations. Some
popular presentation software are. Microsoft PowerPoint, Google Slides, Prezi, Corel
presentations, Open office impress and Harvard graphics. We are going to learn the use of one
such application for designing a computer-based multimedia presentation. The name of this

application is Microsoft PowerPoint 2010.

10.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

° Define MS PowerPoint Working
° Explore Table
° Define Charts and Graphs

10.3 WHAT IS POWERPOINT 2010

Microsoft PowerPoint 2010 is a presentation component of Microsoft Office 2010 suite which

is used to design computer-based multimedia presentations. Presentation in PowerPoint is a
collection of electronic slides containing information in the form of text, graphics, movie clips,
sounds, etc. These slides are displayed in a sequential order one after the other at the time of
presentations on the monitor or projection screen with all multimedia and animation effect in

the form of a slide show.

PowerPoint is not just used for creating electronic presentations, but is also used for making

handouts, speaker notes, etc. which are effective tools for any kind of presentations.
Starting PowerPoint 2010

To start PowerPoint 2010:

Step 1: Click start button on the Taskbar.

Step 2: Select all programs

Step 3: Choose Microsoft Office option in the submenu

Step 4: Click Microsoft PowerPoint 2010 option

10.4 COMPONENTS OF THE POWERPOINT WINDOW

The various components of PowerPoint 2010 Windows are as follows.
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File tab: It opens the backstage view to manage the files and settings. You can save, open and

create a new presentation based on a blank or predefine templates.

Quick access toolbar: It is a customizable toolbar present on the left side of the titlebar used

to quickly perform some of the commonly used functions like saving a file, undo, redo etc.

Title bar: It appears at the top of PowerPoint window which shows the name of presentations
you are working with and has three control buttons on its right side to minimize, maximize and

close the window.

Ribbon: This component is present just below the title bar. It has eight tabs in it wherein each
tab is divided into the groups. The groups are the logical collection of PowerPoint command

to perform various presentations related functions.

Group: Logical collection of commands together are referred as group. It changes with every

tab. File tab show following groups: clipboard, slides, font, paragraph, drawing and editing.
Slide Pane: It is the actual work area where individual slides are created or modified.

Notes Pane: It is a small rectangular area under the slide pane which is used for making the

speaker notes for the individual slides.

Slide Tab: It is present on the left side which shows miniature of each slide. Functions related

to slide can be performed such as addition, deletion and rearranging slides from the slide tab.
Outline Tab: It is present on the left side which show the existing text present in the slide.

Status Bar: It is present at the bottom of the PowerPoint window. It displays the information
about the current slide such a slide number, name of the theme, slide view and zoom

percentage.

Slide View: It is present on the status bar at the bottom of the PowerPoint window having four

views: Normal view, slide sorter view, slideshow view and reading view

10.5 CREATING PRESENTATIONS IN POWERPOINT

Microsoft PowerPoint 2010 offers different ways to create new presentation. You may choose

any of these method as per your needs which are available under Available Templates and
Themes. These are:

Blank Presentation: You can use this method to create customise presentations wherein you
can add contents, format slide, apply effects of your own. This is the default way for creating
presentations in PowerPoint.

Recent Templates: The templates which you have used recently are shown in this category.

Sample Templates: This is an easiest way to create presentations on some general topics.
PowerPoint offers a set of readymade templates suggesting the contents and designyou’re your
presentation.
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Themes: This option is useful when you want to use predesigned format for your presentation
as the present background font style, etc are provided by PowerPoint

My Templates: In this, templates customised by you are saved and shown here which can be
used later on

New from Existing: It allows you to use create or modify the new template using existing
templates as a base

Common Terms Used in PowerPoint

> slide a single page in a presentation which may contain text image stars video etc
> presentation a group sequentially arrange

> slides slide deck a group of related slides
10.6 EDIT TEXT, FONT STYLE AND COLORS IN SLIDES

Communication is a vital part of our daily life. We can communicate our ideas in verbal or

written form. Communication through text is effective in Presentation having graphics adds for

clarity.

Inserting Text in a Slide

Textbox command is used to create additional text placeholder on a slide, if needed

To insert a text box:

Step 1: Click on the insert tab

Step 2: Click on text box from the Text group.

Step 3: Drag the mouse pointer on the slide where you want to add the text. A text box will
appear with a blinking cursor.

Enter the text as needed. The Text box expands automatically to the next line, if the enter text
is more than the size of the text box.

Editing Text in a Slide

The Text entered in a placeholder or text box can be modified easily.

Step 1: Click on the text placeholder to be modified. The cursor appears.

Step 2: Make changes as required and then click outside the placeholder.

Changing the Text Box Background Colour

Step 1: Select the text box. When you insert a text box, a new Format tab appears.

Step 2: Click Shape Fill from the Drawing group and select the color of your choice. The select
color will appear in the background of the text box.

Changing the Text Box Outline

Step 1: Select the text box. When you insert a text box, a new Format tab appears.

Step 2: Click Shape Outline from the Drawing group and select the line color of your choice.
You can use Weight option in it to change the line thickness. The select color will appear in
the background of the text box.
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Copying the Text in a Slide

Step 1: Select the text to be copied.

Step 2: Click copy option in the Clipboard group on the Home tab.
Or

Press Ctrl + C keyboard Shortcut.

Step 3: Bring the cursor to the new location where text is to be pasted.
Step 4: Click paste option in the Clipboard group.

Or

Press Ctrl + V keyboard Shortcut.

The selected text will appear at the destination.

Moving the Text in a Slide

Step 1: Select the text to be moved.

Step 2: Click Cut option in the Clipboard group on the Home tab.
Or

Press Ctrl + X keyboard Shortcut.

Step 3: Click to select the destination where text is to be moved.
Step 4: Click paste option in the Clipboard group.

Or

Press Ctrl + V keyboard Shortcut.

The selected text will move to at the new position.

Formatting the Text in a Slide

Text entered in the slide using various placeholders appears as per the format set for these.
PowerPoint offers wide variety of formatting features that can help you to change the default
text formats as per the need of your presentation.

Using Font Group

Step 1: Select the placeholder that contains the text to be formatted.

Step 2: Use the commands in the Font Group to format the text on the slide.

Using Font Dialog Box

You can also use Font Dialog box to collectively modify the text formatting.

Step 1: Select the text to be formatted.

Step 2: Click launcher button available in the lower right corner of Font Group. A Font Dialog
box will appear.

Step 3: Use the various text formatting and special effects option to change the default format.
Aligning Text

Alignment refers to the placement of text within the placeholder. Text inside the placeholder
can be aligned to left, right, center or justified like this:

Align Left: Aligns the text towards the left edge of the placeholder.

Align Right: Aligns the text towards the right edge of the placeholder.
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Center: Aligns the text between left and right edge of the placeholder.
Justify: Aligns the text evenly between left and right edge of the placeholder.
Using Paragraph Group
Step 1: Select the text or the placeholder whose text has to be aligned.
Step 2: Click the required alignment option from the four options available on the paragraph
group under the Home Tab.
Using Paragraph Dialog Box
Step 1: Select the text or the placeholder whose text has to be aligned.
Step 2: Click launcher button available in the lower right corner of Font Group.
Step 3: A paragraph dialog box will appear and select the alignment under the General section.
Text Direction
This command is used to change the orientation of text in a placeholder. It has four options:
Horizontal, Rotate all text 90°, Rotate all text 270°, and Stacked. The default text direction is

Horizontal.

Align text
This command is used to align the text between the top and bottom edge of a placeholder. The

options are: Top, Middle, and Bottom.

10.7 WORKING WITH TABLES IN A PRESENTATION

In PowerPoint 2010, tables are useful tool for presenting and organising the data in tabular

form. A table is information arranged in horizontal rows and
vertical columns. Tables are generally used to organised text D G+ @

Table Pictures Screenshot Photo
. . . . . . - - - Album'
document, it appears as a simple grid with black gridlines 5x5 Table

on numerical data. When you first insert a table into a

defining the rows and columns. In PowerPoint, you can | CI000]
modify the appearance of table as per your choice. A well- %%%%%
designed table conveys information in more meaningful way. REREE
, 00000
Inserting Table I
{1
Let us learn how to insert a table in PowerPoint. R
==z Insert Table...
Using Insert Tab [ Draw Table

’__|§3 Excel Spreadsheet

To insert a table:

Step 1: Click on the insert tab
Step 2: Click the table option from the table group. A drop-down menu will appear.

Step 3: Drag the mouse over the required number of boxes. A table with the selected number
of rows and columns will be inserted.

Using Layout
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To insert a table

Step 1: Click on the new slide dropdown Arrow under the home tab. Select the title and content
Layout from the drop-down list

Step 2: Click on the insert table icon present on the slide. The insert table dialog box will
appear.

Click to add title
[o! o o
* Click to add text
Insert Table ? s
Number of columns: |5 2
Number of rows: 2 =
O e}

Step 3: You can define the number of rows and columns as per your requirements.
Step 4: Click on Ok button

A table will be displayed with defined number of rows and columns.

503 -

File

Rteshkandari @B) B - @ X

Home Insert Design Transitions &

] Header Row [ First Column

Total Row [ ] Last Column

] Banded Rows [] Banded Columns

Table style options Tabile tyles Werdan Styles 5 Draw Borders ~

‘‘‘‘‘‘

1

Click to add title

Entering data in a table
To enter data in a table:

Step 1: Position the mouse pointer in the first cell of the table and typing whatever you want.
If the data takes up more than one line in the cell, the text will automatically wrap to the next
line. This increases the height of that cell and all the other cells available in that row.
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Step 2: To move to the next insertion point, you can press the tab key on the keyboard or simply
click on the desired cell.

Step 3: Type whatever you want in the next cell. Thus, we can enter data in the table using the
tab key or Arrow key or Mouse

Student List of Class X

1 344 300

Akash Suresh Sharma
Dhruv Brijesh Pathak 2 450 470
Rakhi R.Srivastav 3 390 450

Step 4: Click anywhere outside the table when you have finished

Inserting Rows and Columns in a Table
To insert new rows in a table:
Step 1: Locate the insertion point in a cell and right-click. A shortcut menu will appear.

Student List of Class X

ibri - *
Calibri (Body) ~ 18 - A oA m - g - D
B I == =%-A -2 -4 - Insert Delete

New
Comment

Roll Number First Term marks Second term Marks

Akash :sh Sharma 1 344 300
3 Paste Options:
O P O
Dhruv 0O = :sh Pathak 2 450 470
Font.
Rakhi Bullets » ivastav 3 390 450

Numbering »

Hyperlink...

v @ il il »

Smart Lookup

Synonyms >

W
M

Translate

Ed sp t Cells...
E se ect Table
O

# Format Shape...

Step 2: Select the insert option and click either on the insert row above or insert row below sub
option. After selection, you will see a new blank row is inserted.

Deleting Rows and Columns in a Table

Before you delete a row or a column, you should know that whatever you want to delete the
content of the row or the contents and the structure of the row.
To delete a row or column from a Table:
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Step 1: select the row column you wish to delete

step 2: under the layout tab, click on the delete option in the Rows and Column group.

Step 3: Select the required option from the submenu.

Formatting a Table

PowerPoint offers numerous predefined table styles that you can use to quickly format a table.

If the predefined tables styles do not meet your requirements, you can create and apply a custom

table style.

When you insert a table in a slide, a new tab appears known as Table Tools. This tab is divided

into two sections such as Design and Layout tabs. You will find various tools and commands

for formatting present on these tabs such as Borders, Shading, Table style, Border Color, Merge

cells, Split cells, etc.

Applying Table Styles

When you insert a table in a slide, a table style will be applied automatically. PowerPoint 2010

offers various predefined styles in the Table Style group on the Design tab under the Table

Tools tab. To apply a table style:

Step 1: Select the table.

Step 2: Click on the design tab to access all the table styles and other options of this tab.

Akash
Q
Dhruv

Rakhi

Student List of Class X

Student Name | Father’s name Roll Number First Term marks Second term Marks |

Suresh Sharma 1 344 300

Brijesh Pathak 2 450 470

R.Srivastav 3 390 450

Step 3: Hover the mouse over any table style to see its live preview on the slide.

] Banded Rows ] Banded Columns
Table Style Options.

1

ent List of Class X

o)
1 344 300
2

450 470

3 290 450
o le]
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Step 4: Click on the more dropdown Arrow of the table styles group to view all the options.
Step 5: Click on the desired style to select it.

Applying Borders

To apply a border:

Step 1: Select the cells on which you want to add a border.

B 0F - Presentation] - PowerPoint Table Too Ritesh Kandari @ i3]

file  Home Insert Design Teansiions Anmations SideShow Review View Help [ESE

| Header Row [ First Column e
Total Row Last Calurmn 1pt N
Draw Eraser
| Banded Rows || Banded Columns L& PenColor- Table
Table Style Opticns Table Styles Draw Borders
6 s 2 i

1

o)
Second term Marks

Akash Suresh Sharma 1 344 300

o o » (o}
Dhruy Brijesh Pathak 2 450 470
Rakhi R.Srivastav 3 390 450

(o) O 0

Step 2: Click on the Borders dropdown arrow in the table styles group on the design tab. Select
the desired border type from the drop-down menu.

Step 3: Selected border will be applied to the selected cells.

Applying Border Color

To change border color of a table:
Step 1: Select the table. Click on the Pen Color option from the Draw Borders group in the
design tab.
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Step 2: Choose the required color from the color palette. You will see that mouse pointer
changes to a pencil shape.

Step 3: Click on the left mouse button on the border whose color you want to change or simply
drag the mouse into the cell border and release the button. The line color will be changed.

Applying Border Style

A tool named as Pen style is used to change the line style of a table.
To changing the line style of a table:

Step 1: Select the table.

Step 2: Under the table tool tab, click on the pen style list box which is present on the design
tab.

Step 3: A drop down mouse appears. Select the required style from the drop-down menu.
Step 4: Position the mouse pointer on any border of the table and click on it.
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Applying Shading

You can change the appearance of a table by adding shades. for example, if a table contains
many rows and columns, you might shade alternate rows to help readers distinguish them from
one another. To change table shading follow the given steps:

[ Header Row ] First Column

[ Total Rew | Last Column

[] Banded Rows ] Banded Columns
Table Style Options

1

[——

First Term marks Second term Marks
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Step 1: Select the table and click on the design tab
Step 2: Select the rows and columns that you want to modify.
Step 3: In the table style group, click on the shading option and select any color of your choice.

10.8 INSERTING CHARTS IN A PRESENTATION

A chart is the graphical representation of data in which data is represented by symbols such as

bars, lines, etc. It is an effective way of visualize data to the audience. In general, charts are
widely used for, understanding large quantities of data and the relationships between parts of
the data. There are many types of chart in PowerPoint 2010. Each chart has its own advantage.
for example, a pie chart is used to show the percentage value data and line chart is used to show
the trend of data over a period of time in effective way.

Inserting Chart
There are two main ways to insert chart in a presentation.
Using Insert Tab

To create a simple chart
Step 1: Click on the insert tab.
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Slides | Tables Images usirations Add-ins Links Camments Text Symbols Mediz

Step 2: In the illustration group, click on the chart option

Step 3: The insert chart dialog box appears. Select the desired chart type from the left pane and
the wide range of selected chart type will be appeared in the right pane.
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Step 4: After selection, click on Ok button.

The chart will be displayed in a slide.

Using Layout

To insert a chart:

Step 1: Open a new file in the PowerPoint

Step 2: Click on Home tab

Step 3: Click on the Layout option from the slides group and change the layout of the file.
Step 4: Select the title and content

Step 5: Click on the insert chart icon in the content placeholder.

Step 6: The insert chart dialog box appears. Select the chart type from the left pane and the
wide range of the selected chart type will be appeased in the right pane.

Step 7: Click on Ok button.

An Excel window will open with the placeholder for your data.

Modifying a Chart

In PowerPoint 2010, there are many ways for customising and organising chart. You can
change the appearance of chart by changing the text, line, font color, background, chart style
etc. On inserting a chart, a new tab appears named as Chart Tools. This tab is divided into three
sections. Design, Layout and format which contains various option that allows you to modify
and format the chart as desired.

Changing the Chart Type

You can change the chart type as needed

To change the chart type:

Step 1: Select the chart. Click on the design tab under the chart tools.

Step 2: Click on the change data type option in the type group. The change chart type dialog
box will appear.

Step 3: Select any chart type and click on Ok button. The chart will change accordingly.
Or
Step 1: Select the chart where you want to change layout.

Step 2: In the chart layout group under the design tab, click on the more dropdown arrow to
see all the available chart layout options.

Step 3: Select desired chart layout.
Changing Chart Style

You can quickly modify the appearance of the chart by changing its style. Quick style for lines
includes line styles, gradients, various effects and Shadow.
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To change the chart style:

Step 1: Select the chart whose layout you want to change.

Step 2: Click the more dropdown arrow in the chart styles group under the design tab

Step 3: Select any style from the list that appears.

The chart will be displayed as per your selection.

Changing Background

You can modify a chart by changing its background.

To change the background:

Step 1: Select the chart whose background you want to change.

Step 2: Click on the plot area and select the format plot area option from the shortcut menu

Step 3: The format plot area dialog box will appear. You can select border-style, border color,
shadow effect as per your requirement.

Step 4: Click on the close button and observe the change.
Editing Data

Apart from that, the chart you are obtain on the slide has some fixed data in it. If you want a
chart with your own set of data, follow the given steps:

Step 1: A datasheet will open up.

Step 2: Right click on the chart and click on the edit data option from the shortcut menu. A
datasheet will open up containing the default data for charts.

Step 3: Modify the data of this seat to any data you want.

Every time you press Enter key on the datasheet the chart get refreshed and the newly entered
data takes effect.

TIPS TO CREATE PROFESSIONAL SLIDE FOR
PRESENTATION

° Remember to avoid too much text. You should keep your text brief and include talking

10.9

points only. Detailed notes can be inserted into the notes section of PowerPoint, but only
you should see those notes, unless a professor asks to see your notes to evaluate your

PowerPoint as an assignment.

° Be consistent and clear with your font choices. Helvetica is a nice font for
presentations. Make sure your font is large enough that an audience in a room would be
able to see your text, even if audience members are sitting in the back of the room.
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Be careful with your color choices for text and background. You want to make sure
your audience can read your text easily. Black on white text is easiest to read but is also
boring for a presentation. Still, when you add color, just be sure you are adding color that

works and doesn’t distract.

Add images. Text on slides for every slide is boring. Add appropriate images to your
slides. Relevant charts and graphs are excellent, as are pictures that will connect to your

content.

Make sure your main points are clear. Remember to connect your ideas well and

provide background information and transitions when necessary.

Keep your audience in mind. Your audience will affect the overall tone and appearance
of your presentation. Sometimes, humor can be appropriate. Other times, a more serious
tone may be necessary. Just as you evaluate your situation any time you write a paper,

you should evaluate your situation for creating a PowerPoint presentation.

10.10 POINTS TO REMEMBER

Microsoft PowerPoint is widely used for making professional quality presentations in a
variety of formats, including tables, charts. You can also use it for notes and class

presentations.

PowerPoint can be used as a drawing package for preparing pictures, forms, posters, and
leaflets. Presentation is a powerful managerial tool of communication through which you
can compile and deliver your ideas, concepts, plans or products to the audience in a

structured, effective and impressive manner.

Slides and transparencies are used to be projected in front of the audience using overhead
projector or otherwise. The operation of this equipment was mainly manual, semi-
automated at the best. This approach had obvious limitations. Computer have now

replaced the traditional method of presentation entirely.

10.11 GLOSSARY

Title bar is the top section of the window. It shows the name of the file followed by the

name of the program which in this case is Microsoft PowerPoint.

Slide area is the area where the actual side is created and edited. You can add, edit and
delete text, images, shapes and multimedia in this section.

The Quick Access Toolbar is located just under the ribbon. This toolbar offers a

convenient place to group the most commonly used commands in PowerPoint.
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° Blank Presentation is used to create customise presentations wherein you can add
contents, format slide, apply effects of your own. This is the default way for creating

presentations in PowerPoint.

° Themes is useful when you want to use predesigned format for your presentation as the

present background font style, etc are provided by PowerPoint

° Ribbon component is present just below the title bar. It has eight tabs in it wherein each
tab is divided into the groups. The groups are the logical collection of PowerPoint

command to perform various presentations related functions.

° A table is information arranged in horizontal rows and vertical columns. Tables are

generally used to organised text on numerical data.

e A chart is the graphical representation of data in which data is represented by symbols

such as bars, lines, etc. It is an effective way of visualize data to the audience.

10.12 CHECK YOUR PROGRESS

Descriptive type questions-

a)  What is a slide? How many tabs are there in the Microsoft PowerPoint?

b)  List the key points to be kept in mind while making a Microsoft PowerPoint.
c) How do we change font, size and its color?

d)  What is alignment? What are the types of alignment?

e)  What features are used to modify text?

f)  What is Table? What are the advantages of table in a document?

g)  How will you insert a table in a slide?

h)  Write a short note on ‘Formatting a Table’.

1)  How will you change the chart type?

7)) What are the steeps you should follow to change the background of a chart?

Objective Type Questions-

a)  Chart represent data in linear form. (True/False)

b)  Chart tools tab is divided into one section. (True/False)

c) Textbox command is used to create additional text placeholder on a slide. (True/False)

d)  Tables are generally used to organised text on numerical data. (True/False)

e) A pie chart is used to show the trend of data over a period of time in effective way.
(True/False)

f)  Clipart is a collection of presentation files. (True/False)

g) A table is information arranged in ............... rowsand ................ columns.
h)  Shading option is available inthe ...................... group.
1) option is used to change the border color of rows or columns.
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1 To change the background, clickon ............................ tab.
k) A chart is used to show the percentage value data.
1)  Picture optionisin ...................... option.

Answer (Objective Type Question)-

[a] False [b] False [c] True [d] True [e] False
[f]False [g] horizontal, vertical [h] Table Style [i] Pen Color
[j] plotarea  [k] pie [1] insert
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UNIT- 11
FUNDAMENTALS OF INTERNET- I

11.1 INTRODUCTION
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11.4 APPLICATIONS OF INTERNET
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11.8 SEARCH ENGINE
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11.1 INTRODUCTION

In today’s world we do most of our work online, for example, booking of bus, railway, and

flight tickets, depositing electricity, water, mobile bill, etc. Government is trying to provide all
their services online so that individuals can get their work done from any place and at any time.
This is all possible just because of internet. Internet has changed the way people live their life.
WhatsApp and Facebook are an essential part of people’s life. People share information from
one corner of the world to another corner of the world within seconds. Today, we see the world
as a global village internet is behind all these services. Thus, its really important for students
to understand the basics of internet. Hopefully, this information will be quite helpful for them
to go for further details in this field.

11.2 OBJECTIVES
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After the successful completion of this unit, you will be able to-
) Define internet.

° Elaborate on various applications of the internet.

° Explain basic terms related to the internet.

° Describe the meaning of the URL.

) Elaborate the working of search engines.

° Explain the usage of the internet in education.

11.3 CONCEPT OF INTERNET

In simple words, we can define internet as a way of connecting any number of computers

situated at any place in the world. In other words, it is a global network of computers all over
the world. Internet is a global network of a number of private, public, business, academic,
government, and other networks connected by various technologies. Internet can be used to
send and receive different kinds of information such as text, graphics, voice, video, etc.
Different users may have different platforms, and other issues related to intersystem
communication in the internet. Thus, Transmission control protocol/Internet protocols
(TCP/IP) are used to define the rules for communication on the internet so that these issues can
be resolved. We need access to the internet service provider (ISP) to connect to internet. ISP

works as a mediator between a user and the internet.

11.4 APPLICATIONS OF INTERNET

There are various applications of internet. It is the most useful technology of modern life which

helps us not only in our daily life but also in personal and professional life. Some important

applications of the Internet are as follows:
[1] E-Mail

Electronic mail (e-mail) is one of the important and frequently used applications of the internet.
This provides a way of communication and sharing of information. With e-mail, one can send
and receive information instantly. There are numbers of internet service providers that offer
the service further nowadays there are many physical devices that support e-mail like mobile

phones.
[2] Web browsing

Web browsing is another important application of internet. It is a software application used to
access information on the World Wide Web. A browser is used to display the information
contained in a website. Google Chrome, Firefox, Internet Explorer, etc are some examples of
web browsers. Google Chrome is the most popular browser.

[3] Education
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Internet is one of the main sources of getting information about a topic. Thus, it is quite useful
for students, teachers, and researchers. Nowadays, online education has grown rapidly many
are providing education through online video lectures and earning as well. Massive online open
courses (MOOCs) have opened a new way of education worldwide. There are a number of
courses of different subjects available through MOOCs. A student can do a course of any

university from any place along with his usual work.
[4] Video Conferencing

Internet is also used for video conferencing. Whenever it is not possible to arrange a physical
meeting in one place due to shortage of time, video conferencing is the best alternative. Many
government and private sectors are using internet for video conferencing for their day to day

work. It is a brilliant way of saving time and money.
[S] E Commerce

Internet has become a major platform for conducting commercial activities. Nowadays, most
of the big companies rely on online business. With the help of internet anyone can shop online.

Online stores and sites are used to purchase all the needed products.
[6] Entertainment

Internet has changed dramatically the scenario of entertainment methods. There are many
videos and movies available in the web. Internet provides the facility to access wide range of
audio and video songs, movies, and other television programs. Many websites provide the
facility to upload videos. YouTube is the leading website for such purposes. Now, people are
making entertainment videos and uploading them into the web. This becomes a means of

earning as well.
[7] Communities

Social media allows people across the world to connect with each other via internet. A person
can share text, photos, videos, etc through social media and may connect with the people sitting
at any place in the world. Social media has a great impact on people’s life. Social media has
the power of campaigning in favour or against any particular thing, thus this application of

internet should be used carefully.
[8] Services

We use internet for many services like banking, online submission of bills, online purchasing
tickets of train, aeroplane, movie and hotel reservation, etc. Thus, internet has made these tasks

time and money-saving.

11.5 CONNECTING TO THE INTERNET
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There are many ways to connect to the internet. They all use different hardware and each has
a different range of connection speed. As technology changes, faster internet connections are

needed to handle things, following are some main services to connect to the internet:
[1] Dial Up

This is low-cost but the slowest type of internet connection. A modem is required to connect
to the internet for this type of connection. It requires a wired phone line to make internet
connection. The phone lines regularly experience disturbance which affects the speed of the
internet due to poor connection. In this connection, one cannot use land line phone and internet

service simultaneously.
[2] Digital subscriber line (DSL)

The digital subscriber line uses a broadband connection, thus, it is faster than dial up
connections. It uses two lines one for internet and one for phone calls as a result both using
internet and making calls can be done simultaneously. The speed of connection depends on the

service offered.
[3] Cable

Cable service provides an internet connection through cable TV lines. The speed of internet
connection may be different for upload or download transmission of data. It may have a faster

connection in comparison to dial up and DSL services.
[4] Wireless

Wireless or Wi-Fi uses radio frequency and it does not require use telephone lines or cables for
connection to the internet. Through a wireless network, internet can be accessed at any point

within the coverage of the network. Thus, there is no need to fix at a point to access internet.
[5] Satellite

Satellite internet connection uses satellites that are moving and working in the orbit of the earth.
Thus, in this type of connection we need not cable or phone line. It can be used anywhere in
the world. However, weather may play some role in the connection. In general, this type of

connection is slow in comparison to DSL or cable.
[6] Cellular

These services are used with mobile phones. It provides a wireless internet connection. The
speed of the connection may vary and depends on the service provider. The most common are

3G (3rd generation cellular network) and 4G (4th generation cellular network).

11.6 BASICS OF COMPUTER NETWORKS

A computer network is a set of computers connected to each other in different ways.

Connections may be through wires, optical fibers, wireless etc. The purpose of a computer
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network is to make interaction possible among different computers. When we interact or
communicate, we share information. We frequently use the term ‘data’, which refers to the
information shared and it may be in any form as decided by the communicator. Data may be a
piece of text, numbers, images, audio, or video. First, we understand data communication
which has five components: message, sender, receiver, transmission medium, and protocol. We

can understand these in simple words as follows:

Message is the data communicated between two devices.

Sender is the device sending the data.

Receiver is the device receiving the data.

Transmission medium is the physical medium over which the data travels.

Protocols are a set of rules to make communication possible.
Modes of data communication-

Now, we discuss the different modes of data communication. There are three modes of data

communication: simplex, half-duplex, and full-duplex.
Simplex

In simplex mode, the communication takes place in one direction only. If the communication
is taking place between A and B, then only one can transmit the information and the other can
receive the information, i.e., if A transmits the information then B receives the information.

We can say that, it is a unidirectional mode.

A T — B

Figure 11.1 Simplex Mode of Communication.

Half-duplex-

In half-duplex mode, both the devices can transmit as well as receive the information but at a
time, communication will take place in one direction only, i.e., A and B both can transmit and
receive the information but at a time. Either A can transmit information to B or B can transmit

information to A only. We can say that, it is a restrictive bi-directional mode.

At time A ————— B

At time A [——— B

Figure 11.2 Half-duplex Mode of Communication.

Duplex or Full-duplex-
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In full-duplex mode, both the devices can simultaneously transmit and receive the information.

We can say that, it is bidirectional mode.

A ——— — B

Figure 11.3 Duplex or Full duplex Mode of Communication.

Physical Structure of network

Now, we discuss the physical structures of a network. In a network devices are connected
through links. Link is nothing but a medium of transferring data between devices. There are
two possible connections: point-to-point and multipoint.

Point-to-Point-

In a point-to-point connection, there is a dedicated link between two devices. The whole

capacity of the link is used to transmit data between the two devices.

A B

Figure 11.4 Point-to point connection.

Multipoint connection-

In a multipoint connection, two or more devices share a link. The capacity of the link is shared

by different devices.

C

Figure 11.5 Multipoint connection.
Topology of a network

The geometrical representation of the links and their relationship is known as the topology of
a network. To discuss the topology of a network, we can assume a device as a vertex (nodes)

and a link as an edge between to vertices. There are four basic topologies:

Mesh Topology- In a mesh topology, there is a point to point link between every two devices.
If there are n nodes in the network, every node will be joined through every other n — 1 node.

Thus, there will be n(n — 1) links. In this number, every link is counted twice as a link between
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A and B is the same as the link between B and A, thus there will be @ links. For example,

mesh topologies of three and four nodes are given in the following figures:
Figure 11.6 Mesh topology.
Star Topology-
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In a star topology, there is a central device and all other devices have a point to point link to

the central device. The central device is usually known as a hub and will be discussed later on.
In a star topology two devices cannot make communication directly but through a central

device.
Figure 11.7 Star topology.
Bus Topology-

In a bus topology, all the devices are connected through a cable and this cable act as a backbone
to all the links.

1 L1 C1 [

Figure 11.8 Bus topology.

Ring Topology-

In a ring topology, devices are connected in a ring, i.e., each device has a point to point
connection to two devices only, one in one side of it and second on the other side of it.

( )
L J

Figure 11.9 Ring topology.

Note- A hybrid topology can be formed by using one or two above topologies.
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Components of Computer Network

Here, we discuss the different components of a computer network. Before describing the

different components, the various major components can be seen in the Figure 11.10, as-

National
Interface Card

Components of
Computer network

N

Figure 11.10 Components of Computer Networks.
Network interface card (NIC)-

Network interface card is a device that helps the computers to communicate with each other. It
contains the hardware address which is used by the data-link layer protocol to identify the
system on the network so that the data can be transferred to the correct destination. NIC has
two types; wireless NIC and wired NIC. In a wireless NIC, connection is made using an antenna
and the radio wave technology. Wireless NIC is used in all modern laptops. In wired NIC cables

are used to transfer the data over the medium.
Hub-

A Hub is a device used to divide a network connection among multiple computers. A request
from a computer in the network first goes to the hub through cable and then the hub broadcasts
this request to the entire network. The request is checked by all the computers in the network
for the belongingness of the request with them. The request is dropped in case it does not belong

to any computer.
Switches-

A switch is an advanced version of a hub. In place of broadcasting the message to the entire
network like a hub, it contains an updated table to decide the destination of the data. Using the
information from the table, a direct connection between the source and destination is created.
This helps to increase the speed of the network. A switch works as a controller. It connects

various devices like, computers, printers to a network in a premise.
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Routers-

A router is a device that can connect multiple networks. It is used to forward data packets
among multiple networks. It regenerates the signals it receives, checks the physical addresses
of the source and destination and forwards the signal to its destination through the best possible

route.
Modem-

A modem is known as a modulator/ demodulator. It converts the digital data into an analog
signal and vice versa. It is used to make a connection between the computer and the internet

over the telephone lines.
Cables-

Cables are used for transmitting a signal. Cables work as a carrier to interconnect computers in

a network.

11.7 UNDERSTANDING URL

URL stands for ‘Uniform Resource Locator’. It is the address of a document on the web and it

is unique for every document. A URL has several parts; each part provides some information
to the web browser that helps to find the page. Look at the following address-

http://www.uou.ac.in/school/school-computer-sciences-information-technology

We can break the address into three parts- (i) http:// (i1) www.uou.ac.in (iii) /school/ school-

computer-sciences-information-technology.
The scheme

The first part of the URL is ‘http://°. This string is the scheme that identifies the protocol to be
used to access the page on the Internet. The most commonly used protocols are http (Hyper
Text Transfer Protocol) and https (Secure Hyper Text Transfer Protocol). Sometimes ftp (to
handle a basic file transfer) and mail to (to open a mail client) are also used. After the string,
colon ‘:’ is used as URL scheme separator and the paired slashes ‘//* indicates the beginning
of the local hostname.

Domain name

The second part is ‘www.uou.ac.in’. It identifies the hostname where the resource is located.
We can further categorise it into three parts, (i) www (ii) uou (iii) ac.in. The first part ‘www’
is the sub-domain that defines the hosts; here it is World Wide Web. It may be changed like
support.uou.ac.in to access the internal support page of the website. The second part is the
address of the web server that serves the website. The third part gives the general information
about the website, for example ‘.gov’ shows a government website, ‘.ac’ shows website related
to academics etc. The extension ‘.in” shows the region, here it is for India. The domain name
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is basically an IP address of the web server but as it is not easy to remember an IP address, a

simple text is used.
File-path

The third part is the path of the page that needs to be loaded. If we do not use the file path, then

the home page will be loaded from where we navigate for the required page.

11.8 SEARCH ENGINE

A web search engine is software designed to carry out web search on the internet to provide a

user the relevant information in response to his query. A search engine extracts requested
information from the huge database web pages available on the internet. The search is based
on matching the user’s query with the available pages. There is a mathematical procedure for
matching the query with the documents available on the internet. After matching the
documents, search engines return a list of documents in descending order of their matching
score. Nowadays, there are many different search engines available on the internet, with each
search engine having its own ability and feature. Google is the most popular search engine.
Some other search engines are Bing, Yahoo, Ask, etc. Let us understand the architecture of a

web search engine. It has the following modules:
[1] Crawler Module

In the World Wide Web, web pages are stored in a decentralized way in computers across the
world. Thus, a search engine has to collect information from these documents. This task is
performed by the crawler module. This module consists of a specialized computer program that
runs uninterruptedly. Virtual robots, we call them spiders walk through the web, visit pages on

the web, download them, and send them to repository.
[2] Repository

Repository indicates the computer disks on the computers of the company that runs a search
engine. Repository stores the web pages downloaded by the spider. The pages stored in the

repository are sent to the indexing module for further processing.
[3] Indexing Module

The indexing module consists of a computer program to extract important information from
the web pages. The basic work of this module is to prepare a compressed representation (index)

of the web pages stored in the repository.
[4] Query Module

The query module reads the query written by a user. It analyses and converts it into a specific
format so that it can be matched with index to find the related web pages. The retrieved web

pages are then sent to the ranking module.
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[5] Ranking Module

Ranking module provides ranking a similarity score to the web pages sent by query module
and sort them in descending order of their ranking (highest ranking to lowest ranking). The list
known as the hit list is returned to the user against his query on the computer screen that
contains the URLs together with the excerpt from the pages called a snippet. The similarity

score is based on some mathematical concepts and web-specific factors.

11.9 INTERNET AS AN EDUCATIONAL TOOL

Internet has a tremendous power to disseminate information worldwide within a short period.

Thus, it has emerged as an important tool for education. For every level of education whether
child education, school level, or college level, internet plays a vital role. For you any query,
you can ask to Google search engine, you get some answer to your query. Children can easily
learn their subjects by visualizing it. With the incorporation of the visualization effect learning
becomes more effective. There are many websites available that assist in learning particularly

for children.

In remote areas where faculty members are not available for students, internet is like a gift to
the education system that can be used to fill the gaps between the knowledge seekers and
providers. Nowadays, video lectures of renowned professors in almost every field are available
on the internet. A person sitting in one corner of the world can watch and learn from another
sitting in another corner of the world. A number of lectures for a single topic by different
experts are available on the internet that provides us the freedom of choosing the best lecture.
Massive online open courses (MOOCs) are growing rapidly worldwide. One can learn and earn
a certificate or degree from home by choosing a MOOC. There are different platforms that are
providing MOOC:s, like SWYAM, NPTEL, COURSERA, etc. MOOC:s are not only useful for
students but also for persons those who are in jobs and wish to enhance their carrier in a

particular field. We can summarize the advantages of online education as follows:
[1] Access to cost-effective education

Due to the availability of online courses, students can get a certificate from a reputed institution

with minimum cost that has made education accessible to everyone.
[2] Effective teaching and learning

Due to the advancement of technology, a lecture can be made very effective by introducing
audio, video, and other advance tools.

[3] Updated information

With the help of internet, one can get the latest information on any field as internet is the major

source of information, and every minute huge data is uploaded to the internet.

[4] Learning freedom
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The most important thing about online education is the freedom of learning. One can choose
one’s own time and place to study the online material. Whether you are working, non-working,

or you have any profession, you can manage your own time to complete a course.

11.10 POINTS TO REMEMBER

° We have learned the basic concepts of internet and its applications to various fields.

° We knew the various services to connect internet and basics terms of a computer network.
e  We also learned the meaning of different parts of URL.

e  We got the knowledge of the working of search engines

° We saw that Internet is a powerful tool for education as well.

11.11 GLOSSARY

° MOOC- Massive online open courses.

e  URL- Uniform Resource Locator.

° NIC- Network interface card.

° 4G- 4thh generation cellular network.
e  DSL- Digital subscriber line.

) TCP/IP- Transmission control protocol/Internet protocol.

11.12 CHECK YOUR PROGRESS

Descriptive type questions-

a)  Explain the concept of internet. Describe various applications of internet.

b)  Describe various services that are used to connect to the internet.

c)  Describe various modes of data communication.

d)  Describe the meaning of the physical structure of a network.

e)  What do you mean by the topology of a network? Discuss various network topologies.
f)  Describe various components of a computer network.

g)  Explain the meaning of URL.

h)  What do you mean by search engines? Explain its various modules.

1)  Discuss the usage of internet in education.

Objective type questions-

a) Internet is a global network of computers. (True/False)
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b)  Commercial activities are not possible through internet. (True/False)

¢) A modem is required to connect to the internet for the dial up connection. (True/False)
d) In DSL use of internet and making calls, cannot be done simultaneously. (True/False)
e)  Wi-Fi uses radio frequency. (True/False)

f)  In simplex-mode the communication takes place in one direction only. (True/False)

g) In full-duplex mode both the devices can simultaneously transmit and receive the
information. (True/False)

h) In a star topology with n points, there will be (n(n-1))/2 links. (True/False)

1)  In a ring topology, each device has a point to point connection to two devices only.
(True/False)

j)  Hub is a device used to divide a network connection among multiple computers.
(True/False)

k) A router converts the digital data into an analog signal and vice versa. (True/False)
1)  In URL the string ‘https’ represents secure hypertext transfer protocol. (True/False)
m) The work of Crawler is matching a page on the internet with the query. (True/False)
n)  MOOC: stand for massive open organised courses. (True/False)

Answer (Objective type questions)-

[a] True [b] False [c] True [d] False [e] True [f] True

[g] True [h] False [1] True [j] True [k] False [1] True

[m] False [n] False
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12.1 INTRODUCTION

The role of Internet in education is of prime importance. The internet-based services in
teaching-learning are the essential tools of all of us. Such services are the need of modern era/
automation which makes our task efficiently in terms of time, effort, cost and quality of service.
Internet oriented services in education helps to reduce the movement of hard copy papers
within an organization and integrate various, seemingly unrelated, activities within an
organization. The aspirants/user can access learning applications, and the office
applications/services using Internet. Several benefits of such tools are envisioned due to the
easy access of Internet, such as- Searching files, quick information flow, availability of online

learning material, enhance transparency, increase accountability, etc.

Unit 12: Fundamentals of Internet- Il Page 161 of 249



CVDMM- 302: ICT Resources and Applications uou

12.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

° Understand the role of Google applications in teaching-learning.
° Know about advanced tools on Google like Docs, Sheets, and Slides etc.
° Best practices of using Google Drive tools and applications.

12.3 GOOGLE SHEETS- AN OVERVIEW

Google Sheets is a web-based spreadsheet application that allows you to store and organize

different types of information, much like Microsoft (MS) Excel. Howerever Google Sheets
does not offer all the advanced features of MS Excel. It is easy to create and edit spreadsheets
online with a variety of tasks ranging from the simple to the complex. Basically, spreadsheets
are used by to process complicated numbers and data, they can actually be used for a variety
of everyday tasks, such as- data storage in tabular form, budget planning, creating an invoice
or just about anything else you can think of. Spreadsheets are a great way to organize and

process information.

Google Sheets is a web-based spreadsheet that you can use anywhere with Internet connection.
It works from any device, with mobile apps for iOS and Android along with its web-based core
app. Google Sheets is free, and it's bundled with Google Drive, Docs, and Slides to share files,
documents, and presentations online anywhere. It includes almost all of the same spreadsheet
functions. If you know how to use MS Excel, you will feel at home in Google Sheets. For

advanced features you can download add-ons, create your own, and write custom code.

= a Sheets Q  Search

A

Start a new spreadsheet Template gallery {

Blank To-do list Annual budget Monthly budget

Earlier Owned by anyone v Lastopenedbyme  HH A:Z 0O

Figure 12.1 Google Sheet home
12.4 STEPS TO USE GOOGLE SHEETS

Create or import files to Google Sheets-
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Choose any option from the below to create a new file, as- (i) type

"http://spreadsheet.google.com” into browser's address bar; (ii) either click on the spread sheet

Gmail Images = s:% ‘
E & &

icon (refer to the figure 12.2)

Calendar Translate Photos
Duo Shopping
B /B )
Docs Sheets Slides
E O O
Books Blogger Hangouts

) " 22 |
Figure 12.2 Open Google Spread Sheet Using Icon

Create new file-

After opening Google sheet, you can create a new file; and also can select several templates,
as- to-do-list, annual budget, and monthly budget (refer to figure 12.3).

Unit 12: Fundamentals of Internet- Il Page 163 of 249



CVDMM- 302: ICT Resources and Applications uou

= E Sheets Q  search
Start a new spreadsheet Template gallery £
I" il
Blank To-do list Annual budget Monthly budget
Recent spreadsheets Owned by anyone v B Az O

Figure 12.3 Create new file

Import and convert existing files in to google sheet

If you have existing files, you can import and convert them to google sheets. Following are the
steps to import a file. as-

Step 1- Go to Google Drive.

Step 2- Click on new and then File Upload.

Step 3- Choose the file you want to import from your computer to add it to Google Drive.
Step 4- In the Upload complete window, click the show file location.

Step 5- Right-click the file and select Open with Google Docs (Sheets).

Untitled spreadsheet  ¥¢ Google Sheet Home =
File Edit View Insert Format Data Tools Add-ons Help
~ o~ @ T O100% v § % .0 .00 123 Defalt(Ai. v~ 10 ~ B I S A <& H ~
Al
A B c D E F G H
1
-
3
5
6
7
8
9
10
11
J2
13
+ = Sheet1 ~ (+]

Figure 12.4 Google Sheet Interface (home)

You can do the following tasks on the google sheets (only few are listed here)-
e  Access stored Google Drive files offline.
° Get instant insights into your data

° Insert and edit and summarize your data with charts.
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Filter your data in a spreadsheet.
Protect content in a spreadsheet

Share links of your file to others.

Transfer ownership of a file.

12.5 GOOGLE DOCS- AN OVERVIEW

Google Docs is a free Web-based application which offers word processing, spreadsheets,

presentations, forms, and drawings. Google Docs facilitates to create, edit and store docements
(files) online. Docements can be accessed from any computer with an Internet connection and
a full-featured Web browser.

Users of Google Docs can import, create, edit and update documents and spreadsheets in
various fonts and file formats, combining text with formulas, lists, tables and images. Google
Docs is compatible with most presentation software and word processor applications. Work
can be published as a Web page or as a print-ready manuscript. Users can control who sees
their work.

Google Docs provides an easy-to-use, integrated way for teachers and students to work together
on projects, reports, and more, and to collect and share information in a secure online
environment. Some of the advantages of using Google Docs include: (1) Anytime, anywhere

access (i1) Collaboration support (iii) Autosave and revision history; and many more.

12.6 STEPS TO USE GOOGLE DOCS
Step 1: Setting Google Account

For using Google Docs you have to setup a Google account (if you does not have one). It is
free to signup a Google Account, and with it you can access GMAIL, Maps, Youtube, as well

as GDrive.

To create a Google Account you can use (http://docs.google.com) this link. You will get the

screen as shown in Figure 12.5

Enter your information and follow the suggestion. After creating the Google Account login and

get access to google Drive screen.
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Google

Create your Google Account
First name Last name

Username @gmail.com

You can use letters, numbers & periods

Use my current email address instead

Password Confirm

Use 8 or more characters with a mix of letters, numbers &
symbols

[J show password

Sign in instead Next

English (United States) ~

® o

One account. All of Google

working for you.

Help

Privacy

Terms

Figure 12.5 Google Account Interface (home)

Step 2: Starting Google Docs

There are a different ways to get to Google Docs, contingent upon your gadget. You can

download the application from the App Store or Google Play, or click on the Google Apps

symbol in the upper-right corner of the Google landing page. You should then tap the Docs

button — you might need to look down inside the menu that pops-up or click More From

Google in that equivalent pop- up menu to see it.

Google

Google Search I'm Feeling Lucky

Watch the 2020 Presidential Debate. Tonight on YouTube at 9pm ET

o

Shopping

Books
Hangouts
i

Jamboard

o

Finance
- "
=

Blogger

o

Duo

Classroom

Docs

©

Contacts

Keep

Collections

Unit 12:

Figure 12.6 Google Docs Launching Dashboard
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Step 3: Creating a New Document

To make a new document,

Click the blank page with the multicolored Addition sign inside it, which is located on
the upper-left side of the main Google Docs page.

After that a blank page icon with the multicolored addition sign will pop up again at the
top of your screen. Click on that to open a new document.

= é Docs Q

Start a new documer

|_

Blank

Figure 12.7 Creating a new document

Step 4: Working on a new document

Once you’ve created a document, you can work on it.

Click Untitled Document in the upper-left corner to add a title to your document.

You can also adjust the font type, text size, and much more via the Toolbar at the top
of the page. If those options are hidden, click the downward-facing Arrow in the upper-

right corner to display them.

Any changes made to your file will be saved automatically to the Google cloud
platform. And you can access that file from any of your devices that has an internet

connection.

If you look to the right of your document’s title at the top of the screen, you should
either see Saving... or Saved to Drive. Wait for the second message to appear before
exiting out to ensure all your work has been saved.

You can also use shortcut keys to format your document

o Bold — Ctrl+B
o Italic — Ctrl+I
o Underline — Ctrl+U
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o Strikethrough — Alt+Shift+5
o Subscript — Ctrl+,
o Superscript — Ctrl+.

File Edit View Insert Format Tools Add-ons Helpl Laste 3,;,,\1',1-:,;';,1,:1':Jf;lii,i:I

E Untitled drur:umentl wEm e
L N |

& A, T 1005 - Normaltext ~  Arial ~ - 11 + B ZT UA » eoocFE-r = 3
S

1 v

dings you add to the document will

This is a test document. |

Figure 12.8 New document in Google Docs

12.7 GOOGLE SLIDES- AN OVERVIEW

Google Slides is a free program that is important for Google's set-up of electronic applications,
including Google Docs (word preparing), Sheets (bookkeeping pages), Slides (introductions)
and Forms (gathering and putting together data). What's especially amazing about Google
Slides is that you can make, alter, work together and present consistently across working
frameworks and without potential document similarity or debasement issues, overseeing streak
drives or sorting out connector links. Utilizing an online program likewise takes out the danger

of moving an infection.

It is likewise genuinely simple to move a show from PowerPoint to Google Slides and back
once more, however you might lose some designing simultaneously. In the event that you do
move a show, page through to ensure the slides actually look the manner in which you need
them to. In case you are utilized to PowerPoint and end up expecting to utilize Google Slides
(or the other way around), dread not! The orders and techniques are quite comparative among
them, and in the event that you stall out, there are heaps of acceptable online assets to address

your inquiries.

To feature a couple of key components and advantages:

Widespread access, from your telephone, tablet or PC
Backing for both Android and iPhone/iPad (Google Slides applications)

Offer your show with choices for to limit/empower seeing, remarking and altering

Auto-save
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12.8 STEPS TO USE GOOGLE SLIDES

Step 1 — Create a new presentation in Google Slides

) Login into your Google Account, head to Google Drive.
° There, make a Google show by clicking New > Google Slides > Blank Presentation.
° You'll be diverted to another page with a blank page(presentation)
L Drive Q  searchin Drive
2 > Tuts+ Stuff ~
9  Folder
Owner
@ File upload
[%] Folder upload me
me
Bl Google Docs »
Google Sheets 5 me
Google Slides > me
Blank presentation
More ? me
From a template
E S'torage . Tutwrran me
Figure 12.9 Creating new presentation in Google Slides
Step 2 — Creating new Slide
° If you are on the slides page, select an option from the top of the page to create a new
slide.
° You can press the white square with a plus sign for a blank slide, or click one of the
templates.
° Click on the Template Gallery option, where more templates will show up.
My First Presentation | 2 R
File Edit View Inset Slide Format Amange Tools Table Help [ Present ~  Comments
r\'\- Q ATMu@- \N- & A

| -

Click to add title

Click to add subtitle
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Figure 12.10 Adding new Slides

° Delete slides by selecting the slide and clicking Edit > Delete.
° Or right-click on the slide thumbnail in the sidebar and clicking Delete slide.
° Or simply press the Delete key while the slide is selected.

Step 3 — Formatting a Google Slides Presentation

The initial phase in making presentation is arranging what it looks like. In this way, we should
investigate the Themes sidebar that shows up after opening a new slide.

Google Slides comes preloaded with various themes for slides.

The Themes sidebar shows up on the right half of your new slide. Utilize that bar to travel

through the different themes accessible.

Untitled presentation =] B present ~ | OEIRGE
File Edit View Insert Format Slide Arange Tools Add-ons Help

F e ) Q- Kk [TIM-Q \ - El Bakgond Layout Theme Transition ~ Thevnas -

v

Click to add title

Simple Light

Click to add title e

Click to add subtitle

Simple Dark

Click to add title

Streamiine

Figure 12.11 Formatting in Google Slides

What are the things that we can do using Google Slides?

° Create and Present a Professional Presentation: Google Slides is the most ideal
decision for writing and putting across a presentation expertly. Alternatives accessible
with the moderator incorporate speaker notes and the choice by which one can set up
Q&A adjusts during the show.

° Share a Presentation Online: Google Slides can likewise be utilized to make a
slideshow show that can run consequently on the web at whatever point somebody
attempts to utilize it. Utilizing Google Slides, one can make a shareable connection to
the show so it very well may be utilized in online media. One can likewise make codes
that would permit one to insert their show into their own sites.

° Create a Timeline: One can make a timeline with Google Slides with the use of
drawing tools. However, if one selects the correct Google Slides Template, making

one’s timeline presentation would be an easy task.
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° Work as a Team: Google Slides very much like some other office usefulness apparatus
that G Suite offers has distinctive sharing choices like can alter, can see, can remark
access. This permits clients to adjust the substance of the presentation continuously
cooperation differently or prevent them from doing as such if the show maker doesn't

need others to affect the archive with a particular goal in mind.

12.9 GOOGLE DRIVE- AN OVERVIEW

Google Drive is a cloud-based capacity arrangement that permits you to save records on the

web and access them anyplace from any cell phone, tablet, or PC. You can utilize Drive on
your PC or cell phone to safely transfer records and alter them on the web. Drive likewise

makes it simple for others to alter and team up on records.

Google Drive also gives you access to free web-based applications for creating documents,

spreadsheets, presentations, and more.
Why use Google Drive?

Google Drive is perhaps the most well known cloud storage administrations accessible today.
On the off chance that you've never utilized a cloud-based capacity administration like Google
Drive previously, pause for a minute to consider the upsides of keeping your documents on the
web. Since records can be gotten to from any PC with an Internet association, Drive takes out
the need to email or save a document to a USB drive. Furthermore, in light of the fact that

Drive permits you to share records, working with others turns out to be a lot simpler.

12.10 STEPS TO USE GOOGLE DRIVE

For using Google Drive you have to login to your Google Account. (Google Account setup has
been discussed earlier in this UNIT).

Once you login to your google account you can use Google Drive option.

Google Drive doesn't simply store your records; it additionally permits you to make, share, and
oversee reports with its own efficiency applications. In the event that you've at any point
utilized a suite like Microsoft Office, a few things about Google Drive's applications may
appear to be natural. For example, the sorts of documents you can work with are like records
that can be made with different Microsoft Office programs.

Below are the types of files you can create and share on Google Drive:

° & Documents: For composing letters, flyers, essays, and other text-based files (similar
to Microsoft Word documents)

° Spreadsheets: For storing and organizing information (similar to Microsoft Excel
workbooks)

° Presentations: For creating slideshows (similar to Microsoft PowerPoint
presentations)
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) E Forms: For collecting and organizing data
° &3 Drawings: For creating simple vector graphics or diagrams

Accessing Google Drive

1. Whenever you've set up your Google account, you can get to Google Drive by going to

http://drive.google.com in your internet browser.

2. You can also navigate to Google Drive from any Google page (such as Gmail or Google

search) by selecting the grid icon near the top-right corner, then clicking Drive.
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Figure 12.12 GDRIVE Link in Google Account

Interface of Google Drive

Your Google Drive might be vacant at the present time, yet as you transfer and make records

you'll have to realize how to see, oversee, and sort out them in the interface.

You can use different facilities under GDrive by using (+/New) option under Drive logo in left

side.
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Figure 12.13 GDRIVE Interface

BRIEF INTRODUCTION TO DISCUSSION FORUM,
BLOGS AND NEWSGROUPS

Discussion Forum

12.11

A discussion forum is a website where people can gather to have discussions about a specific
topic. Electronic message boards for asynchronous communication, also commonly referred
to as Web forums, message boards, discussion boards, discussion groups and bulletin boards.
A program which permits individuals to have conversations on the web. The conversation is
begun by one part by posting a subject and different individuals answer. This permits
individuals from similar gathering to share data and thoughts.

It’s common for websites to add a discussion forum to their website for people to discuss the
product, service, or organization and even help each other. It reduces customer support

requests, is great for search engine optimization, and creates a sense of community.

Discussion Forums are maybe the most punctual type of web-based media stage. Early adopters
of Internet innovation might review news gatherings or particular vested parties (SIGs) that
were facilitated on the early sites and frameworks associated with the Internet. These people
group were established in specialized points however in the long run extended to cover pretty
much any classification that could draw in a group of people. These stages developed and are

currently facilitated on purchaser situated informal communication destinations.

Some of them are —

° Reddit

° Stack Overflow
) Quora

° Yahoo Groups

° Google Answers
Blogs

A blog is a sort of site that is refreshed routinely with new substance. Most sites contain short,
casual articles called blog entries. These posts ordinarily contain a blend of text, photographs,
recordings, and different media. At its center, a blog is only a space on the Web that you can
make to record and state your viewpoints, encounters, and interests. A larger part of websites
are composed by one individual. Thus, the normal blog is genuinely close to home, mirroring
the interests and character of the individual who composes it. This is the sort of blog we'll zero

in on in this instructional exercise.

Individuals who compose blogs are called bloggers. From what you hear on the news, you may
think bloggers are each of the a particular kind of individuals—youthful, politically slanted,

and educated. Or on the other hand possibly you've caught wind of bloggers who've expounded
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on stunning encounters or yearning projects, then, at that point transformed their web journals
into smash hit books. While a few bloggers do fit these portrayals, a greater part of bloggers
don't. Indeed, there's no "normal" blogger—web journals are composed by individuals, all

things considered, and foundations and from varying backgrounds.

There are many reasons why people blog, like:

) To share your experiences and expertise

) To speak up about an issue you care about

° To become more involved with hobbies and passions
° To be part of a community

° To advance your career or start a career in writing

° To keep family and friends updated about your life

Another explanation a few group blog is to bring in money. Individuals bring in cash from their
web journals by facilitating promotions, selling items, or distributing their blog entries as a

book or printed articles.

Some of the common features that a typical blog will include:

° Header with the menu or navigation bar.

° Main content area with highlighted or latest blog posts.

° Sidebar with social profiles, favorite content, or call-to-action.

° Footer with relevant links like a disclaimer, privacy policy, contact page, etc.
NewsGroups

A newsgroup is a storehouse of electronic messages posted by clients and oversaw by the
Usenet framework. This is an overall Internet conversation framework that is isolated from the
World Wide Web. Usenet was set up in 1980, somewhat more than 10 years before the making
of the World Wide Web. Newsgroups on Usenet were one of the main chances for general PC

clients to share and post data on the arising Internet.

Members in a newsgroup read and post messages to at least one classes. Usenet was made in
when the transfer speed of the Internet was exceptionally restricted, and newsgroups were
intended to be text as it were. All the more as of late, clients had the option to join pictures and

different records to postings, yet as a rule, newsgroups stay intensely text-based.

The protocol utilized by newsgroups is called Network News Transfer Protocol, or NNTP. This
is one of the numerous correspondence conventions utilized on the Internet, which additionally
incorporates the more notable HTTP convention utilized by the World Wide Web. The name
of a newsgroup is dictated by the individuals who make it. A name normally comprises of a
few words that portray the subject, isolated by a dot.

Some of the examples are-

° news.admin.net-abuse.email
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rec.arts.sf.tv.babylon5.moderated

talk.origins

Newsgroups are dissimilar from other communication methods that use the World Wide Web

in a number of ways:

No registration with a particular newsgroup is required
Stored information is distributed on a collection of computers instead of a central server
Archives are always available

Newsreader software is commonly used to read and post messages

12.12 POINTS TO REMEMBER

E-Office Suite is the need of modern office automation which makes our task efficiently

in terms of time, effort, cost and quality of service.

Google Docs facilitates to create, edit and store docements (files) online. Docements
can be accessed from any computer with an Internet connection and a full-featured Web
browser.

Google Drive is a cloud-based capacity arrangement that permits you to save records

on the web and access them anyplace from any cell phone, tablet, or PC

Google Sheets is a web-based spreadsheet application that allows you to store and

organize different types of information, much like Microsoft (MS) Excel.

A newsgroup is a storehouse of electronic messages posted by clients and oversaw by

the Usenet framework.

A blog is a sort of site that is refreshed routinely with new substance. Most sites contain
short, casual articles called blog entries.

A discussion forum is a website where people can gather to have discussions about a

specific topic.

12.13 GLOSSARY

Add Fonts - When you create a new document, Google Docs starts you off with nearly
two dozen native fonts you can choose from using the dropdown list on your top editing
toolbar.

Templates - A template is a pre-created document that already has some formatting
Create or Remove Header - Headers and footers are particularly useful when creating a
Google Doc that has many pages. You can create a header that includes the document

title, each page number, or both on every page all at once.

Classroom - Classroom is where your child can find their assignments, grades and
feedback, and communicate directly with their teacher
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° Forms - Forms are often used by teachers for creating quizzes, parent feedback surveys,
or even field trip forms.
° Drive - Drive is your child’s virtual backpack, where they can hold all of their

assignments, projects, and notes online

12.14 CHECK YOUR PROGRESS

Descriptive Type Questions-

1) How to get Google Account?

2) What are the different software tools available in Google Drive? Explain.
3) What are Google Docs?

4) What is a blogger? Explain.

5) Write the steps to use Google Slides?

Objective Type Questions-

a) If you already have a Google account, you can use the same account to access Google
Docs. (True/False)

b) You can insert automatic page numbers for your document in the header or footer.
(True/False)

) Google Docs do not allow you to insert or upload images. (True/False)

d) A Google doc is most similar to........ccccceeeveeveeneeniennns

e) Inserting a header at the top of a page will make it appear on............cccc....

Answer (Objective Type Question)-
[a] True [b] True

[c] False [d] Microsoft Word [e] Every page
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13.1 INTRODUCTION

Communication is a process of sharing the information and ideas from one place or person to

another. A network is required for proper communication. A network consists of multiple
devices that communicate with one another. A computer network is an interconnection of
computers and computer resources for sharing of data and resources. The devices connected in
the network are called nodes. Nodes may be a computer, printer, or any other device capable
of sending or receiving data. Computer networks can be classified on the basis of their size and
purpose. The computer networks are of three types Local Area Network (LAN), Metropolitan
Area Network (MAN), and Wide Area Network (WAN).

The Internet is the global ‘network of networks’ that connects millions of computers all over
the world. The computers and computer networks interchange information using TCP/IP
(Transmission Control Protocol/Internet Protocol). The computers are connected through the
telecommunication networks and Internet is used for various purposes like e-mailing, sharing
files and gathering information, etc over World Wide Web (WWW).
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13.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

° Define data communication and computer network.

e  Define the types of networks and their characteristics.
° Define the Internet and its services.

° Explain the concept of TCP/IP suite.

) Describe the OSI reference model.

13.3 COMPUTER NETWORKS

A computer network is a collection of several computers and other devices which are

interconnected in such a manner that allow easy exchange of data and resources. Main
objectives of the computer network are exchange of data or information, sharing software and

hardware resources like printer, and distribution of the processing load.
Advantages of a computer network-

The main advantages of a computer network are:

° Central storage of data: A computer network allows storing of data files in a central

computer of a network shared by all the nodes of a network.

° Resource Sharing: A computer Network enables us to share resources such as storage

space, processing units, and peripherals like printers, scanners fax, etc.

° Sharing of software: A user in a network can use the software installed in any of the

computer or file servers in the network.

° Communication: Different users connected through the network can communicate with

each other through voicemail, e-mail, messaging, video conferencing, etc.

° Electronic Commerce: Computer networking (Internet) provides the facility of electronic

commerce.
Types of networks

There are mainly three types of computer networks based on their size: (i) Local Area Network
(i1) Metropolitan Area Network, (iii) Wide area network (WAN).

[i] Local Area Network

A Local Area Network (LAN) is a group of computer and peripheral devices that are connected
in a small limited geographical area such as school, laboratory, home, and office building. A
LAN is used to connect computers and other network devices so that the devices can

communicate with each other to share the resources. The resources to be shared can be a
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hardware device like printer and software like an application program or data. The size of a
LAN is usually small. The various devices in LAN are connected to central devices called hub

or switch using a cable.
Characteristics of LAN:

° LAN is used for connecting two or more personal computers through a communication

medium such as twisted pair, coaxial cable, etc.

e Itis cheaper as it is built with inexpensive hardware such as hubs, network adapters, and
Ethernet cables.

° The resources to be shared can include hardware (e.g. printers), software (e.g. an

application program), or data.

° LAN enables the sharing of resources such as files or hardware devices needed by

multiple users.
° Is limited in size, typically spanning a few hundred meters, and no more than a mile.
e  LAN due to its small size is faster than the other networks.
° Local Area Network provides higher security.
° LAN can be either wired or wireless.

° Different devices (nodes) in a LAN can be connected with certain topologies like BUS,
RING and STAR.

[ii] Metropolitan Area Network

A metropolitan area network is designed to extend the network over an entire city.
Metropolitan area network (MAN) is a computer network that spans over larger geographical
region than LAN. It covers several buildings or an entire city. This network is used to share
regional resources among network users. It may be a single network such as a cable television
network or connecting a number of LANSs into a larger network so that resources are shared
from LAN-to-LAN as well as device-to-device.

Characteristics of MAN:

° MAN covers a larger geographical region than LAN usually covering a city or several

buildings.
° It is a high-speed network than WAN.
° Users can share regional resources through MAN.
° MAN normally covers an area ranging 5 to 50 km in diameter.

° Less expensive than WAN.

Unit 13: Layered Architecture of Internet and Protocols- | Page 179 of 249



CVDMM- 302: ICT Resources and Applications uou

° Composition of various small Local Area Networks.
[iii] Wide Area Network

Wide Area Network is the largest computer network that covers a large geographical area such
as different countries or even whole world. Generally, WAN is an interconnection of several
LANs and MANSs distributed all over the world. A WAN provides long-distance transmission
of data, voice, image, or other information over large geographical areas that may cover a
country. Several local networks can be connected using network devices like routers, gateways,
bridge, etc. to form a WAN. Computers are connected to a wide area network through leased

lines or satellites. Internet is the most popular wide area network.
Characteristics of WAN:

e A wide area network (WAN) is a computer network that spans over a wide geographical

region.
° WAN is an interconnection of several LANs and MANSs.

° The data through the WAN can be transmitted over high speed leased phone lines or

wireless links such as satellites.
° WAN provides various network services used by a variety of protocols.

° Through a wide area network, different computers are linked to a remote central database

managed by a system server.

13.4 HISTORY OF INTERNET

Internet is the interconnection of computer networks. It is a very large hardware combination

of millions of personal, business, and government computers. Internet is the major technical
infrastructure that allows millions of users throughout the world to get connected with people,

product, and services at various parts of the globe.
Evolution of Internet-

In the late 1960s, US department of Defence became interested in computer networking and
formed a research agency known as the Advanced Research Project Agency (ARPA) to
research on networking. ARPA projects included a wide area network called ARPANET- Ist
version of the internet. ARPANET was used to connect computer at different geographical

locations and move data among those locations.

Robert Kahn and Vinton Cerf in 1973, worked together to develop a protocol for connecting
several networks together. These protocols are Transmission Control Protocol/Internet
Protocol (TCP/IP). Over the next few years, Robert Metcalfe developed a system allowing data

transmission over a network through cables called Ethernet.
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In 1982, the first commercial network was developed and allowed for email communication.
In 1983, Domain name system was introduced to allow domain names to automatically assign
an [P number. In 1990s, the Hypertext Markup Language (HTML) and the Uniform Resource
Locator (URL) was developed by Tim Berners and his team.

13.5 THE OSI MODEL

The Open System Interconnection (OSI) model is a layered framework for the design of

network systems that allows for communication across all types of computer systems. This
model describes how information from a software application in one computer moves through
a physical medium to the software application in another computer. This model was introduced
by ISO (International Organization for Standardization). The OSI model includes seven

different layers and each layer performs a well-defined function.

APPLICATION LAYER
PRESENTATION LAYER
SESSION LAYER
TRANSPORT LAYER
NETWORK LAYER
DATA LINK LAYER

PHYSICAL LAYER
Figure 13.1 The OSI model.

[1] Physical Layer-

A physical interface between the network devices is provided by the physical layer. This layer
is responsible for transmitting row bit streams over a communication channel between two
nodes. It converts streams of binary bits into electrical or electromagnetic signals. Functions of
the physical layer are-

° Representation of bits
° Determine physical topology
° Physical characteristics of interface and transmission channel

° Transmission mode
[2] Data Link Layer-

The error-free communication path between nodes over the physical channel is established by
the data link layer i.e. the error detection and correction in the transmitted data is performed by
the data link layer. The data link layer splits the bit streams into data frames that are transmitted

sequentially. Functions of a data link layer are-

) Data framing

° Error control

Unit 13: Layered Architecture of Internet and Protocols- | Page 181 of 249



CVDMM- 302: ICT Resources and Applications uou

° Flow control
° Access control
) Physical addressing

[3] Network Layer-

A network layer builds the logical path between the source and the destination nodes of the
network. In the network layer first, the transmitted message is fragmented into packets. Then,
sequencing and error control of these packets is performed. Thus, the routing decisions are
taken at the network layer. The main network layer protocol is the Internet Protocol (IP).

Functions of a network layer are-

° Routing

° Translation of logical network address into a physical address
° Packet switching and sequence control

e  Network layer flow control

e  Network layer error control
[4] Transport Layer-

Once a path is established between the sending and receiving stations, the transport layer
provides control standards for a communication session for enabling processes to exchange
data reliably and sequentially. The transport layer accepts data from the above session layer,
splits it into smaller units, and pass the data units to the lower layer (network layer). Transport
layer protocols are Transport Control Protocol (TCP) and User Datagram Protocol (UDP).

Functions of the transport layer are-

o Service point addressing
° Segmentation and reassembly
o Connection control

° Flow and error control
[5] Session Layer-

A session between two end users is established, maintained and terminated by the session layer.
It manages and synchronizes the conversation between two different applications. Functions of

the session layer are-

) Dialog Control

° Synchronization
[6] Presentation Layer-

A presentation layer is responsible for converting the message data in a form easily recognized
by the receiver. For this, it may perform code conversion, compression & decompression,
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encryption & decryption on message data depending on the requirement of the applications.

Functions of the presentation layer are-

e  Data encoding and decoding
° Compression and decompression

° Encryption and decryption
[7] Application Layer-

Various network services that support the user of the network are provided by the application
layer. The most common services provided by this layer include e-mail, transfer of files,
directory services, remote login, network resources, etc. Some application layer protocols are
FTP (File Transfer Protocol), HTTP (Hypertext Transfer Protocol), SMTP (Simple Mail
Transfer Protocol), TELNET, etc. Functions of the application layer are-

° File transfer
° Mailing service
e  Directory service

° Remote login

13.6 TCP/IP PROTOCOL SUITE

Network protocols are the set of rules, procedures, and standards to determine the way systems

communicate and data is transferred from one system to another. The collection of protocols

~,

APPLICATION
LAYER

TRANSPORT
LAYER TCP UDP

NETWORK

LAYER ICMP IGMP -

DATALINK| ™ J
LAYER

HTTP SMTP FTP SNMP

sEssEEAEIERS

N
b

-
A

NETWORK ACCESS LAYER
PHYSICAL N—

LAYER

that are designed to work together is called a protocol suite. The TCP/IP is a protocol model
defined with four layers. Each layer of the TCP/IP suite contains relatively independent

protocols.
Figure 13.2 The TCP/IP Suite

[1] Network Access Layer (Physical and Data Link Layers)-
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This is the lowest layer of the TCP/IP model. The physical and data link layers together is
called network access layer in TCP/IP suite. This layer is responsible to determine the
transmission of data between the two devices on the same network. This layer receives the data
packets from the network layer (Internet Layer) and sends it to the destination over a physical

media.
[2] Network Layer (Internet Layer)-

Internet or Network layer form the data packets called IP datagrams that include source and

destination address (IP address). Network layer protocols are:

° Internet Protocol (IP) - IP defines the host’s logical address called IP address. This
address is used by the network to identify the device. This protocol is responsible to route
the data packet to its respective destination.

° Address Resolution Protocol (ARP) - This protocol links logical address (IP address) to
physical address.

° Internet Control Message Protocol (ICMP) - ICMP is used to send notification of
datagram problems back to the sender. It is responsible to send the query and error
reporting messages.

° Internet Group Message Protocol (IGMP) - IGMP is a group management protocol that

manages group membership in a multicast network.
[3] Transport Layer-

The transport layer is responsible to form end-to-end connections between the source and the
destination. The protocols of the transport layer are:

° Transmission Control Protocol (TCP) - TCP is a connection based and reliable protocol.
It provides full transport layer services to the application. It provides host-to-host
communication.

° User Datagram Protocol (UDP) - UDP is a connectionless unreliable protocol. It provides

the procedure to process communication.
[4] Application Layer

In a TCP/IP model the application layer is equivalent to the combinations of session,
presentation and application layers of the OSI model. It performs all the responsibilities of

sessions, presentation, and application layers. The main protocols of the application layer are:

° Hypertext Transfer Protocol (HTTP) - It is a communication protocol that is used to
transmit the contents of web pages called hypertext from web servers to web browsers.

° Simple Mail Transfer Protocol (SMTP) - It is a communication protocol for electronic
mail. SMTP is used to send messages from one server to another.

° Domain Name System (DNS) - The main function of DNS is to translate the domain

names into IP addresses on the internet.

Unit 13: Layered Architecture of Internet and Protocols- | Page 184 of 249



CVDMM- 302: ICT Resources and Applications uou

File Transfer Protocol (FTP) - FTP allows the users to move files from one computer to
another on the internet. FTP provides the facility of uploading and downloading.
Terminal Network (TELNET) - Telnet service allows the user to log in to a remote

computer from a local machine on the internet.

13.7 POINTS TO REMEMBER

Data communication is the process of transferring data and information from one
computer to another.

The main components of a communication system are the source, medium, and receiver.
A computer network is a collection of computers and other devices which are linked
together for data communication.

The main objective of a computer network is sharing of information, resources, and
distribution of the processing load.

Networks are of three types: Local Area Network (LAN), Metropolitan Area Network
(MAN) and Wide Area Network (WAN)

LAN is a computer network within a campus, building, and group of buildings in a
limited geographical area.

A metropolitan area network (MAN) is similar to a local area network (LAN) but spans
an entire city or campus. MANSs are formed by connecting multiple LANSs.

A wide area network (WAN) is a computer network spanning over states, countries, or
all over the world.

The arrangement of computers and other devices in a network is called topology.

Some common network topologies are BUS, STAR, RING, MESH, TREE, etc.

Internet is an interconnected network of computers and other resources all over the world.
It is a collection of many separate networks.

Internet has its root in the US army. Internet started in 1960s, under the original name
ARPA (Advances Research Project Agency).

In 1973, Robert Kahn and Vinton Cerf developed Transmission Control Protocol/Internet
Protocol (TCP/IP) for connecting several networks together.

In 1990s the Hypertext Markup Language (HTML) and the Uniform Resource Locator
(URL) was developed by Tim Berners and his team.

The Open System Interconnection (OSI) model provides a standard for layered protocols
for a computer network. This model is created by the International Standards
Organization (IOS).

The seven layers of OSI model are physical, data link, network, transport, session,
presentation, and application. Each layer has some specific functionality.

The bottom three layers of OSI model (physical, data link, and network) are network
support layers.
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The top three layers of OSI model (session, presentation, and application) are the user
support layers.

The network support layers and user support layers are linked by the transport layer.
The physical layer is responsible for the movement of individual bits from one node to
the other.

The data link layer splits the bits stream received from the network layer into data units
called frames and responsible for moving these frames from one node to the next without
error.

The network layer is responsible for the delivery of individual packets from source host
to the destination host.

The main function of the transport layer is the delivery of the message from process to
process.

The session layer establishes, maintains, and synchronizes the interactions between
communicating devices. It allows a process to add checkpoints.

The main functions of the presentation layer are data translation, compression, and
encryption.

The application layer enables users to access the network. It provides network services
such as e-mail, file transfer, remote login, etc.

TCP/IP reference model is a four layered protocol suite developed by the department of
US defence in 1960s.

The four layers of TCP/IP model are the Host-to-Network layer, Internet/Network layer,
Transport layer, and Application layer.

The lowest layer of TCP/IP is the Host-to-Network layer which combined the physical
and data link layers of the OSI model. This layer is concerned with the physical
transmission of data.

Internet or Network layer defines protocols for logical transmission of data. Internet
Protocol (IP) is the main protocol in this layer.

Transport layer defines Transport Control Protocol (TCP) and User Datagram Protocol
(UDP) for end-to-end error free delivery of data.

The application layer in a TCP/IP model combines the functionalities of the session,
presentation, and application layers of the OSI model. This layer includes several
protocols like HTTP, FTP, SMTP, TELNET, etc to allow access to network resources

and services.

13.8 GLOSSARY

Peripheral Devices- Peripheral devices are the internal or external devices that connect
to the computer to perform computer’s primary functions such as input, output, and
storage. Some common peripheral devices are keyboard, mouse, printer, CD-ROM and
DVD drives, flash memory drives, etc.
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Electronic Commerce- Electronic commerce or E-commerce is defined as the trading of
goods, services, information, or anything else of value between two entities over the

internet.

Topology- The physical and logical arrangement of computers and other resources in the
network is called a network topology. Some basic topologies are bus, ring, star, tree,

mesh, etc.

Uniform Resource Locator (URL) - A URL is the address of a specific webpage or file
on the internet. It is a reference to a web resource that specifies its location on the

computer network. An example of URL is https://www.Myweb.com

Data Transmission Modes- The direction of the flow of information between two
communicating devices can be determined by the data transmission modes. Data
transmission modes are simplex, half-duplex and full-duplex. In simplex mode, data can
flow only in one direction. In half-duplex mode, data can flow in both directions but in
one direction at a time. In full-duplex mode, data can flow in both the directions at the

same time.

Synchronization- To transmit a long file, the session layer allows a process to add
checkpoints. So, if a crash encounters during data transmission, the transmission of the

file resets from the last checkpoint. This process is called data synchronization.

Encryption and Decryption- The network layer adopts a privacy policy to transmit
sensitive information. Encryption is the process of converting the original message in
some other meaningless form called ciphertext. Decryption is the process of converting
the meaningless message (ciphertext) into its original form at the receiver end.

Data Compression- Compression is the process of reducing the number of bits contained

in the message to be transmitted.

13.9 CHECK YOUR PROGRESS

Objective type questions-

a)
b)
c)
d)
e)
f)
g)

An interconnected network of networks is known as..... ..... .....

IP stands for ..... ..... .....

A is a collection of local area networks within a city.

The internet is an example of a ..... ..... ..... network.

............... layer of TCP/IP model deals with TCP and UDP protocols.
A single computer on a network is known as a ..... ..... .....

Bits are packaged into frames at ..... ..... ..... layer of OSI model.
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h)  The physical layer is concerned with the movement of ..... ..... ..... over the physical
medium.
1)  The............... layer of OSI model is responsible for encryption and decryption.

1) ARPA stands for ..... ..... .....

Descriptive type questions-

a)  What is a computer network? Describe the types of computer networks?
b)  Explain the brief history of Internet?

c) Describe the OSI model with the functionality of each layer?

d)  List the services of internet?

e)  What protocols are parts of different layers of TCP/IP suite?

Answer (Objective type questions)-

[a] Internet  [b] Internet Protocol [c] MAN [d] Wide Area [e] Transport
[f] Node [g] Data Link [h] Bits [i] Presentation

[j] Advanced Research Project Agency
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14.1 INTRODUCTION

A computer network must provide general, cost-effective, fair, and robust connectivity among

a large number of computers. As if this weren't enough, networks do not remain fixed at any
single point in time but must evolve to accommodate changes in both the underlying
technologies upon which they are based as well as changes in the demands placed on them by
application programs. Furthermore, networks must be manageable by humans of varying levels
of skill. Designing a network to meet these requirements is not a small task. To help deal with

this complexity, network designers have developed general blueprints, usually called network
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architectures. The network architecture guides to the design and implementation of networks.
[1]

In case of network systems layering approach is followed where start with the services offered
by the underlying hardware and then add a sequence of layers, each providing a higher (more
abstract) level of service. The services provided at the upper layers are implemented in terms

of the services provided by the low layers. [1]

The International Standard Organization (ISO) was one of the first organization to formally
define a common way to connect computers. Their architecture, called the Open Systems
Interconnection (OSI) architecture which defines a partitioning of network functionality into
seven layers, where one or more protocols implement the functionality assigned to a given

layer. It is often referred to as the 7-layer model or OSI model by ISO. [1]

Sender- A Receiver- B

Layer 7 Application Layer Layer 7 Application Layer
Layer 6 Presentation Layer Layer 6 Presentation Layer
Layer 5§ Session Layer Layer 5 Session Layer
Layer4 Transport Layer Layer4 Transport Layer
Layer3  Network Layer Layer3 Network Layer
Layer2 Data Link Layer Layer2 Data Link Layer
Layer1  Physical Layer T »Layer 1 Physical Layer

Figure 14.1 The OSI Model

The physical layer handles the transmission of raw bits over a communications link. The data
link layer then collects a stream of bits into a larger aggregate called a frame. Network adaptors,
along with device drivers running in the node's (computer) operating system, typically
implement the data link level. This means that frames, not raw bits, are actually delivered to
hosts. The network layer handles routing among nodes within a packet-switched network. At
this layer, the unit of data exchanged among nodes is typically called a packet rather than a
frame, although they are fundamentally the same thing. The lower three layers (Physical, Data
link, and Network layer) are implemented on all network nodes, including switches within the
network and hosts connected to the exterior of the network. The transport layer then
implements what we have up to this point been calling a process-to-process channel. Here, the

unit of data exchanged is commonly called a message rather than a packet or a frame. The
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transport layer and higher layers typically run only on the end hosts and not on the intermediate
switches or routers. [1]

There is less agreement about the definition of the top three layers. Application layer protocols
include things like the Hypertext Transfer Protocol (HTTP), which is the basis of the World
Wide Web (www) and is what enables web browsers to request pages from web servers. Below
that, the presentation layer is concerned with the format of data exchanged between peers.
Finally, the session layer provides a name space that is used to tie together the potentially
different transport streams that are part of a single application. For example, it might manage
an audio stream and a video stream that are being combined in a teleconferencing

application.[1]

14.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

° Define IP addressing scheme and Internet governance.
° Understand the role of IPv4 in networking.
° Explore the popular protocols, i. e. FTP, HTTP, SMTP, HTTPS, TCP/IP.

14.3 IP ADDRESSING SYSTEM

An IP (Internet Protocol) address is a label which is used to identify one or more devices on a

computer network, such as the internet. It can be compared to a postal address. An IP address
can be presented using binary number system or dotted decimal notation. IP addresses are
usually written as a set of numbers (dotted decimal notation) in a given order. Devices using
IP addresses use the internet protocol to communicate. The Internet Assigned Numbers
Authority (IANA) assigns IP addresses to regional internet registries (RIRs). The RIRs assign
them to Internet Service Providers (ISP). Internet Service Providers then assign IP addresses
to their customers. All internet connecting devices necessarily have an IP address. Each IP
address has two parts: One that specifies the computer or group of computers, and another
which specifies the network. Certain types of addresses are unique, others can be re-used. A

number of IP addresses are used for special purposes (called reserved addresses). [2]

IP addresses allow network resources to be reached through a network interface. If one
computer wants to communicate with another computer, it can address the information to the
remote computer’s [P address. Assuming that the two computers are on the same network, or
that the different computers and devices in between can translate requests across networks, the
computers should be able to reach each other and send information. Each IP address must be
unique on its own network. Networks can be isolated from one another, and they can be bridged
and translated to provide access between distinct networks. A system called Network Address
Translation (NAT), allows the addresses to be rewritten when packets traverse network borders

to allow them to continue on to their correct destination. This allows the same IP address to be
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used on multiple, isolated networks while still allowing these to communicate with each other
if configured correctly. [3]

14.4 OVERVIEW OF IPv4 AND IPv6

The Internet is a network of networks. The connection points between networks are called

routers, networking devices that route data traffic between sub-networks on the Internet. Every
device on the Internet has a unique Internet Protocol (IP) address, like a postal or e-mail
address. The Internet Protocol specifies how a router handles a request for a different IP
address.

IPv4 (Internet Protocol Version 4)-

Each of the four numbers in a typical IP address today is an eight-bit or 1 byte with a decimal
value between 0 and 255. A 32-bit (4 byte) IPv4 address is big enough to support 232
(4,29,49,67,296) unique IP addresses. An IPv4 address can be expressed by the-
Dotted-decimal notation (Example- 172.16.254.1)

Binary notation (Example- 10101100 00010000 11111110 00000001)

The IPv4 address distribution-

Classful distribution

Classless distribution

IP addresses are typically made of two separate components. The first part of the address is
used to identify the network address, the part that comes afterwards is used to specify a specific
host within the network. As per classful address distribution, IPv4 addresses are divided into
five different classes, As-

Class A (ranges 0.0.0.0 to 127.255.255.255)

Class B (ranges 128.0.0.0 to 191.255.255.255)

Class C (ranges 192.0.0.0 to 223.255.255.255)

Class D (ranges 224.0.0.0 to 239.255.255.255)

Class E (ranges 240.0.0.0 and 255.255.255.255)

IPv6 (Internet Protocol Version 6)-

An [Pv6 addresses are generally expressed in hexadecimal form because of larger length.
For example- 2001:0DB8:AC10:FE01:0000:0000:0000:0000

The new IPv6 addresses are 128 bits wide (16 bytes), which is enough to support
IP addresses.

14.5 INTERNET SERVICE PROVIDER (ISP)

Internet Service Providers (ISPs) are companies that provide various Internet services to

2128 ynique

interested customers. ISPs provide Internet connectivity to homes and workplaces on a
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contractual basis. The beneficiary (either an individual person or an organization) pays a fee

for the services. Usually, ISPs provide either business or individual Internet access. [4,5]

ISPs support various forms of Internet access, such as traditional modem dial-up up, DSL
(Digital subscriber Line), cable modem broadband services, fiber and dedicated lines. In the
past, some of the best ISP services were DSL and dial-up services. In the case of DSL, if the
beneficiary was looking for more speed and a better Internet connection, then the DSL accounts
would have been a great alternative a few years ago. As compared to the dial-up, DSL does not
use the home phone line so that the telephone can be used anytime without presenting a conflict
for the user. [4,5]

There are many different Internet Service Providers, some of the most popular include BSNL,
MTNL, Reliance Jio, Bharti Airtel, Idea Cellular, etc. When you choose an ISP, there are many
factors to take into consideration. Some of those factors include price, type of internet
connection you want, speed, customer support, types of devices you use, and cancelation

policies. [4,5]
Types of Internet Connections

° Dial-up connection- ‘Dial-up’ connection is also known as level two connection. This
provides connection to Internet through a dial-up terminal connection. The computer,
which provides Internet access is known as ‘Host’ and the computer that receives the
access, is called ‘Client’ or ‘Terminal’. The client computer uses modem to access a
“host” and acts as if it is a terminal directly connected to that host. 56 Kbps (Kilo Byte
Per Second) modem access is widely available and supported by most ISPs. So, this

type of connection is also known as low speed or ‘Remote Modem Access’ connection.
[6]

° Integrated Services Digital Network (ISDN)- ISDN offers Internet connectivity at
speeds of up to 128 Kbps through the use of digital phone lines. ISDN is a dial-up

service that has been provided by telephone companies for many years.

° Leased connection- It is also known as direct Internet access or Level Three connection.
It is the secure, dedicated and most expensive, level of Internet connection. With leased
connection, your computer is dedicatedly and directly connected to the Internet using

highspeed transmission lines.

° Digital Subscriber Line (DSL)- It is another technology being used for Internet access.
DSL connects your home or office to the Internet through the same telephone wire that
comes from the telephone pole on the street. Like ISDN, with DSL, user can make and
receive telephone calls while connected simultaneously to the Internet. However, DSL
service is limited in the distance that you can be from the provider’s point of presence
(POP).
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° Cable Modem Connection- The connection speed can be up to 10 times that of a dial-
up and the cost is about twice that of an ISP’s dial-up account, with no phone company
charges. Many people who have cable TV can now get a high—speed connection to the
internet from their cable provider. Cable lines offer an extremely high bandwidth
connection to the Internet. It divides the connection into lots of bands, and translates
the data in the bands into signals that can be carried through cable lines. Cable modems

change these signals into IP packets that your computer can understand.
° And many more connection types are available such as- Wireless connections, etc.

14.6 INTERNET GOVERNANCE

Internet governance is the development of norms and principles relating to how the Internet

functions by a group of stakeholders including governments, organizations, and commissions
and the regulation and administration of those principals by the parties involved. Aside from
structural issues, Internet Governance can include conversations around access, policy and
content. [7]

According to the Report of the Working Group on Internet Governance (WGIG) (June 2005
P.4) Internet Governance is the development and application by governments, the private
sector, and civil society in their respective roles of shared principles, norms, rules, decision-
making procedures, and programs that shape the evolution and use of the Internet. Some of the
organizations that are involved in Internet governance are [7]-

° ICANN (Internet Corporation for Assigned Names and Numbers)

TANA (Internet Assigned Numbers Authority)

ISOC (Internet Society)

Internet Governance Forum

NTIA (National Telecommunications and Information Administration)

ITU (International Telecommunication Union)

UNESCO (United Nations Educational, Scientific and Cultural Organization)
WIPO (World Intellectual Property Organization)

Registries and Registrars

° IETF (Internet Engineering Task Force)

14.7 GATEWAY

In computer networking, a gateway is a component that is part of two networks, which use

different protocols. The gateway will translate one protocol into the other. A router is a special
case of a gateway which connects two or more similar networks. Gateways, also called protocol
converters, can operate at any network layer. The activities of a gateway are more complex

than that of the router or switch as it communicates using more than one protocol.

14.8 FILE TRANSFER PROTOCOL (FTP)
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File Transfer Protocol (FTP)- It is an Internet utility software used to upload and download
files. It gives access to directories or folders on remote computers and allows software, data
and text files to be transferred between different kinds of computers. FTP works on the basis
of same principle as that of Client/Server. FTP “Client” is a program running on your computer
that enables you to talk to, and get stuff from, remote computers. The FTP client takes FTP
commands and send them as requests for information from the remote computer or known as
FTP servers. To access remote FTP server, it is required but not necessary to have an account
in the FTP server. When the FTP client gets connected, FTP server asks for the identification

in-terms of user login name and password of the FTP client. [§]

HYPER TEXT TRANSFER PROTOCOL (HTTP AND
HTTPS)

Hypertext Transfer Protocol is a communication protocol which is used to send and receive

14.9

webpages and files on the internet. It was developed by Tim Berners-Lee and is now
coordinated by the W3C (World Wide Web Consortium).

HTTP works by using a user agent to connect to a server. The user agent could be a web
browser. The server must be located using a URL (Uniform Resource Locator) or URI
(Uniform Resource Identifier). This always contains "http:/" at the starting. It normally
connects to port 80 on a computer.

A more secure version of HTTP is called HTTPS (Hypertext Transfer Protocol Secure). This
contains "https://" at the beginning of the URL. It encrypts all the information that is sent and
received. This can stop malicious users such as hackers from stealing the information and is
often used on secure transmissions, such as- payment websites. HTTPS uses port 443 for
communication instead of port 80.

14.10 SIMPLE MAIL TRANSFER PROTOCOL (SMTP)

Most internet systems use SMTP as a method to transferring e-mail from one user to another.

SMTP is an application layer protocol. User-level e-mail clients typically use SMTP only for
sending messages to a mail server for relaying, and typically submit outgoing e-mail to the
mail server. SMTP is a protocol and is used to send the mail whereas POP (post office protocol)
or IMAP (internet message access protocol) are used to retrieve those mails at the receiver’s
end. The SMTP server is always on listening mode. As soon as it listens for a TCP connection
from any client, the SMTP process initiates a connection through port 25. After successfully
establishing a TCP connection the client process sends the mail instantly. Since SMTP's
introduction in 1981, it has been updated, modified and extended multiple times. The protocol
version in common use today has extensible structure with various extensions for
authentication, encryption, binary data transfer, and internationalized email addresses. SMTP
servers commonly use the Transmission Control Protocol on port number 25 (for plaintext) and
587 (for encrypted communications). [10,11]
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1417 TRANSMISSION  CONTROL ~ PROTOCOL/INTERNET
Y PROTOCOL (TCP/IP)

The TCP/IP suite is a four layers model which is for both modelling current Internet

architecture, as well as providing a set a rule that governs all forms of transmission over a
computer network. The TCP/IP Model is sometimes called the Internet model. The TCP/IP
model describes a set of general design guidelines and implementations of specific networking
protocols to enable computers to communicate over a network. TCP/IP provides end-to-end
connectivity specifying how data should be formatted, addressed, transmitted, routed and
received at the destination. Protocols exist for a variety of different types of communication

services between computers.

TCP/IP protocol stack is a shorthand for the two most important protocols used to make the
Internet work; the Internet Protocol (IP), and the Transmission Control Protocol (TCP). The IP
is responsible for transferring data packets whereas the TCP makes sure all packets arrived
safely, if not, retransmits them. The TCP/IP protocol stack is made up of four layers that work
together. These four layers are (high to low)-

Layer 4- Application Layer.
Layer 3- Transport Layer.
Layer 2- Network Layer.
Layer 1- Physical Layer.
The Application Layer-

The application layer defines how certain services operate and how they can be used. Examples
are the FTP service for transferring files, HTTP for serving Web pages and SMTP for e-mail.
The two ends, called "the client" and "the server" are set up a connection over which they
exchange messages in accordance with a specific protocol. The client starts the protocol by
requesting the service. Often the next step is for the server to authenticate the client's request

and respond accordingly. [12,13]
The Transport Layer-

On the Internet, the transport layer is realized by two protocols. The first is the Transmission
Control Protocol (TCP) and the second is the User Datagram Protocol (UDP). Both break up a
message that an application wants to send into packets and attempt to deliver those packets to
the intended recipient. At the recipient’s side, both take the payload from the received packets
and pass those to the application layer. [12,13]

The main difference between TCP and UDP is that TCP is reliable or connectionful and UDP
is connectionless protocol. TCP will collect incoming packets, put them in the right order and
thereby reassemble the original message. If necessary, TCP requests retransmission of lost or

damaged packets. UDP merely takes each incoming packet and delivers the payload (the
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original message) to the application layer. Any errors or out-of-order data should be taken care
of by the application. [12,13]

UDP is much faster than TCP, and so is mainly used for applications like audio and video
streaming, where the occasional error is less important than getting all the data there at the right
time. More generally, UDP is designed for applications that do not require the packets to be in
any specific order. Because of this, UDP is sometimes called a “connection-less” protocol.
[12,13]

For example, the e-mail client and server communicate over a reliable/ connection-oriented
protocol (TCP). The server listens on a certain port (port 25) until a connection request arrives
from the client. The server acknowledges the request, and a TCP connection is established.

Using this connection, the client and server can exchange data. [12,13]
The Network Layer-

The network layer is responsible for transmitting and routing data packets over the network.
The Internet uses the Internet Protocol or IP as its network layer. Each node on the network has
an [P address, and data is sent as data packets (each data packet has specific format and size
limit). [12,13]

The data packets are passed from one node in the network to another until it gets to the
destination address with a source IP address, destination IP address and a payload (message)
imprinted on the data packet. The IP does not notice that a packet gets lost. It just never gets to
the destination. If a particular node cannot pass the packet to the next node along the normal
route, it will do its best to find an alternative path. That is why IP is sometimes called a “best
effort delivery protocol". [12,13]

The Physical Layer-

The lowest layer is the physical layer, which defines how the cables, network cards, wireless
transmitters and other hardware connects computers to the networks and networks to the rest
of the Internet. Examples of physical layer networks are- Ethernet, Wi-Fi, Token Ring and
Fiber Data Distributed Interface (FDDI). The physical layer provides the means to transfer the

actual bits from one computer to another. [12,13]

14.12 POINTS TO REMEMBER

° The International Standard Organization (ISO) was one of the first organization to

formally define a common way to connect computers.

° An IP address can be presented using binary number system or dotted decimal notation.
IP addresses are usually written as a set of numbers (dotted decimal notation) in a given
order. Devices using IP addresses use the internet protocol to communicate.
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ISPs support various forms of Internet access, such as traditional modem dial-up up,
DSL (Digital subscriber Line), cable modem broadband services, fiber and dedicated
lines.

There are many different Internet Service Providers, some of the most popular include
BSNL, MTNL, Reliance Jio, Bharti Airtel, Idea Cellular, etc.

In computer networking, a gateway is a component that is part of two networks, which
use different protocols.

FTP works on the basis of same principle as that of Client/Server. FTP “Client” is a
program running on your computer that enables you to talk to, and get stuff from,
remote computers.

HTTP works by using a user agent to connect to a server. The user agent could be a
web browser. The server must be located using a URL (Uniform Resource Locator) or
URI (Uniform Resource Identifier). This always contains "http://" at the starting. It
normally connects to port 80 on a computer.

SMTP is a protocol and is used to send the mail whereas POP (post office protocol) or
IMAP (internet message access protocol) are used to retrieve those mails at the

receiver’s end.

14.13 GLOSSARY

Router- A device that transfers data between computer networks to provide access to
the Internet.

ISP (Internet Service Provider)— A company that provides Internet service to customers.
HTTP (Hypertext Transfer Protocol)— A set of rules (a protocol) for transferring and
accessing data using the web.

URL (Uniform Resource Locator)— A web address of a specific web page or file on the
Internet. An example is https://www.uou.ac.in

IP (Internet Protocol)— A set of rules (a protocol) for sending data from one computer
to another on the Internet. Each computer has a unique IP address that distinguishes it
from all other computers on the Internet.

FTP (File Transfer Protocol)— A set of rules (a protocol) for transferring files between
computers over the Internet.

Cookie- A small text file stored in a user’s computer by a website that the user has
visited so that it can remember something about the user at a later time. For example,
cookies are used for online shopping. Without cookies, login information would have
to be entered before every product was added to the shopping cart.

Link (hyperlink)— A word, phrase, image, etc., within a file or web page that a user can
click on to jump to another document, section of the same document, or web page.

PC (Personal Computer)— a small computer designed for use by a single user at a time.
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Mac (Macintosh)— a type of personal computer made by Apple Inc. It runs a version of
the macOS (Apple’s operating system, pronounced “mack-oh-ess”).

OS (Operating System)— a powerful program that controls and coordinates a
computer’s hardware devices and runs software and applications. Examples includes
Windows, Android, OS X, and Linux.

Reboot— to shut down and restart a computer, allowing its operating system and
programs to be reloaded.

CPU (Central Processing Unit)— the brain or engine of a computer, where most of the
processing and operations take place.

Bit (Binary Digit)— the smallest, most basic unit of measurement for computer data
storage, represented as either a 0 or a 1. One byte is equal to 8 bits.

Byte (Binary Term)— a unit of measurement for data storage. One byte is equal to 8 bits.

14.14 CHECK YOUR PROGRESS

1
2)
3)
4)
S)
6)

Define OSI model.

Define IP addresses and their role in computer networking.
What do you understand by IPv4 and [Pv6?

Explain Internet governance.

Briefly explain the types of internet connection.

Explain the role of following protocols- HTTP, FTP, SMTP.
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15.1 INTRODUCTION

Knowledge and information can be sourced by utilizing e-content technology. E-Content is a

web-based blended interactive way of digital content that is electronically delivered. For
electronic learning, it becomes essential to develop e-content with the varieties of tools
available. There exist many e-content delivery platforms to exhibit our content. Some of the
basic tools for developing interactive e-content, simple delivery platforms, and grading tools
are explained in this unit. In a developing country like India e-learning can raise the level of
education, literacy, and economic development. Learning anything, anywhere, at any time is

the current scenario.

E-Contents provided through e-learning are the future content system for school education to

higher education and even for faculty members. Currently, e-contents are available for
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school education, diploma, degree, postgraduates, research scholars, and faculty
members. There is an enormous growth rate in the tools used for designing a learning
management system. The actual challenge here is the need to develop interactive
courses that are both rich in content and interesting to the viewer. Many tools such as
e-content generators, screen casting tools, audio and video creator, animations,
simulators, grading tools, content management tools, survey tools, editorial calendars,
and many more are available to create a rich and powerful delivery platform. The e-

content growth rate in India is less compared to other developing countries.

15.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

° Know the basic tools and techniques of e-content development.
° Define the benefits and importance of e-content development.
° Understand the basic concepts of HTML.

° Understand the basic concepts of website planning for e-content/e-tutorials.

15.3 E-CONTENT

The rapid development in computer technology, together with the use of computers by the

teachers paved the way for the introduction of computers in teaching and learning. With the
advancement of technology, the computer has become more user-friendly so teachers can
develop e-content easily. E-content is a very powerful tool of education. E-content is valuable
to the learners and also helpful to teachers of all individual instruction systems. E-content is
the latest method of instruction that has attracted more attention to gather with the concept of

models.

E-content can be defined as the digital content (electronic-content) that can be transmitted over

a computer network such as the Internet. (Source- Wikipedia)
Types of E-content-

E-content is termed as electronic content including text, image, graphics, animation, audio, and
video. Sometimes, e-content can be carrying any one of the above elements or all of the above
together to display offline or online web-pages and also to be transferable to computer to

another computer and internet.

Electronic content (e-Content) or digital content is defined by those involved in creating,
providing, and distributing information 4 as the digitized content, which is viewed on screen
and not on paper. Contents that are produced and stored electronically rather than in print are
the result of electronic publishing (e-publishing). The contents can be in any of the following

forms:

Unit 15: E-Content Development Page 202 of 249



CVDMM- 302: ICT Resources and Applications uou

[i] Any one information type (for example fully textual, only graphics content, or only audio

content)
[ii] Multimedia or hypermedia (i.e. mixing more than two information type)
E-Resources-

Pictures, photos, audios, videos, demonstrations, animations, graphics, etc can be included
based on the interest of the investigator or producer. The most important aspect is that the
material should be accessible and knowledge based and also help induce individual’s interest
to learn. These things must be kept in mind while preparing a perfect content based on the

learner’s level of understanding.
Text format-

Text font selection is the main area of concern regarding the e-content presentation while
developing a package. The preferred font may be taken as Times new roman, Bookman Old
style, San serif, Serif, etc. The font visionary and style can also form an important aspect during

development.
Video-

Avoid ambiguity while preparation, casual, providing enough spacing between words and
sentences, correct pronunciation for the words, relevance, modulation, voice pitch corrections,

clarity in visual presentation mode, etc should be done for perfection.
Image, photo, and picture-

Quality items should be selected while downloading. High-resolution formats are fairly
preferred and pixels should be high rated so that magnification or zooming done during
learning leads to usefulness for learners.

Script writing-

It’s an art. The script writing reveals the interest of the investigator and helps the developer as
well in the successful development of a package. Relevant sentences with simple meaning are
usually accepted. Being a writer, one should not include his/her higher level language to
complete the work. The script should be easy to read and the learner should not have difficulty
in understanding its meaning. A higher level of language style or tough words should not be
used anywhere. Most important is the script should be written according to the level of the
learner’s class. Precision is another equally important attribute. It should be like an actual

classroom practice environment.

BENEFITS AND IMPORTANCE OF E-CONTENT
DEVELOPMENT

Advantages of E-Content-

15.4
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Many institutions publish books, research reports, lecture modules, and other information for
academic purposes. All these publications are usually in-print form and stored in the library for
fellow lecturers, researchers and students use. Are there compelling reasons why these in-print
publications should be in electronic form? To answer this, it is necessary to identify the
advantages and disadvantages of printed content (p-content) and e-content. According to

Bonime and Pohlmann, (1998) e-contents benefit from-

e  Hyper linking - contents can be linked to other pages inside and outside the book.

° Non-linearity - the order of access can be determined by users.

° Addition of multimedia - content presentation is enhanced by mixing information type
(i.e. sound, video and so on) data density - storage capacity is decreased increasing
portability simultaneously.

° Searching - the usefulness of the content is enhanced by the ability of the users to locate

any piece of information or to access any section instantly.
Importance of E-Content

° E-content is user friendly and one can download and use text materials on any computer
independently.

) E-content being learner friendly is easy to navigate.

° Another important feature of e-content is that being learner-centric it proves quite useful
in the self-instructional model.

° E-content is also teacher’s friendly and can used in various teaching- learning methods

such as classroom, lecturing to a group, lab session.

TOOLS AND TECHNIQUES OF E-CONTENT
DEVELOPMENT

Nowadays, a wide range of tools are present to help create e-content from simple PowerPoint

15.5

presentations to 3D animations. The E-content is actually a virtual teacher which provides us
high-quality digital content that is well designed, developed, and validated. Various factors like
the subject, its complexity, learner, and nature of the content influence the design. Several
models and design strategies are available to develop the e-content. The general steps that are

mostly followed are analysis, design, development, implementation, and evaluation.

Articulate Storyline is easy to use software that helps create virtually powerful content that is
both interactive and easily accessible to mobile users. An optimal view is automatically
provided to mobile users. The triggers are used to create effective interactivity in storyline. We
can decide when an action should take place, where should it take place (like in the same layer
or other layers) and what should be the action that is possible only with triggers. It is also
possible to create a questionnaire that may include true/false, MCQs, match the following,
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image matching, etc. Simple animations can be created here as well. The tables are used here

to organize the content and present them neatly to the user.
Figure 15.1 Articulate Storyline Screen Shots
[1] Screen Casting Tools

The screen output is the video screen capture along with the audio that can be digitally
recorded. This is known as screen casting. Many softwares are available for screen casting

some of them include CamStudio, Screencast-O-Matic, Screenr, and Jing which are available
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free. Some are free web-based software. The Screencast-O-Matic is easy to use free web-based
casting tool. By simply clicking the ‘Start Recording’ one can activate the online recorder. The
user can choose the recording mode. They can record only the screen, webcam, or both and
can select the region for recording on the screen. This can be saved on their computer or can
be directly uploaded. Wevideo, Magisto, Videopad, Openshot are some video creators and

editors.
[2] Audio Generators

The presentation will be powerful when we have audio accompanied with it. Many free
software such as Free Sound Recorder, Audacity, and WavePad are available to record our
audio. Audacity is open source software that allows us to record live audio and comes with
several features. The recorded audio can be cut, copied, and mixed with other sound effects.
We can also change the speed or pitch of a recording. It is also possible to convert old

recordings into digital form and edit any type of sound file formats.
[3] Animations

A picture is worth a thousand words similarly, an animation can make us understand even a

complex system. Simulations or movement can be created by generating a chain of pictures
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and giving effects that create an optical illusion of movement. The common methods of
presenting animations include video programs, motion picture, and various other forms are
available. We can have a 2D or 3D animation in our presentation. A 2D animation creates
movement in a two-dimensional space and allows us to create characters, storyboards, and
backgrounds. In 2D animation the objects can move up, down, left, and right. 2D animation
uses bitmap and vector graphics to create and edit animated images. Some of the popular
software available are: Adobe Photoshop, Flash, Synfig, and Encore. 2D animations are easy
to generate whereas 3D animation requires deep knowledge and skill in modelling 3D objects.

Modelling, animation, and rendering form the basics of 3D animations.

There are many 2D to 3D open source converter software available. The convertor tool adds
depth information to the 2D image. Different algorithms and techniques are used by different
converters to convert a given 2D image into a 3D image. Some of the popular software
available are: Blender, Make3D, 3DShade, Recap pro, Insight3D, Convertlmage, etc. Some of
them are fully automatic and automatically estimates depth for an image. Most of the
convertors get 2D images captured from a normal camera and store them in PC in standard
image formats as input while adding depth using various techniques. Others are semi-
automatic; we have to assign depth to various parts of the image. We need to define a few

parameters like width, depth and the position of object explicitly.
[4] Grading Tools

To know the real outcome and to evaluate the student performance, grading becomes essential.
It is a prime concern in deciding student success. Grading gives feedback to students on their
performance and helps them know their strengths and weaknesses. Some of the tools available
for grading are: ActiveGrade, LearnBoost, JumpRope, Answer pad, and FreshGrade. Rubric is
a popular grading tool used for marking assignments, class participation, or overall grades.
There are two types of rubrics namely holistic rubric and analytical rubric. They help us decide
what criteria or essential elements must be present in the student’s work to ensure that it is high
in quality. A rubric allows us to the decide number of levels of achievement, components at

each level, and their relation to the grading scheme. We can also add comments.

15.6 E-CONTENT DELIVERY PLATFORMS/TOOLS

The E-content delivery platform known as LMS (Learning Management System) is a server-

based or cloud-based software program. LMS has information about courses, users, and course
content. A learning management system provides a platform to teach and learn without
depending on the time and space boundaries. Anybody can take any course in they are
interested in. Learning Management System is a software application that manages various
functions like administration of classrooms online, documentation of various courses, tracking
the progress of the user, reporting of training programs, online events, and grading the users.
Most of the LMS has the following features: Registration and Enrolment options to teachers
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and students, adding and deleting courses by Universities and other educational bodies, set
different roles for users and managing user account, setting the course calendar, uploading and
retrieving assignment, and resources. LMS is used by students, teachers, and administrators.
LMS can be used by anyone interested in conducting online classes and storing or retrieving

student’s documents. The modules can be grouped under the following categories:

o Content Manager

° Course Manager

° Catalogue Manager

° User Profile Manager

e  University Consortium Manager

° Learning Planner and Calendar

Some popular LMS software available in the market are: Canvas, MindFlash, LearnUpon,
Moodle, Blackboard, Talentless, and BridgeLMS. One of the easy to work with and free online
software available is the Canvas. Canvas upon simple registration allows us to create our own
course in teacher’s mode and as a student we can join n number of courses. It supports content
in various formats, e.g. multimedia, video, and text. Users can have any number of modules
and pages inserted into it. The option provides a way to insert any number of files uploaded to
the Canvas which can be viewed by the student. Animations, simulations, interactive contents,
audio files, and screen casting can be added to our course. This paves the way for the learner
to properly understand the concept and have a clear idea. It also offers assignments to the
students in order to evaluate and grade them easily. Teachers can modify information according
to the need of the student.

Using the proper learning strategies, LMS can increase the motivation of learners, promote
learning, encourage interaction, provide feedback and support during the learning process.
However, improvement in teaching methodology and the outcomes of the learning are not
guaranteed through the learning management system. This kind of teaching involves reuse of
the content and thus saves cost, effort, and time. Various innovative activities are offered to the

learners to make learning active and interesting.
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Figure 15.2 Canvas Instructure Screen Shots

15.7 OPEN SOURCE E-CONTENT DEVELOPMENT TOOLS

The e-learning community has several sets of technology standards and is currently developing

additional standards. The ultimate vision is to have interoperability throughout the entire e-
learning market. Until then, the e-learning community is fragmented into different systems
adhering to various standards. The four most common standards are Aviation Industry
Computer-based Training Committee (AICC), Sharable Content Object Reference Model
(SCORM), IMS Global Learning Consortium, and Microsoft LRN. Many of the products
offered in today's e-content marketplace are shifting from proprietary apps to open standards
like HTMLS. Open-standard products and software offer many of the same features as closed
applications but provide the additional benefit of working across the most common device
platforms. Open-standard products and software also allow for greater longevity, since the e-
content can continue to be accessed through various devices even as technologies develop
further

[1] eXe

eXe stands for e-learning xhtml editor, an authoring application to assist teachers and
academics in the publishing of web content without the need to become proficient in HTML or
XML markup languages. eXe grew out of the New Zealand Government Tertiary Education
Commission's e-collaboration fund led by the University of Auckland, Auckland University of
Technology, and Tairawhiti Polytechnic. It was later supported by CORE Education, a New
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Zealand-based not-for-profit educational research and development organisation. It has also

been greatly assisted by a global group of participants and contributors.
[2] Xerte

Xerte is an open-source content creation tool that allows non-technical staff to quickly and
easily create built-in rich, interactive, and engaging resources with high levels of accessibility.

Xerte was developed by the University of Nottingham supported by JISC Techdis.
[3] GLO Maker

GLO Maker is an authoring tool for creating rich, interactive learning resources. It builds on
the extensive experience of the Centre for Excellence in Teaching and Learning (CETL) in
Reusable Learning Objects. It is an open source and free for educational use. GLO Maker
authoring tool is based on the new concept. Generative Learning Objects (GLO) approach
inverts the traditional approach for reusability. The traditional approach to the reuse of learning
objects has been to separate content from the context to make the content reusable. However,
in GLO, it extracts successful pedagogical designs and makes these the basis for reuse (GLO
Maker 2009). In this design-based approach for learning objects, designs have to be rendered
explicit in two distinct ways. The first form relates to human understanding which is
pedagogical design. Then, the design should be rendered to produce a learning object based on

that design. GLO Maker was developed by London Metropolitan University.
[4] Course Lab

Course Lab is a powerful, easy-to-use, e-learning authoring tool that offers programming-free

and WYSIWYG environment for creating high-quality interactive e-learning content. Features:

) Publish to HTML package.

e  Publish to CD-ROM.

° Publish to SCORM 1.2 and SCORM 2004 package for import to any LMS supporting
this standard.

[5] LAMS

LAMS, the Learning Activity Management System, is an open source Learning Design system
for designing, managing, and delivering online collaborative learning activities. It provides
teachers with an intuitive visual authoring environment for creating sequences of learning
activities. These activities can include a range of individual tasks, small group work, and whole
class activities based on both content and collaboration. LAMS is inspired by the concept and
principles of IMS Learning Design. LAMS was developed in collaboration with the LAMS
Foundation, LAMS International, and the Macquarie E-learning Centre of Excellence
(MELCOE), all based in Sydney, Australia, in affiliation with Macquarie University. LAMS
have been developed since 2003.
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15.8 INTRODUCTION TO HTML

Hypertext Markup Language (HTML) is the standard markup language for creating Web pages.
HTML can be described as follows-

) HTML stands for Hypertext Markup Language.

° HTML describes the structure of a Web page.

° HTML consists of a series of elements.

° HTML elements tell the browser how to display the content.

) HTML elements are represented by tags.

° HTML tags label pieces of content such as "heading", "paragraph", "table", and so on.
° Browsers do not display the HTML tags but use them to render the content of the page.

The HTML Documents- We can use any text editor to write HTML over it, and save the
document with dot html (.html) file extension. All HTML documents must start with a
document type declaration: <IDOCTYPE html>. The HTML document itself begins with
<htmlI> and ends with </html>. The visible part of the HTML document is between <body>
and </body>. Example-

<IDOCTYPE html>

<htmlI>

<body>

<h1>My First Heading</h1>
<p>My first paragraph</p>
</body>

</html>

Html Elements and Attributes

An HTML element usually consists of a start tag and an end tag, with the content inserted in

between- <tagname> Content goes here...</tagname>
The HTML element is everything from the start tag to the end tag:
<p>My first paragraph. </p>

HTML elements with no content are called empty elements. Empty elements do not have an

end tag, such as the <br> element (which indicates a line break).

Nested HTML Elements- HTML elements can be nested (elements can contain elements). All
HTML documents consist of nested HTML elements.
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HTML Attributes- HTML attributes can be described as follows-
All HTML elements can have attributes

Attributes provide additional information about an element
Attributes are always specified in the start tag

Attributes usually come in name/value pairs like: name="value"
Commonly used attributes in html are as follows-

[1] The href Attribute

HTML links are defined with the <a> tag. The link address is specified in the href attribute:
Example

<a href="https://www.w3schools.com">This is a link</a>

[2] The src Attribute

HTML images are defined with the <img> tag.

The filename of the image source is specified in the src attribute:
Example

<imgsrc="img_girl.jpg">

[3] The width and height Attributes

HTML images also have width and height attributes, which specifies the width and height of
the image:

Example

<imgsrc="img_girl.jpg" width="500" height="600">

[4] The alt Attribute

The alt attribute specifies an alternative text to be used if an image cannot be displayed.

The value of the alt attribute can be read by screen readers. This way, someone "listening" to

the webpage, e.g. a visually-impaired person can hear the element.

Example

<imgsrc="img_girl.jpg" alt="Girl with a jacket">

[S] The style Attribute

The style attribute is used to specify the styling of an element, like color, font, size, etc.
Example

<p style="color:red">This is a red paragraph.</p>
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HTML Tags- Some commonly used html tags are as follows-

Tag Description

<> Defines a comment

<IDOCTYPE> Defines the document type

<a> Defines a hyperlink

<area> Defines an area inside an image-map

<b> Defines bold text

<body> Defines the document's body

<br> Defines a single line break

<button> Defines a clickable button

<center> Defines cantered text

<figure> Specifies self-contained content

<font> Defines font, colour, and size for text
<footer> Defines a footer for a document or section
<form> Defines an HTML form for user input
<h1> to <h6> Defines HTML headings

<head> Defines information about the document
<header> Defines a header for a document or section
<htmI> Defines the root of an HTML document
<i> Defines a part of text in an alternate voice or mood
<img> Defines an image

<link> Create link between a document and an external resource
<p> Defines a paragraph

<table> Defines a table

<title> Defines a title for the document

WEBSITE PLANNING AND STRUCTURE FOR E-

5.9 CONTENT/E-TUTORIALS

Guideline for Website Planning-

Basically, it’s how your website is connected. How your main pages lead to deeper pages on

your website. You can see it as how your navigation and sitemap are built.

Why Plan a Website Structure?

Well, you wouldn’t build a house without a plan, so why would you want to build your business

website without it. It can help to improve your user experience, your SEO, your internal linking

and the simplicity of usage. You should understand that planning a structure isn’t just about

the main website it’s also about the blog and internal linking.
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Creating a website is a complex endeavour to embark on. Every change, every added functions,

every addition of content increases the workload, time, and expense of a website, but all of that

can be managed with a website plan. Creating a website plan saves you countless headaches

down the road.

Steps for Creating Website Structure-

The essential steps for creating website structure are-

Start by getting the basic insights to your business/applications- This means getting to
know your own business. It’s not just important when you talk to a designer or whoever

will create your website. This is important when for you too.

Start doing your keyword research- Next step would be to dive into the keyword research.
Paid tools have even more data to give a bigger edge when researching for your business

keywords.

Competition research- In this step, we are technically still at keywords research, but we

are going to go further into the competition of your website.

Create your website’s URL structure- Most common URL structure looks like this. You
have a homepage, services, about us, references/work, blog, and contact. This will
represent your hierarchy, URL structure, and the main navigation. You get something

like this, a simple website diagram.

Homepage

Physiotherapy for What is
back pain Physiotherapy
Physiotherapy for What isa
lower back pain Disc Bulge
Sports Exercises for Disc
Physiotherapy Bulge Treatmet

||

Figure 15.3 Sample website planning diagram

Create a Simple and Logical Navigation- If you plan your website structure as shown

above you shouldn’t have any trouble creating the navigation for your website.

Create Your Navigation with HTML and CSS- The safest way for crawlers to be able to

read your navigation is to create your navigation with HTML and CSS.

Create an Internal Linking Strategy- Internal linking is what makes your website structure

to work for your website.

Unit 15: E-Content Development Page 213 of 249



CVDMM- 302: ICT Resources and Applications uou

It helps the structure to be logical, helps users navigate your website and establishes your

shared information’s hierarchy.

Create a Sitemap for Your Website- The thing is that most search engines use sitemaps
to find out about your new pages. It also helps search engines to index your pages faster

than if you don’t have one. There are many tools (Sitemap Generator) to do that.

Subsection 1 Subsection 2 Subsection 3

,..\

Subsubsection 1 Subsubsection 3
Subssubection 2 — Subsubsection 4

Figure 15.4 Website information hierarchy.

15.10 POINTS TO REMEMBER

E-Content is a web-based blended interactive way of digital content that is electronically

delivered.

E-content technical definition: (Electronic-content) Digital content that can be

transmitted over a computer network such as the Internet.

E-content is termed as Electronic content that includes text, image, graphics, animation,

audio, and video.

There exit wide varieties of tools to create e-content from simple PowerPoint

presentations to 3D animations which create virtual reality of the object under study.

Some of the tools available for grading are: ActiveGrade, LearnBoost, JumpRope,

Answer pad, and FreshGrade.

The E-content delivery platforms like LMS (Learning Management System) are a server-

based or cloud-based software programs.

Open source software is a software with free to access to the public and lots of people in
the world.
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HTML is the standard mark-up language for creating web pages.

Creating a website is a complex endeavour to embark on. Every change, every added
functions, every addition of content increases the workload, time, and expense of a

website, but all of that can be managed with a website plan.

15.11 GLOSSARY

CSS- Cascade Style Sheet.

URL- Uniform Resource Locator.

DOCTYPE- Document Type.

LAMS- Learning Activity Management System.

AICC- Aviation Industry Computer-based Training Committee.
SCORM- Sharable Content Object Reference Model.

LMS- Learning Management System.

2D- Two Dimensional.

3D- Three Dimensional.

15.12 CHECK YOUR PROGRESS

Objective type questions-

a)

b)
©)

d)

e)

Electronic-content Digital content that can be transmitted over a computer network such

as the Internet. (True/False)
E-content is termed as special content that include text and image only. (True/False)

The E-content delivery platform is known as FMS (File Management System).
(True/False)

Open-source software is a software which codes are free — to — access to the public; and

lots of people in the world. (True/False)

HTML stands for Hyper Text Makeup Language. (True/False)

Descriptive type questions-

a)
b)
c)
d)
e)

What do you mean by E-Content? Why it is important for today’s education system?
What are the tools and techniques used for E-Content development?

Describe Open Source E-Content development tools.

What is HTML? What is the difference between html element and html attribute?

Why do we need to plan a website before design it? Explain.
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f)  What are the steps to design a website structure?

Answers (Objective type question)

[a] True [b] False [c] False [d] True [e] False
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16.1 INTRODUCTION

E-governance because of its scope and aims is highly relevant in today’s era. In simple terms,

it is the use of information communication technologies (ICTs) to carry out public services,
that is to say, the use of the internet to ensure that services are delivered in a much more
convenient, customer-oriented, and cost-effective manner. In other words, the e-governance is
the application of Information Technology to the processes of government functioning in order

to achieve a Simple, Moral, Accountable, Responsive, and Transparent (SMART) Governance.

In the overall perspective, the e-governance is simply the use of ICTs in the operations of
government businesses, put in another way, it is the shift from the traditional method of
carrying out government activities which is mainly hierarchical, linear, and one-way to the use
of internet which enables the public to seek information at their own convenience and not really

having to visit the office in person or when government office is open.

The major objectives of e-governance are to improve government processes (e-administration),

connect citizens (e-citizens and e-services), and build external interactions (e-society). Despite
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these objectives, making and implementing decisions, proper leadership, putting in place
organizational arrangements, ensuring resources and funding, establishing accountability and
measuring success, telecommunications network, internal agency systems, cross-government
systems, service delivery network access points, internet access, and skilled staff, better
delivery of government services to citizens, improved interactions with business and industry,
citizen empowerment through access to information, and more efficient government
management are the factors that must be taken into consideration for the success of e-

governance implementation.

16.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

e  Understand the role of e-governance for smart administration.
° Define the importance of e-governance.

° Explore e-governance projects in India.

° Define the types and applications of e-governance.

e  Know the challenges of e-governance in India.

16.3 E-GOVERNANCE: AN OVERVIEW

The ‘e’ in e-Governance stands for ‘electronic’. Thus, e-Governance is basically associated

with carrying out the functions and achieving the results of governance through the utilization
of Information and Communications Technology (ICT). Why countries around the world are
increasingly opting for ‘e-Governance’? In the last few decades, the expectations of citizens
from the government have increased manifold. ICT facilitates efficient storing and retrieval of
information, instantaneous transmission of information, processing information & data faster
than the earlier manual systems, speeding up governmental processes, taking decisions

expeditiously & judiciously, increasing transparency, and enforcing accountability.

The primary purpose of governance is the welfare of citizens. While one aspect of governance
relates to safeguarding the legal rights of all citizens, an equally important aspect is concerned
with ensuring equitable access to public services and the benefits of economic growth to all. It
is expected that e-governance would enable the government to discharge its functions more

effectively and can be able to work with more transparency.

In India, during the initial stage of introduction of ICT in governance there was some resistance.
There were also serious doubts about whether government employees at all levels would be
able to handle computers. As time passes, all goes beyond and fortunately all these misgivings

have proved wrong.
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Today, new technology makes the machine-human interface very user-friendly. The
Information Technology (IT) and Information Technology Enabled Services (ITES) sectors
have created millions of jobs besides improving vastly on the services provided by government

undertakings like Banks, Airlines, Railways, etc.

As a country like India, with 1.3 billion population, more than 600,000 villages, growing
economy coupled with increasing aspirations of the citizens for a better quality of life — use of
Information Technology in improving government processes is not just become vital but
essential and without which it would be extremely difficult, if not impossible, to serve its
citizens efficiently and transparently and ensure participation of a larger number of people in

decision making at all levels of government— Centre, State and local.

The National e-Governance Division (NeGD) is providing strategic direction in terms of
framing policies and implementation strategy for the Digital India Programme in different
domains of e-Governance. And also provides, proactive support to Central and State
Governments for Mission Mode Projects (MMPs) and other e-Governance projects acting as a
facilitator and catalyst for the implementation of the Digital India Program by various

Ministries and State Governments.

The NeGD also ensures effective citizen engagement and communication with all stakeholders
using offline and Social Media channels. The role of NeGD in training and development
initiatives, including- development of competency frameworks, training guidelines, case
studies, etc. and developing online and web-based training and setting up of Learning
Management System, knowledge management and sharing through workshops, development
of case studies, sharing best practises, creation of knowledge repositories, etc.

The e-governance is, in essence, the application of Information and Communications
Technology to government functioning to create ‘Simple, Moral, Accountable, Responsive,
and Transparent (SMART) governance. The e-governance involves the use of ICTs by
government agencies for any or all of the following reasons, as-

° Exchange of information with citizens, businesses, or other government departments.
° Speedier and more efficient delivery of public services.

° Improving internal efficiency.

) Reducing costs/increasing revenue.

° Re-structuring of administrative processes and improving the quality of services.

The e-governance aims to make the interaction between government and citizens (G2C),
government and business enterprises (G2B), and inter-agency relationships (G2G) more

friendly, convenient, transparent, and inexpensive. The goals of e-Governance are-

° Better service delivery to citizens.
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° Ushering in transparency and accountability.

° Empowering people through information.

e  Improved efficiency within Governments.

° Improve interface with business and industry.

16.4 IMPORTANCE AND BENEFITS OF E-GOVERNANCE

E-governance is about reforms in governance, facilitated by the creative use of Information

and Communications Technology (ICT). The importance and benefits of e-governance are not

limited in respect to good governance, and citizen empowerment, few of them are as follows-

E-Governance brings governments closer to the citizens.

Provide simplicity, efficiency, and accountability in the government- Applications of
ICT to governance combined with detailed business process re-engineering would lead
to simplification of complicated processes, weeding out of redundant processes,
simplification in structures & changes in statutes, and regulations. The end result would
be the simplification of the functioning of government, enhanced decision-making
abilities, and increased efficiency across government— all contributing to an overall
environment of more accountable government machinery. This, in turn, would result in

enhanced productivity and efficiency in all sectors of government functioning.

E-governance empowers people to gather information regarding any department of

government and get involved in the process of government decision making.

E-Governance strengthens democracy by ensuring greater citizen participation at all

levels of governance.

E-Governance leads to automation of services, ensuring that information regarding every

work of public welfare is easily available to all citizens.

E-Governance revolutionizes the way governments function, ensuring much more

transparency in the functioning, thereby eliminating corruption.

If the information regarding every activity of government is easily available, it would
make every government department responsible as they know that every action of theirs

is closely monitored.

Expanded reach of governance- Rapid growth of communications technology and its
adoption in governance would help in bringing government machinery to the doorsteps
of the citizens. Expansion of telephone network, rapid strides in mobile telephony, the
spread of internet, and strengthening of other communications infrastructure would

facilitate the delivery of a large number of services provided by the government.
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° Proper implementation of e-Governance practices makes it possible for people to get
their work done online thereby sparing themselves of unnecessary hassles of travelling

to the respective offices.

° Successful implementation of e-Governance practices offers better delivery of services

to citizens, improved interactions with businesses, and industries.

e  E-governance helps citizen empowerment through access to information, better

management, greater convenience, revenue growth, cost reductions, etc.

° Enabling Environment for Promoting Economic development- Technology enables
governments to create positive business climates by simplifying relationships with
businesses and reducing the administrative steps needed to comply with regulatory
obligations. There is a direct impact on the economy, as e-procurement creates wider

competition and more participants in the public sector marketplace.

16.5 TYPES OF INTERACTIONS IN E-GOVERNANCE

The e-governance facilitates interaction between different stakeholders in governance using

ICT, such types of interactions are grouped into the following, as-
Government to Government Model (G2G)-

The G2G refers to the online communications between government organizations,
departments, and agencies based on a super-government database. Moreover, it refers to the
relationship between governments. G2G model of e-governance aims to enhance and improve
inter-government organizational processes by streamlining cooperation and coordination
among various government departments/organizations. The efficiency and efficacy of
processes are enhanced by the use of online communication and cooperation which allows for

the sharing of databases and resources and the fusion of skills and capabilities.
Government-to-Business (G2B)-

Government to business is another type of e-governance model which enables significant
efficiencies to both governments and businesses. G2B includes various services exchanged
between government and the business sector services. The business services offered include
obtaining current business information, new regulations, downloading application forms,
lodging taxes, renewing licenses, registering businesses, obtaining permits, and many more.
Nowadays, the government-to-business (G2B) model has been receiving a significant amount

of attention.
Government-to-Citizens (G2C)-

Government-to-Citizens (G2C) model of governance has been designed to facilitate citizen

interaction with the government. It allows citizens to access government information and
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services instantly, conveniently, from everywhere. The government-to-citizen model of
governance focuses on customer-centric and integrated electronic services where public
services can be provided based on a ‘one-stop solution’ concept. This implies that every citizen
can get single window access to government services. G2C model of governance facilitates
several services to the citizens, e.g. certifications, paying governmental fees, and applying for

benefits schemes of government, etc.
Government-to-Employees (G2E)-

Government is by far the biggest employer and like any organization, it has to interact with its
employees on a regular basis. This interaction is a two-way process between the organization
and the employee. Use of ICT tools helps in making these interactions fast and efficient on the
one hand and increase satisfaction levels of employees on the other so that the G2E model of

governance is a valuable model of smart administration.

16.6 E-GOVERNANCE PROJECTS IN INDIA

The Government of India (Gol) established the Department of Electronics in 1970. The
subsequent establishment of the National Informatics Centre (NIC) in the year 1977 was the

first major step towards e-Governance in India. In the early 1980s, the use of computers was
confined to very few organizations. The advent of personal computers brought the storage,
retrieval, and processing capacities of computers to Government offices. By the late 1980s
gradually, with the introduction of common use software such as word processing and other
kinds of software, the computers were put to other uses like managing databases and processing

information, etc.

Advances in communications technology further improved the versatility and reach of
computers, and many government departments started using ICT for a number of applications
like tracking movement of papers and files, monitoring of development programmes,

processing of employees payrolls, generation of reports, etc.

The main thrust for e-governance was provided by the launching of the National Informatics
Centre Network (NICNET) in 1987, the national satellite-based computer network. This was
followed by the launch of the District Information System of the National Informatics Centre
(DISNIC) programme to computerize all district offices in the country for which free hardware

and software was offered to the State Governments.

A National Task Force on Information Technology and Software Development was constituted
in May 1998, while recognizing Information Technology as a frontier area of knowledge per
se, it focused on utilizing it as an enabling tool for assimilating and processing all other spheres
of knowledge. It recommended the launching of an ‘Operation Knowledge’ aimed at

universalizing computer literacy and spreading the use of computers and IT in education.
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In the year 1999, the Union Ministry of Information Technology was created. By the year 2000,
a 12-point minimum agenda for e-Governance was identified by the Government of India for
implementation in all the Union Government Ministries/Departments. Some glimpse of the

agenda-

° Each Ministry/Department must provide Personal Computers (PCs) with necessary
software up to the Section Officer level. Besides, Local Area Network (LAN) must also
be set up.

° It should be ensured that all staff with access and need to use computer for their office
work are provided with adequate training. To facilitate this, inter alia,
Ministries/Departments should set up their own or share other’s Learning Centres for

decentralized training in computers as per the guidelines issued by the ministry.

° Each Ministry/Department should start using the Office Procedure Automation software
developed by NIC to keep a record of receipt of ‘dak’, issue of letters, as well as the
movement of files in the department.

° Payroll accounting and other house-keeping software should be put to use in day-to-day

operations.
Emergence of the National e-Governance Plan (NeGP)-

About the future of e-governance, the lighting words by the great visionary Dr. APJ Abdul
Kalam, former President of India, in his inaugural address at IIT Delhi (India) during 2003 at
International Conference on 'e-governance' can be summarized as- “E-governance has to be
citizen-friendly. Delivery of services to citizens is considered a primary function of the
government. In a democratic nation of over one billion people like India, e-governance should
enable seamless access to information and seamless flow of information across the state and
central government in the federal set up. No country has so far implemented an e-governance

system for one billion people. It is a big challenge before us.”
About National e-Governance Division (NeGD)-

In the year 2009, National e-Governance Division was established by the Ministry of
Electronics & Information Technology (MeitY) as an Independent Business Division under the
Digital India Corporation. NeGD has played a pivotal role in executing e-governance Projects
and initiatives undertaken by Ministries/ Departments, both at Central and State levels. The

roles and responsibilities of NeGD are-

a)  Providing strategic direction in terms of framing policies and implementation strategy

for the Digital India Programme in different domains of e-Governance.

b)  Proactive support to Central and State Governments for Mission Mode Projects (MMPs)

and other e-governance projects.
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g)

h)

1))

Acting as a facilitator and catalyst for the implementation of the Digital India Program

by various Ministries and State Governments.

Providing technical assistance to Central Ministries/ State Line Departments in their e-

governance projects either directly or in collaboration with professional consultants.

Undertaking technical appraisal of e-governance projects for examining issues like
overall technology, architecture, framework standards, security policy, service delivery

mechanism, sharing of common infrastructure, etc.

Developing generic / model Expression of Interest (Eol), Request for Proposal (RFP),
Standard Contracts, PPP Models, and other related documents for various stages and

requirements of projects for the use of States.

Ensuring effective citizen engagement and communication with all stakeholders using

offline and Social Media channels

Impact assessment and e-Readiness measurement of e-Governance projects of all States
/ UTs.

Recruitment, deployment and HR management of specialised resources in the State e-

Governance Mission Teams (SeMTs) in all States and UTs

Training and development initiatives, including- (i) Development of competency
frameworks, training guidelines, case studies, etc. (ii) Developing Online and Web-based
Training and set up Learning Management System (iii) Knowledge management and
sharing through workshops, development of case studies, sharing best practises and
creation of knowledge repositories, etc

Implementation Strategy for E-governance-

The approach and methodology adopted for NeGP contains the following elements-

Common Support Infrastructure.

Governance- Suitable arrangements for monitoring and coordinating the implementation

of NeGP under the direction of the competent authorities have been set up.
Centralized Initiative, Decentralized Implementation.

Public-Private Partnerships (PPP) model is to be adopted wherever feasible to enlarge

the resource pool without compromising on the security aspects.
Programme Approach at the National and State levels.

Ownership of Ministries- Under the NeGP, various Mission Mode Projects (MMPs) are
owned and spearheaded by the concerned line ministries.

Some Mission Mode Projects implemented by NeGD-
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[1] Unified Mobile Application for New-age Governance (UMANG)-

UMANG is envisaged to make e-governance. It provides a single platform for all Indian
citizens to access pan India e-Gov services ranging from central to local government bodies
and other citizen-centric services. UMANG intends to provide major services offered by central
and state government departments, local bodies, and other utility services from private
organizations. It provides a unified approach where citizens can install one application to avail
multiple government services. UMANG service has been made available on multiple channels
like mobile application, web, IVR, and SMS which can be accessed through smartphones,
feature phones, tablets, and desktops.

Note- Download UMANG App by giving us missed call on 97183-97183 or Visit-
https://web.umang.gov.in/web/#/

[2] DigiLocker-

DigiLocker system is a flagship initiative of the Ministry of Electronics & IT under the Digital
India Programme. Targeted at the idea of paperless governance, DigiLocker aims to provide a
digital wallet to every citizen of the country so that all lifelong documents/certificates can be
electronically held under a single secure digital wallet. DigiLocker is a platform for issuance
and verification of documents & certificates digitally, eliminating the use of physical
documents. Indian citizens who sign up for a DigiLocker account get a dedicated cloud storage
space that is linked to their Aadhaar(UIDAI) number.

Note- To access Digilocker visit at- https://digilocker.gov.in
[3] National Centre of Geo-informatics (NCoG)-

NCoG is a single source Geographic Information System (GIS) platform for sharing,
collaboration, location-based analytics, and decision support system, catering to central and
state ministries/departments/agencies across the country. Under this project, location-based
datasets such as data related to central government land banks, mining, forests, industrial parks,
water resources, etc. are collated with attribute related data to bring out insights that are useful
to support decision making. User departments can now pinpoint their operations, assets on a
map, and plan better. NCoG has provided mobile applications for geo-tagging and creating

evidence of completed operations under the Government schemes.
Note- To access NCoG visit at- https://ncog.gov.in/
[4]- Rapid Assessment System (RAS)

RAS is an online instant feedback for e-services (online as well as offline through counters)
delivered by the Government of India and State Governments. The main objective of RAS is
to continuously assess the quality of e-Services, through feedback, under each e-governance

project and realign processes to achieve targeted benefits. RAS interface prompts the citizens
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to provide feedback about the quality of service immediately after the citizen avails an e-service
of the Government. The analytic features of RAS help integrated departments in system

improvement and better delivery of services.
Note- To access RAS visit at- https://ras.gov.in/
[S]- Program Management Information System (PMIS)-

PMIS build using open source technologies is used to track and monitor project initiation,
planning, execution, and management. It can be utilized for Central/State/Integrated MMPs,

Departmental and Adhoc projects under the Digital India programme.
Note- To access PMIS visit at- https://pmis.negd.gov.in/
[6]- OpenForge platform-

The objective of the OpenForge platform is to promote sharing and reuse of e-governance
application source code. In 2015, the Ministry of Electronics & IT, Government of India rolled
out the ‘Policy on Collaborative Application Development by Opening the Source Code of
Government Applications’, which provides a framework for archiving government custom-
developed source code in repositories and opening these repositories for promoting reuse,
sharing and remixing. By opening the source code, the Government wants to encourage
collaborative development between Government departments/agencies and private
organizations, citizens, and developers to spur the creation of innovative e-governance

applications and services.

The scope of the project includes the development of a Collaboration Platform under the
‘Source Open Policy’. Further, it includes the creation of a project team, development and
maintenance of the platform, on-boarding of departments, promotion of the platform, and
community management. The community to be created and managed through the platform will
be a key driver in bringing agility and quality to the application development process. It will

also lead to further reuse and value addition to the e-governance software landscape.
Note- To access OpenForge visit at- https://openforge.gov.in/
[7]- Learning Management System (LMS)-

LMS is a software application that automates the administration, tracking, and reporting of
training events. LMS is a pioneer project under e-Kranti (an e-governance plan initiated by the
Government of India). It is widely recognised that there is a tremendous need to enhance the
skill sets and to develop an adequate number of appropriately trained resources for handling a
variety of tasks including those who are expected to design and deliver Government services

to the citizens.

Note- To access LMS visit at- https://Ims.gov.in/
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[8]- Miscellaneous e-governance Projects in India-

Passport Seva Project.

Immigration, Visa and Foreigners Registration & Tracking (IVFRT).

Insurance (Department of Banking)

Income Tax (Ministry of Finance/Central Board of Direct Taxes)

National Citizen Database/UID (Ministry of Home Affairs/Registrar General of India
(RGI)/ Planning Commission, Now NITI Aayog).

Central Excise (Department of Revenue/Central Board of Excise & Customs)

Pensions (Department of Pensions & Pensioners Welfare and Department of
Expenditure)

Banking (Department of Banking)

Land Records (Ministry of Rural Development)

Road Transport (Ministry of Road Transport & Highways)

Treasuries (Ministry of Finance)

E-District (Department of Information Technology)

Common Services Centres (Department of Information Technology)

e-Courts (Department of Justice, Ministry of Home Affairs)

e-Procurement (Ministry of Commerce & Industry/ DGS&D)

And many more.

16.7 CHALLENGES OF E-GOVERNANCE IN INDIA

Lack of motivation and awareness towards the role and importance of e-governance.

Lack of citizen-centric nature of applications and poor cooperation among bureaucrats

and people at the local level of governance.

Lack of trust, poor technical designs which leads to lack of interoperability among

distinct e-governance applications, and underutilization of ICT infrastructure resources.

One of the challenges to attain the ability of high level of data abstraction is to maintain
the privacy of data in designing e-governance applications.

Authentication is very important to know the right user of the services or it may be
misused by private competitors. Meanwhile, the digital signature plays a major role in

providing authenticity. In fact, it is expensive and causes for frequent maintenance.

Maintenance should be given due importance because IT ministry has been continuously
developing new software to fill the current needs of citizens.

Digital divide- Even in the era of science and technology, a huge gap exists between users

and non-users of e-governance services. In India, majority of the masses, living below
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poverty line are deprived of government services. This gap needs to be made narrow, and

then only the benefits of e-governance would be utilized equally.

Infrastructure is essentially required for the implementation of e-governance as much as
possible in India. Electricity, Internet, and poor adaptability of technology will retard the
progress of e-governance. In the context of developing countries, there should be enough

basic facilities to give an impetus to e-governance.

16.8 POINTS TO REMEMBER

E-governance is simply the use of information communication technologies (ICTs) to
carry out public services, that is to say, the use of the internet to ensure that services are

delivered in a much more convenient, customer-oriented, and cost-effective manner.

E-governance is the application of Information Technology to the process of government
functioning to achieve a Simple, Moral, Accountable, Responsive, and Transparent
(SMART) Governance.

The major objectives of e-governance are to improve government processes (e-
administration), connect citizens (e-citizens and e-services), and build external

interactions (e-society).

It is expected that e-governance would enable government to discharge its functions more

effectively and can be able to work with more transparency.

The National e-Governance Division (NeGD) is providing strategic direction in terms of
framing policies and implementation strategy for the Digital India Programme in

different domains of e-Governance.

E-governance strengthens the democracy by ensuring greater citizen participation at all

levels of governance.

E-governance revolutionizes the way governments function, ensuring much more

transparency in the functioning thereby eliminating corruption.

The rapid growth of communications technology and its adoption in governance would

help in bringing government machinery to the doorsteps of the citizens.

E-governance helps citizen empowerment through access to information, better

management, greater convenience, revenue growth, cost reductions, etc.

16.9 GLOSSARY

CSC- Common Service Center.
ERP- Enterprise Resource Planning.

G2B- Government to Business.
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G2C- Government to Citizen.

G2E- Government to Employee.

G2G- Government to Government.

GPS- Global Positioning System.

ITeS- Information Technology enabled Services.
MCA- Ministry of Corporate Affairs.

NeGD- National e-Governance Division.

NeGP- National e-Governance Plan.

NISG- National Institute for Smart Government.
PPP- Public Private Partnership.

SMART- Simple, Moral, Accountable, Responsive, Transparent.
SWAN:- State Wide Area Network.

16.10 CHECK YOUR PROGRESS

Descriptive type questions-

a)
b)
©)
d)
e)

f)

What are the benefits of e-governance?

Explain the summarized view of e-governance in India.

List five major challenges of implementing e-governance in India.
Define in short, the various e-governance models.

Define briefly the role and responsibilities of the National e-Governance Division
(NeGD).

List the name of ten miscellaneous e-governance projects in India.

Objective type questions-

a)

b)

c)

d)

Infrastructure is essentially required for the implementation of successful e-governance

projects. (True/False)

One of the major challenges in implementing successful e-governance projects is a lack

of motivation and awareness. (True/False)

The National e-Governance Division (NeGD) is providing strategic direction in terms of
framing policies and implementation strategy for the Digital India Programme in

different domains of e-Governance. (True/False)

PMIS stands for Prime Minister Information System. (True/False)
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e)

f)
g)

DigiLocker aims to provide a digital wallet to every citizen of the country where we can
deposit the money. (True/False)

National e-Governance Division was established by the Ministry of ........

Government-to-Citizens (G2C) model of governance has been designed to facilitate

citizen interaction with ........

Answer (objective type question)-

[a] True [b] True [c] True [d] False [e] False

[f] Electronics & Information Technology [g] Government
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17.1 INTRODUCTION

Digital technology has changed the way in which students use visual materials in academic

work and has increased the importance of visual literacy skills. (Matusiak, et. al., 2019) Visual
literacy refers to the ability to interpret, negotiate, and make meaning from information

presented in the form of an images (Wikipedia).

The web, social media, and mobile technology have contributed to the ease of viewing and
sharing images on a global scale. This digital transformation is not only associated with the
proliferation of information resources, but also with the increasing importance of the image as
a mode of knowledge representation. Image users are no longer only viewers, but are also
creators of and active contributors to visual communication. Visual literacy emerges as a set of
essential competencies for today's learners. As we are surrounded by visual media, it does not
necessarily mean that we know how to find appropriate images, understand their meaning in

their respective context, or integrate them accordingly (Matusiak, et. al., 2019). The
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development of multimedia technologies for learning and reachability of smart devices offers
new ways in which learning can take place in different age group learners. The term multimedia

denotes, Text, Images and graphics, Audio, Video, and Animation.

17.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

) Explore types of images.

Define raster and vector images.
° Explore key features of Adobe Photoshop and GIMP.

° Define copyright issues involved with images.

17.3 TYPES OF IMAGES

File formats are intended to store particular kinds of digital information. For Example- the

"JPEG" file format is designed only to store still images, while the ".GIF" format supports
storage of both still images and simple animations. The most well-known formats have file
specifications that describe exactly how the data is to be encoded.

Digital image files are seen by programs as streams of data (binary digits, as- Os and 1s), a
method is required to determine the format of a particular file within the file system. One
popular method is to determine the format based on the final portion of the filename, known as
the filename extension.

A digital image is a picture that is stored on a digital device, i.e. a computer. A digital image
means, which consists of a sequence of numbers (binary digits, as- 0, and 1) that computers
can understand. To create a digital image, generally you have two ways, as- using software
(i.e., Paint brush, Photoshop, etc), and using digital cameras (i.e. mobile phones, web cams,
etc).

Note: Some terminologies about images.

What is a pixel?

A 'pixel' (also called picture element) is a tiny square of colour. Lots of pixels together can
form a digital image. More number of pixels in a image shows better quality of the image
whereas lesser number of pixels in an image shows lower quality of the image.

What is Resolution?

Resolution is usually described as “Pixels per Inch” (PPI) when referring to a computer display,
or “Dots per Inch” (DPI) used by a printer when printing an image. Generally speaking, 300
DPI is considered the industry standard for printing (although many printers can print over
2000 DPI), whereas an image on a computer screen is displayed at about 100 PPI (a newer ‘4k’
computer monitor that is 28" across the diagonal (or about 71 centimetres) has approximately

160 PPI and some mobile phones have screens with over 400 PPI). This means that, even if the
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image quality looks good on your screen, the resolution may not be good enough or of an

acceptable quality when printing.

This means, you need larger images (higher resolution) for printing. The disadvantage is that
high resolution images correspond with large file sizes, so you need to think about the size of
the image (in centimetres) on the printed page. For example, to print an A4 sized image so that
the image covers the full page at 300 DPI, you need a minimum resolution of 3508 X 2480
pixels, which means an image file size of between approximately SMB (Lossless PNG) to
13MB (Lossless JPEG), which may be too big for environments with low or expensive
bandwidth.

When developing teaching resources, we recommend that you do not enlarge the image on the
page more than a standard photo print size. This will reduce the file size of images you need to

embed in the resource to ensure good quality printing (if printing in colour).

Image file formats-

° GIF (Graphic Interchange Format)- GIF uses lossless compression for relatively small
file sizes, as compared to uncompressed data. The GIF format can only show 256
colors.

° TIFF (Tagged Image File Format)- TIFF files have many formats, as- Black and white,
greyscale, 4-bit color, 8-bit color, and 24-bit color images.

° BMP (Bitmap)- Bitmap is monochrome and the color table contains two entries. Each
bit in the bitmap image represents a pixel.

° JPEG (Joint Photographic Expert Group Format)- A JPEG image provides very good
compression, but does not uncompressed exactly as it was; JPEG is a lossy compression
technique.

° PNG (Portable Network Graphics)- It utilizes lossless compression. It is a universal
format that is recognized by the World Wide Web consortium (W3C), and supported

by modern web browsers.

17.4 RASTER AND VECTOR IMAGES

Images are the greatest contributors to the visual appeal of your website. Images are files, just

like any other document in your computer, but they can be coded and formatted differently to
reproduce the image you want to see. We find these referred to as raster and vector graphics.
These formats represent two very different methods of creating an image. [2]

Raster Image/Graphics-

The image files most of us are already familiar with using are typically raster format. Examples
of these are JPEG, GIF and BMP. When we interact with pictures, we took on digital cameras
for example, we are dealing with JPEG or JPG files. Raster files recreate an image by recording

the color value of pixels, which represent the smallest single point on a screen that can be
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assigned a color by the display. The higher the number of pixels (or density, measured as pixels
per inch) translates to how sharp the image is, and how large it can be rendered without losing
quality. [2]

The number of colors available in the image file is based on the length of the value available
to each point. If we only allowed a single binary character for each pixel point, we would be
able to keep our file size as small as possible. This however would mean we could only
represent our image in black and white (binary only allows us two options, 0 or 1, so we can
only represent two colors.). When we allow longer values to represent a single point, we can
assign values a larger range of colors. Once we scale these up, however, we trade away our
smaller image sizes in order to have more colorful pictures. [2]

Traditionally, we have faced this trade off by using different image formats in different areas
of our website. While reserving JPG for our larger images or photos, we can use GIF for smaller
icons and indicators. GIFs limit us to 256 colors, but since most icons use few colors, we are
able to capitalize on the benefits of this format here. It is important to note that raster images

will quickly lose quality when rendered at sizes larger than the original image’s width or height.
[2]

Vector Images/Graphics-

Vector images store information about colors and locations as definitions of angles, lines, and
curves in mathematical format. The benefit of a vector formatted image is that it can be scaled
both up and down in size without distortion or degradation in image quality. This is due to the
fact that the image is “drawn” by the browser each time it is loaded, and the processor performs
the steps necessary to recreate the image. Since the image can be scaled, the same image file

can be drawn very large, or very small, without changing the file size. [2]

To resize the image, you can perform compression / decompression techniques. When we
discuss compression in terms of graphics, we need to consider whether it will result in a lossy
or lossless result. A lossless result means the compression techniques used do not remove data
from the original copy, so we can restore the image to its exact original size and appearance.
A lossy compressions structure can result in greater compression, but achieves the extra
advantage by removing information from the file. [2]

Slicing- For some time, there has been a practice of breaking larger images up into many

smaller ones (a process called slicing), in an effort to allow webpages to load more quickly.

17.5 POPULAR OPEN- SOURCE IMAGE EDITING TOOLS
[1] GIMP (www.gimp.org)-

"GIMP is a free and open-source raster graphics editor used for image manipulation and image
editing, and free-form drawing"- Wikipedia. It is the well-known alternative to Adobe
Photoshop (which is paid licensed) for image editing and manipulation. It is a feature-rich and
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free program, allowing you to show your creativity in photo editing. You can freely download

it from the following link, as- www.gimp.org.
[2] Krita (www.KTrita.org)-

It is a free and open-source raster graphics editor designed primarily for digital painting and
2D animation. Krita is a great tool for sketching or digital painting, and has multiple brush
options. If you are creating cartoons, textures, concept art, and digital paintings, Krita supports
almost all kinds of activities. You can freely download it from the following link, as-

www.Krita.org.
[3] Pinta (www.pinta-project.com)-

It is somehow similar to MS Paint. Pinta is an open-source, cross-platform (can run in other
Operating Systems) bitmap image drawing and editing program. It is a basic image editing
application which is easy to learn, you can download it from the following link, as- www.pinta-

project.com.
[4] Darktable (www.darktable.org)-

It is a free and open-source photography application software. It has several image editing
features like Adobe Photoshop, as- dynamic adjustment filters and presets, and etc. You can

download it from the following link, as- www.darktable.org.
[5] DigiKam (www.digikam.org)-

DigiKam is an advanced open-source digital photo management application that runs on Linux,
Windows, and Mac Operating System. The application provides a comprehensive set of tools
for importing, managing, editing, and sharing photos/images. You can download it from the

following link, as- www.digikam.org.
[6] Inkscape (www.inkscape.org)-

It is a free and open-source vector graphics editor used to create vector images, primarily in
scalable Vector Graphics format. Other formats also can be imported and exported. It offers a
rich set of features and is widely used for both artistic and technical illustrations such as
cartoons, clip art, logos, typography, diagramming and flowcharting. Y ou can download it from

the following link, as- www.inkscape.org.

17.6 BRIEF INTRODUCTION TO ADOBE PHOTOSHOP

Adobe photoshop is a photo editing and raster graphic design software which allows users to

create, edit, and manipulate various graphics. It is developed by Adobe Systems for both
Windows and Mac Operating Systems. It allows to create and edit raster images with multiple
layers, and also supports multiple file formats. Adobe Photoshop having a sidebar with a
variety of tools in its toolbox with multiple image-editing functions. These tools typically fall
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under the categories of drawing; painting; measuring and navigation; selection; typing; and

retouching. Brief introduction of such tools are- [5]

Pen tool- The pen tool creates precise paths that can be manipulated using anchor
points. The free form pen tool allows the user to draw paths freehand, and with the
magnetic pen tool, the drawn path attaches closely to outlines of objects in an image.
Clone stamp tool- The Clone Stamp tool duplicates one part of an image to another part
of the same image by way of a brush.

Shape tools- Photoshop provides an array of shape tools including rectangles, rounded
rectangles, ellipses, polygons and lines.

Measuring and navigation- The eyedropper tool selects a color from an area of the
image that is clicked, and samples it for future use.

Selection tools- Selection tools are used to select all or any part of a picture to perform
cut, copy, edit, or retouching operations.

Cropping- The crop tool can be used to select a particular area of an image and discard
the portions outside the chosen section.

Slicing- The slice tool can be used to divide an image into different sections, and these
separate parts can be used as pieces of a web page design once HTML and CSS are
applied.

Moving- The move tool can be used to drag the entirety of a single layer or more if they
are selected.

Marquee- The marquee is a tool that can make selections that are a single row, single
column, rectangular. An area that has been selected can be edited without affecting the
rest of the image.

Lasso- The lasso tool is similar to the marquee tool; however, the user can make a
custom selection by drawing it freehand. There are three options for the lasso tool—
regular, polygonal, and magnetic.

Quick selection- The quick selection tool selects areas based on edges, similarly to the
magnetic lasso tool. The difference between this tool and the lasso tool is that there is
no starting and ending point.

Magic wand- The magic wand tool selects areas based on pixels of similar values.
Eraser- The Eraser tool erases content based on the active layer.

Color replacement tool- The color replacement tool allows the user to change the color,
while maintaining the highlights and shadows of the original image, of pieces of the

image.

17.7 OVERVIEW OF IMAGE EDITING AND GIMP

Image editing-
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A photo editing software makes visually appealing changes to the photos and helps you
organize your photographs into collections. From the business viewpoint, images contain
thousands of words and also can be a symbol of your brand. Image editing software can take
the scanned image of the old pictures/images, covert and restore them into the digital images.

So, that one can edit and reshape old memories. [7]

Why edit a/an image/photograph? [7]

° For gaining attention, so that business benefit can be attain.
° For Portrait Services.

° For Clipping.

° For quality enhancement, And many more.

Things to be noted while selecting Photo Editing Software- [7]

° Almost all computers, digital cameras, smartphones, and other movable devices come
with in-built image editing software.

° File Format— The images that you need to create should locate on the web in the right
format. That format can be any, i.e., JPEG, PNG or GIF. The file format you choose
should also allow you to compress the file size of your photo for the web.

° Organizing Tools— Try finding the software that helps you keep track of your photos
by using naming schemes, search, and thumbnail previews, especially when you are
taking lots of pictures.

° Standard Editing Tools— Your photo editing software should possess at least minimum
level editing requirements like resizing, cropping, rotating and adjusting brightness and
contrast in your photos. These tools should be quick and easy to use.

° Photo Sharing— You should select a program that integrates to photo-sharing services

like Integra, Flickr, etc.

Some are the basic steps for editing image(s)-

) Crop your image(s) and clean them up.

) Adjust white balance.

° Adjust exposure and contrast of your image.
° Adjust colour vibrancy and saturation.

° Sharpen images.

° Finalize and share image.

Introduction to GIMP-

GIMP is a multi-platform photo manipulation tool. GIMP stands for 'GNU Image Manipulation
Program'. The GIMP is suitable for a variety of image manipulation tasks, including photo

retouching, image composition, and image construction. It has many capabilities, as it can be
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used as a simple paint program, an expert quality photo retouching program, an image format

converter, etc. GIMP is free available from many sources for many operating systems. [6]

Some of the key features and capabilities of GIMP are- [6]

° A full suite of painting tools including brushes, a pencil, an airbrush, cloning, etc.

° Sub-pixel sampling for all paint tools for high-quality anti-aliasing.

) Layers and channels.

) Advanced scripting capabilities.

° Multiple times undo/redo.

° Transformation tools including rotate, scale, shear and flip.

° Supports wide range of file formats, as- GIF, JPEG, PNG, XPM, TIFF, TGA, MPEG,
PS, PDF, PCX, BMP, etc.

° Selection tools, as- rectangle, ellipse, free, fuzzy, Bezier and intelligent scissors.

You can perform several photo editing tasks, some of them are listed here. as-

° Basic image and layer manipulation techniques.

° Different shaped images.

° Introduction to layer masks to modify the opacity of a layer.
) Basics of colour curves.

) Image formats overview.

° Photo editing techniques.

Luminosity masks.
Layer masking and creative filter applications.

Several paintings brush.

Automate editing.

Note- for accessing/knowing more detailed tutorials about GIMP, you may follow/visit to-

www.gimp.org/tutorials.

17.8 COPY RIGHT ISSUES OF IMAGES

Photographs are more often the subject of copyright infringement due to the ease of

republishing photos on the Internet. Because photos are so often published without attribution,
it can be difficult to locate the actual owner of an image. You should use images responsibly.
Most databases and websites provide information about copyrights and how their images can
be used. Read this information carefully and comply with usage guidelines. Usage guidelines
can vary. [3]

There are a number of different citation styles including but not limited to APA, MLA, AP,
Chicago, etc. It is important to stay consistent with style usage throughout any particular
document. If you are using images pursuant to a Creative Commons (CC) license, so you

should have good understanding of CC licenses to properly cite to such materials. [3]
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Any items obtained from the web or scanned from a print source should be attributed to the
owner of the copyrighted work. This includes photographs, paintings, or other works of art,
tables, graphs, and other illustrations from primary or secondary source materials. Images from
royalty free clip art, such as the clip art available in Microsoft Word or Power Point, do not
need to be cited. Generally, the following elements are needed in an image citation- [3]
Artist's name (if known).

Title of image (if known).

Title of article or book if applicable.

Author of article or book if applicable.

Title and date of journal if applicable.

Database name if applicable.

Date of access if online.

Date of publication if originally from print material.
URL if applicable.

NOTE-

Many image libraries allow you to filter search results by licence status: for instance, CCO (in
the public domain, no attribution required), CC BY (free to re-use with attribution and
indication if changes were made) or CC BY-NC (free to re-use in a non-commercial context,
with attribution and indication if changes were made). The CC Search tool
(http://search.creativecommons.org) enables you to search multiple libraries simultaneously.
[4]

Google Images- Advanced Search option enables you to filter results by Usage Rights, similar
to Creative Commons categories. Be aware that Google doesn't accept responsibility for the

reliability of these results- check the terms of use at source where possible. [4]

17.9 POINTS TO REMEMBER

° Image users are no longer only viewers, but are also creators of and active contributors

to visual communication. Visual literacy emerges as a set of essential competencies for

today's learners.

° The term multimedia denotes, Text, Images and graphics, Audio, Video, and
Animation.
° A 'pixel' (also called picture element) is a tiny square of colour. Lots of pixels together

can form a digital image. More number of pixels in a image shows better quality of the
image whereas lesser number of pixels in an image shows lower quality of the image.

° A digital image is a picture that is stored on a digital device, i.e. a computer. A digital
image means, which consists of a sequence of numbers (binary digits, as- 0, and 1) that
computers can understand. To create a digital image, generally you have two ways, as-
using software (i.e., Paint brush, Photoshop, etc), and using digital cameras (i.e. mobile
phones, web cams, etc).

Unit 17: Fundamentals of Image Editing Page 239 of 249



CVDMM- 302: ICT Resources and Applications uou

Resolution is usually described as “Pixels per Inch” (PPI) when referring to a computer
display, or “Dots per Inch” (DPI) used by a printer when printing an image.

Adobe photoshop is a photo editing and raster graphic design software which allows
users to create, edit, and manipulate various graphics.

A photo editing software makes visually appealing changes to the photos and helps you
organize your photographs into collections.

Photographs are more often the subject of copyright infringement due to the ease of
republishing photos on the Internet. Because photos are so often published without
attribution, it can be difficult to locate the actual owner of an image. You should use
images responsibly.

There are a number of different citation styles including but not limited to APA, MLA,
AP, Chicago, etc.

17.10 GLOSSARY

Vector images- Vector images store information about colors and locations as
definitions of angles, lines, and curves in mathematical format. The benefit of a vector
formatted image is that it can be scaled both up and down in size without distortion or
degradation in image quality.

Raster image- The image files most of us are already familiar with using are typically
raster images. Raster files recreate an image by recording the color value of pixels,
which represent the smallest single point on a screen that can be assigned a color by the
display. The higher the number of pixels in a image shows the better quality if the
image.

GIF (Graphic Interchange Format)- GIF uses lossless compression for relatively small
file sizes, as compared to uncompressed data. The GIF format can only show 256
colors.

TIFF (Tagged Image File Format)- TIFF files have many formats, as- Black and white,
greyscale, 4-bit color, 8-bit color, and 24-bit color images.

BMP (Bitmap)- Bitmap is monochrome and the color table contains two entries. Each
bit in the bitmap image represents a pixel.

JPEG (Joint Photographic Expert Group Format)- A JPEG image provides very good
compression, but does not uncompressed exactly as it was; JPEG is a lossy compression
technique.

PNG (Portable Network Graphics)- It utilizes lossless compression. It is a universal
format that is recognized by the World Wide Web consortium (W3C), and supported

by modern web browsers.

17.11 CHECK YOUR PROGRESS

a)

What do you understand by Raster and Vector images? Explain.
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b)

c)
d)

List frequently used open-source image editing applications.
Define the basics of editing an image.

How can we safe ourselves of from violating copyright(s) of an image(s)? Explain.
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18.1 INTRODUCTION

The infographics are modern technologies, which are used for visual presentations in which
graphic drawings (illustrations, symbols, maps, graphics, etc.) are combined with text messages
to transform complex data and concepts into the form of images and drawings that can be
clearly conveyed and easily understood by the people/target audience. The term "infographics"
is made up of "Information" and "Graphics" that integrates visualization of data, illustrations,
texts and images all together in a form which is easily understood. The infographics are
characterized by numerous advantages, including simplifying the scientific facts and
presenting them in a visualized data form, shortening explanatory texts, illustrations, and

videos to expressive symbols, images and simple denotations, as well as being easier to be

produced (Afify, 2018).
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Infographics are widely spread in educational and entertainment social networks, newspapers,
magazines, and multi-interest websites more than the other electronic media as well as being
less expensive than the other means. With the use of infographics one can design more than
one type of visuals; and perhaps the most prominent ones are static and animated types. The
static infographics denote the graphics which are designed for the objective of printed use or
digital use in websites, or to be viewed on a screen as digital presentations without integrating
any motion; And animated elements having motion properties. As for the animated
infographics, they refer to the graphics designed for being displayed on graphic animated video
screens on video websites such as YouTube, TV ads or animated presentations on smartphones,
etc (Afify, 2018).

In other words, you can say that the word infographic is an abbreviation of "information
graphic". It is a visual representation of data or editorial content. "Simply put, an infographic
uses visual cues to communicate information. They do not need to contain a certain amount of
data, possess a certain complexity, or present a certain level of analysis. There is no threshold
at which something becomes an infographic. It can be as simple as a road sign of a man with a
shovel that lets you know there is construction ahead, or as complex as a visual analysis of the
global economy" (Lankow, Ritchie, & Crooks, 2012).

The effectiveness and role of using infographics in teaching-learning proven the students'
success when they are utilized as an alternative to texts, and also the infographics facilitates
learning in comparison to ordinary texts, as well as enabling learners to participate effectively
in the learning process, which results in long lasting learning. Infographics are specially used
in e-learning environments which are based on the digital platform through e-learning
management systems or using other platforms of Internet based learning. The key advantage
of using infographics is that there is no fixed place or need for a specific time to learn the things

which are expressed using such mediums.

18.2 OBJECTIVES

After the successful completion of this unit, you will be able to-

) Explore features of infographics.
) Define types of infographics.
) Explore infographics designing steps and tools.

18.3 CHARACTERISTICS OF THE INFOGRAPHICS

Infographics are considered as a new type of digital learning resources with innovative style of
information presentation. The most important feature of infographics is their flexible structure
which permits the visual portrayal of information, the possibility of preparing them with
alternative forms, besides the possibility for using other components in their production, such
as video and audio files. The infographics are characterized by the following (Afify, 2018)-
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° Visual Attractive: The visual attractiveness is considered the essence of infographics
use. It combines graphic elements to represent digital data, with an objective textual
explanation through icons, images, colors, and all elements and principles of visual
designs able to orient the audience and have their attention focused.

° Symbolizing and Summarizing: One of the most important features of infographics
is the ability to symbolize information, concepts, facts and knowledge into brief
presentation in visual symbols, ranging from images, shapes, arrows as well as static
and animated graphics.

° Ability for Sharing: Infographic designs are produced in the form of digital content,
which makes them easy to share across different electronic content platforms, and that
enables the readers to learn collaboratively, and supports communication among them.
Additionally, their design holds copyrights in high regard so the content is more secure
when shared.

° Enhancement Ability: The designer can add the links and additional internet addresses
as reference for the learners to enrich their culture and knowledge about the subject of
infographics. Besides, there is also the possibility for adding the titles of some books,
abstracts, studies and related research, which enriches the electronic as well as the
printed content.

° Enhancing learning process: Infographics act in having the learning process done in
a fast and effective manner. Learners prefer visual images to abstract texts for learning.
This can be explained by the fact that infographics constitute an appropriate tool which
ensures that students learn important points in the subject matter quickly; and that they
attain textual information according to their own speed.

18.4 TYPES OF INFOGRAPHICS

There are many reasons why infographics are becoming a common form of communication in

several places. There are many different types of infographics, few of them are-

[1] Comparison-

Generally, used for-

This vs. That

Clearly divided into 2 columns.

Showing differences between 2 similar concepts.

Visuals should illustrate differences immediately.

[2] Chart-

It is very commonly used infographics in which you can explore more information in a short
time whereas in a textual format you would have to re-read everything; opening and closing
paragraphs would reiterate.

[3] Timeline-

Such type of infographics used to present history of something, like- concept, product, service,
person (e. g. timeline of their life).

[4] Process-
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Using infographics, you can explain complex and multi-layered information in an easy manner;
you also can add branching and decision making.

[S] Essay-

Components of an essay or article broken into parts. Think of it in rectangular blocks. You can
use different elements of an essay, i.e., definitions, comparisons, checklists- keeps it from being
boring, keeps viewer alert.

Infographics doesn’t need to be read chronologically like it would be in a textual report- a
reader can pick out whatever their eye is drawn to. It reduces redundant text compared to a
report.

[6] Animated-

Instead of a poster- like infographic, this is a video which includes images, charts and graphs
but can also include music and narration. Such type of infographics can be created with

PowerPoint or Keynote, or using other video editing software.

18.5 DESIGNING AN INFOGRAPHIC
STEP 1: Decide what you want to say. [1]

First decide, what do you want to get across to your readers? Then, you should think about the

different ways in which the data can be visualized.

NOTE- Each of the infographics on the previous page could probably be displayed in different
ways and using different designs. However, each design may subtly change the meaning, or at
least change the way the audience interacts or reacts to it.

STEP 2: Pinpoint Patterns

Y ou must decide-

What does the data say?

What insight is starting to emerge from patterns in the statistics or data?

What type of infographic might fit for presenting your data or core message?

What types of charts, images, or graphics might be useful to convey your message correctly?
STEP 3: Sketch out a design

Try to sketch a draft of your design on paper before creating your graphic using software. Your
design may change many times before you get it right and it is much easier to scrap a piece of
paper than it is to start over in the software. It can save your time.

STEP 4: Choose your tool

There are many online/offline tools which are used to design different types of infographics.
Different tools requiring different technology skills. Some of the popular tools which are
frequently used to design infographics, are-

PowerPoint
Piktochart (www.piktochart.com)

Venngage (www.venngage.com)

Canva (www.canva.com)
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Easelly (www.easel.ly)
Visme (Www.visme.co)

Infogram (www.infogram.com)

Snappa (www.snappa.com)

18.6 INFOGRAPHICS DESIGNING TOOLS

Microsoft PowerPoint

Basically, PowerPoint is not a photo editing tool, but you can create effective infographic using
PowerPoint. As humans are visual creatures, and as such we prefer a visual illustration as
opposed to reading a plain text. Infographics allow you to present information in an eye-
catching and efficient manner. Plain and simple designs can become more effective by putting
your creativity and imagination on them. PowerPoint is a tool through which you can use Smart

arts, Clip arts, Place holders with different colours, Various shapes, and more.
Piktochart (www.piktochart.com)

Piktochart is a cloud-based infographic application that allows users to use various templates
to create infographics, presentations, reports for many purposes. Piktochart is unique from
other applications because it creates content that is web-publisher ready and can stand alone as
a part of multimedia content. It is intuitive, produces fast templates, and can personalize content
and designs as needed. All templates are stored in an online library which also affords real-

time collaboration to streamline the workflow and reach desired objectives. [2]

One of the most crucial aspects of Piktochart is its ability to embed the multimedia principle.
It allows users to showcase their learning by using pictures to support the text which is in
accordance with the multimedia principle. People learn better from words and pictures than
from plain words alone and benefit all types of learners. The foundation of Piktochart is to use
images, graphics, and designs to communicate meaningful information with intended
audiences. Moreover, most of the templates provided by Piktochart contain the option to
include both words and graphics and helps viewers engage in active learning. It supports the
collaborative learning approach as it encourages learners to share information and collaborate
with others to share resources and information. It is a learning environment that provides
information and allows opinion sharing between team members to make a rich connection

among them. [2]
Canva (www.canva.com)

Canva is a graphic design tool for the web, Android, 10S, and Chrome. Users create an account
(with an email address or by linking their Google or Facebook account) and then follow the
instruction to proceed. Users can upload their own images and create their own layouts or

choose from a selection of thousands of built-in images and design templates (some of which
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are available freely). You can adjust brightness and contrast, resize images, overlay images
with text and colors, and many more. Once you have finished creating designs, they will
automatically save to the cloud storage and can be accessed from the user's login in the website.
Users can then export their creations via e-mail, as Facebook posts, or via Twitter, and they
can download their images in JPEG, PNG, or PDF format. I hope you will definitely take an

experience.
Easelly (www.easel.ly)

Easelly is an infographic creation tool that guides users to build visual and text representations
of'a concept or idea. Easelly provides some themes and many objects, but it is up to the user to
search through these materials and organize them into a cohesive infographic. This website
offers an option to share finalized products, so there are many public infographics to choose
from for a template. This website is easy to navigate, and progress on an infographic can be

saved for later. I hope you will try it out by visiting the www.easel.ly.
Infogram (www.infogram.com)

With the help of this tool, you can create and share infographics, charts, and other types of data
illustration. can create a variety of illustrations, ranging from tree maps to bar and line graphs.
Designs can be customized with quotes, brief text, and a title; other elements like a facts and
figures section, world map, and a live countdown timer can also be added with just a couple of
clicks. By clicking on ..., you should try it out. You can also share your creations on Twitter,
Facebook, or Pinterest; or copy and paste a link to embed it on a blog or other websites.

Venngage (wWwww.venngage.com)

Venngage is an online tool for creating infographics, reports, and data visualizations. You can
choose a template or color scheme, then you can add text, change fonts, and add widgets, charts,
and icons. You can save the infographic as an image or download it as a PDF. Users can also

publish their image to the site and share it with other users via a URL or embedding code.

18.7 APPLICATIONS OF INFO GRAPHICS

° Infographics are graphic visual representations of information, data, or knowledge,

intended to present complex information quickly and easily.

° Using infographics, you can easily convey the figures and data from which people can
absorb information in a much efficient way.

° They can improve cognition by utilizing graphics to enhance the human visual system’s
ability to see patterns and trends (source: Wikipedia).

° Infographics display large amounts of data and information in the form of a graph or

picture.
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° Infographics are entertaining, eye-catching, concise, and all the information they
contain is easily digested by the audience.

° Infographics are composed of- Visual Elements (i.e. Color, Graphics, Reference icons),
Content Elements (i.e. Time Frames, Statistics, References), and Knowledge Elements
(i.e. Facts, etc).

° Infographics are helpful to communicate more effectively for agencies reporting
achievements to their clients.

° Trade shows are chaotic places where infographics can play key role to interactive data
visualization.

18.8 POINTS TO REMEMBER

° The term "infographics" is made up of "Information" and "Graphics" that integrates
visualization of data, illustrations, texts and images all together in a form which is easily
understood.

° Infographics are widely spread in educational and entertainment social networks.

° The effectiveness and role of using infographics in teaching-learning proven the
students' success.

° Infographics are considered as a new type of digital learning resources with innovative
style of information presentation.

° Many different types of infographics are in trend, as- Comparison, Chart, Timeline,
Process, Animated, etc.

° Some popular tools to design infographics, are- PowerPoint, Piktochart, Venngage,
Canva, Easelly, Visme, Infogram, Snappa, etc.

18.9 GLOSSARY

° Visually attractive: The visual attractiveness is considered the essence of infographics
use.

° Infographic: information with graphics.

° Infographics: It is characterized by numerous advantages, including simplifying the

scientific facts and presenting them in a visualized data form, shortening explanatory
texts, illustrations, and videos to expressive symbols, images and simple denotations,

as well as being easier to be produced (Afify, 2018).

18.10 CHECK YOUR PROGRESS

a)
b)
c)
d)
e)

Define the role of infographics in teaching-learning.

How can you design an effective infographic? Explain.

List the different types of infographics.

Define some of the popular infographic designing tools with their key features.

State the applications of infographics.
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